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1 Welcome to the Renoise User Manual
Welcome to the Renoise user manual. Renoise provides a large number of features
which perform a wide variety of tasks for music and sound creation. This manual will
help you to understand how everything works by explaining all available aspects of
Renoise in detail. You can use the category list to look through the various topics, or
use the search function to find something specific.

You can also find a quickstart guide, a beginner's video tutorial and version of this
manual online at the official Renoise site: http://tutorials.renoise.com

If you have any questions or suggestions, then please don't hesitate to contact us.

Copyright © 2022 by the Renoise authors. All rights reserved. All other product and company names are registered
trademarks of their respective owners. The Renoise User Manual was created by PDF Main, Vincent Voois [vV], Sato
Takashi [sato], Dac Chartrand [Conner_BW], Eduard Müller [taktik] and Erik Jälevik [sharevari]
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2 Introduction To Renoise
Welcome to Renoise, an audio creation package that is significantly different from most
of the others. This means the interface may look unusual or a bit complex, but this
introduction will familiarise you with its main components and explain their basic
functions. If you haven't already set up audio and MIDI devices, then it's recommended
to move on to those sections of the manual after reading through this page.

2.1 Main Screen Overview

When you launch Renoise for the first time you will be presented with something similar
to the image below:

You should also see the Welcome panel, but if you've disabled or dismissed it, just click
on the Renoise logo at the bottom-right corner to bring it back. The panel provides links
to this manual, the user forum and the official website. There are also tabs which show
the files that have been recently loaded and saved, as well as quick access to the demo
and tutorial songs. Looking at how these songs play can be a great way to learn about
how Renoise works, so just double click on one to load it in and hit the Play button at
the top-left or press the space-bar on your computer keyboard.
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We will now briefly go through the main areas of the Renoise interface. Note
the links in blue, which you can click on for more detailed information about
the various components.

2.1.1 Upper Status Bar

Located at the very top of the interface is the Upper Status Bar. The left side offers a
variety of menu options and just to the right of this is the Master volume slider, which
controls the overall volume of the song. Next is the button to enable auto-adjusting of
the Master volume level to avoid clipping (the volume will be automatically lowered
when clipping occurs). Further right is the VU meter showing the current Master volume
level, followed by the MIDI controls (MIDI Mapping button, MIDI I/O LEDs), Song Timer
and the current CPU usage.

2.1.2 Global Song Control

Just below the Upper Status Bar on the left-hand side are the basic Transport Panel
controls. From here you can start/stop the song and access basic editing features such
as Edit Mode (record) and the metronome.
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2.1.3 Song Visualisation

Below the Transport Panel are the Track Scopes, which provide visual feedback and can
help you to analyse the song as it is playing.

2.1.4 Loading & Saving Files

At the bottom right corner of the interface is the Disk Browser, which is used to load or
save songs, instruments, samples, effect chains etc. Upon first loading Renoise you will
see a list of demo songs here. Double click on a song to load it, then press play to see
and hear Renoise in action.

2.1.5 Selecting Instruments

Just above the Disk Browser is the Instrument Selector, where you choose the current

Renoise 3.4 User Manual

2.1.3 Song Visualisation 4



instrument that you wish to play or record with using either the computer keyboard or
an external MIDI keyboard.

2.1.6 Editing View

Selecting one of these tabs will change the content of the large central section of the
interface. By default it will be set to Edit, displaying the Pattern Editor where you record
notes and effect commands. Selecting Mixer will open the mixer view, which is more
efficient for monitoring and editing the song's various tracks and effect devices. The
next three tabs deal with different aspects of the currently selected Instrument, which
in Renoise may contain any combination of samples, plugins and MIDI.

2.1.7 GUI Presets

Directly above the Instrument Selector are a set of eight global preset buttons used to
switch between various sections of the interface and are accessed by either left-clicking
on them or pressing F1 - F8 on the keyboard. Renoise comes with eight presets already
stored by default, but you can create your own by right-clicking a button to save the
current GUI setup.

2.1.8 Sequencing Patterns

Located at the far left of the screen is the Pattern Sequencer. Renoise uses a sequence
of patterns to arrange the structure of a song and the Pattern Sequencer is used to
create, copy and organise your patterns.

2.1.9 Creating Patterns
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To the right of the Pattern Sequencer and occupying the large central space is the
Pattern Editor, which is the main tool for composing and editing within Renoise.
Although it may look intimidating to beginners, the method of adding/recording notes
into tracks using the Pattern Editor is actually incredibly simple.

2.1.10 Applying Effects

Beneath the central area is the panel for Track Effects. This displays and controls all of
the effects that are being applied to the current track (the track which the cursor is in).
Besides the typical Audio Effects (native/VST/AU/LADSPA/DSSI) you can also assign
Routing Devices to send/receive audio, and Meta Devices such as LFOs that do not
directly affect audio, but are instead used to alter parameters through automation.

2.1.11 Lower Status Bar

Finally, at the very bottom is the Lower Status Bar. The icons at the left allow you
switch between the Track Effects and Graphical Automation panels or hide them
completely. At significant points, Renoise will display information regarding its status
and current operations here. If you wish to see the Welcome panel again, click on the
Renoise logo at the right.
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2.2 Guide Yourself Through the Interface: Tooltips

As you are using Renoise, watch out for Tooltips, which can be seen by hovering the
mouse pointer over a button or part of the interface for a second. Almost every button
in Renoise will provide you with a small tip about its function.

2.3 Renoise Work-flow: Learning the Keys

While Renoise supports drag'n'drop and mouse gestures, it is primarily a
keyboard-based application. As such, there are keyboard shortcuts for practically every
function. To view the available shortcuts, select "Help->List Keyboard Shortcuts..." from
the Upper Status Bar. If you are interested in a shortcut specific to an interface area,
you can right-click to open a context menu. Additionally, the keyboard shortcuts can be
customised in the "Edit->Preferences->Keys" menu.

A list of most important shortcuts can also be found in the Keyboard Shortcuts section
of this manual.
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3 Setting Up Audio Devices
Audio devices enable your computer to create the sounds you hear, either through a
dedicated sound-card or simply using your computer's built-in hardware. Regardless of
whatever generates the actual sound output, what you control in Renoise is the audio
driver, which is what allows the hardware and software to communicate.

3.1 Default Setup

By default, Renoise is configured to use the system's default audio output device at a
high latency, ensuring that in most cases Renoise is ready to go and output can be
heard. No input device (something you can record with) is selected by default. Because
the default settings are often not optimal for your particular machine, you should have
a quick look at the Audio Preferences in case adjustments can be made.

3.2 Audio Preferences

To change the audio settings in Renoise, select "Edit->Preferences" from the Upper
Status Bar. On MacOS you will find the "Preferences" in the "Renoise" menu at the very
left.

In the Preferences menu, select the Audio tab:
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(Example of the Audio Preferences tab on Windows)

What follows is a quick overview of how to set up devices. For a more detailed
explanation of the Audio Preferences, take a look at the Preferences section of the
manual.

3.3 Audio Setup on Windows

On Windows you will have the choice between two different audio architectures:

Direct Sound: This is the Windows default setup for audio and will work with all
devices that are recognised by Windows. It is reliable, but also has a relatively
high latency (the time it takes for the sound output by Renoise to be heard).
Direct Sound only offers one stereo channel as input or output, so if your
sound-card offers multiple audio channels you will not be able to use them in
Renoise via this method.

• 

ASIO: An audio architecture created specifically for professional audio
applications such as Renoise. It offers low latencies and combines recording and
playback into one driver, making recording more reliable and stable. It also
allows software to access multiple channels at once. So if your sound card has
more than one output, you can directly address them in various ways when using

• 
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ASIO.

Because of its many advantages, using ASIO is highly recommended. Even if your
sound-card does not provide ASIO drivers (i.e. your device does not show up in the ASIO
device list in Renoise), you could try out a free general ASIO driver for Windows:
ASIO4All. This driver will work with most audio hardware, but may not be as reliable as
your specific sound-card vendor's official drivers.

3.4 Audio Setup on Mac MacOS

On MacOS there is only one driver architecture present and it will work out of the box
on all available Macs. Named 'Core Audio', it is similar to ASIO, offering low latencies
and allowing the use of multiple sound-card outputs (when present) in Renoise.

To use Core Audio, simply select the device for output and recording and then select
the latency and sample rate you want to use. Please see below for a more detailed
description of the latency and sample rate setup.

3.5 Audio Setup on Linux

On Linux you have the choice between two different architectures:

ALSA: This is the default audio architecture on most Linux systems and it should
work out of the box in Renoise. In most cases it is very fast and reliable, but may
require some fine-tuning before being usable. Please see the notes just below for
more info about the "tweaking" that is needed for Linux Audio in general.

• 

Jack: Not installed by default on many Linux systems, but this is still a relatively
common and advanced way to access your sound hardware. Jack does not just
bridge Renoise to your sound-card, but also allows the routing of audio between
multiple applications (provided they also support Jack). Please visit the official
Jack audio pages at jackaudio.org for more detailed information.

• 

Configuring Linux for Audio in general: Many Linux distributions are, by default, not
optimized to the standards required for real-time audio creation in Renoise. So when
using either ALSA or JACK with Renoise it is recommended to:

use a real-time kernel• 
configure PAM (/etc/security.conf) to allow Renoise and other applications to
create low latency and high priority tasks

• 

Both topics are described in depth in our Linux FAQ. For more information on the
subject, this general Linux and Audio FAQ is also recommended: linuxaudio.org
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3.6 Latency & Sample Rates

Latency is the time it takes for the Renoise output audio to be played on your speakers
or headphones. The lower the latency, the quicker Renoise will respond to what you
play or modify. So lower latencies are preferable, but they also require more CPU power
to maintain. If the CPU becomes overloaded then the audio will start to crackle and
choke. If you hear such crackles in the sound output, the first thing you should do is
increase the latency via the Preferences menu.

The sample rate defines how much detail is contained within the sound that you hear.
The higher the sample rate, the more detail. 44,100 Hz is the rate that is used by CD
players, so that rate offers an excellent playback quality. Whether higher rates result in
a noticeably better listening experience is debatable, but they do offer increased
resolution for effects. Rates below 44,100 Hz are not recommended because there is an
audible reduction in sound quality.

Note that CPU consumption is affected by the sample rate. A doubling of the sample
rate roughly corresponds to a doubling of CPU consumption in Renoise, because
everything requires twice the number of calculations. So be aware that when using
higher rates you will reach your computer's processing power limit sooner.
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4 Setting Up MIDI Devices
You can connect external MIDI devices to Renoise in order to play notes or record
controllers (automation). This is often done with a MIDI master keyboard or an external
synthesizer which is capable of sending MIDI. While it is possible to use the computer
keyboard to enter notes in Renoise, it is not velocity sensitive and can only map two
and half octaves at once. So a MIDI keyboard is highly recommended when you want to
accurately record "live" playing.

Using the MIDI Mapping function, you can externally map things like starting/stopping
the song, changing sequences, levelling tracks and FX etc. This can be done by either
mapping regular notes from a master keyboard, or with MIDI hardware which is
dedicated to the task, such as MIDI controllers and mixers.

With the MIDI Clock you can sync external MIDI capable devices to the Renoise clock or
vice versa.

To play external MIDI instruments you just use the MIDI section of a Renoise
instrument, which does not require anything to be set up via the Preferences menu.

4.1 Default Setup

By default, Renoise is set up to use the first two devices it finds as input devices. If you
don't have more than two devices, MIDI IO might work right out of the box for you. To
verify that Renoise recognises your MIDI keyboard or controller, load up a sample and
press notes on the keyboard. If you can't hear what you're playing, you should open up
the Preferences menu and have a look at the settings.

4.2 Monitoring MIDI-IO

To the right of the menu options within the Upper Status Bar will be either two or four
small LEDs. If there are four LEDs then the left set refer to MIDI Clock signals, while the
right set refer to general MIDI transfers. If there is no MIDI Clock set up, then there will
be only two LEDs, representing general MIDI transfers. Every message that is sent from
Renoise will blink the red LED, while every message that is received by Renoise will
blink the green.

4.3 MIDI Preferences

To change the MIDI settings in Renoise, select "Edit->Preferences" from the Upper
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Status Bar. On MacOS you will find the "Preferences" in the "Renoise" menu at the very
left.

In the Preferences menu, select the MIDI tab:

(Example of the MIDI Preferences tab on Windows)

4.4 Device Setup

Clicking on one of the device drop down boxes shows a list of the currently installed
MIDI devices. Simply select the one that you would like to use.

On Windows, you may find the same entry appearing twice, one with WDM before the
name and one without. If that's the case, then your sound-card or MIDI device offers
two different drivers for the same device. WDM is a new kind of driver which offers
better timing, so select this one if it works.

On Linux, you will also see some generic names (Renoise Input A/B). These devices are
virtual ports that Renoise registers so that other applications can connect to them
easily. To do all MIDI routing outside of Renoise with the ALSA MIDI patch-bay
applications, take a look at the Linux MIDI HowTo FAQs for more information about this
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and ALSA in general.

In the above picture, you can see three configuration panels:

MIDI Master Keyboard / Mapping: Connect your external MIDI master
keyboard or MIDI controller to Renoise

• 

MIDI Clock Master: Send MIDI clock timing information to other MIDI devices• 

MIDI Clock Slave: Sync Renoise to external MIDI devices• 

All that is needed to start is to select the required devices. For a detailed description of
the other advanced settings, take a look at the Preferences section of the manual.
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5 Introduction To Redux
Welcome to Redux. This introduction will familiarise you with the main components of
the user interface and explain their basic functions. Redux has taken the Sampler and
Phrase Editor features from Renoise and made them available as a plugin. So while
there is a lot of crossover between the two programs, not everything in this manual is
necessarily relevant to Redux. Use the blue text links on this page to move on to other
useful pages.

5.1 Compact Mode

Redux is significantly different from most other plugins and consequently it also looks
different. When launched, Redux will be in Compact mode, which has been designed to
take up minimal screen space while still providing access to essential features. Note
that in Compact mode, the macro control section can be shown by clicking on the
Macro button and extra phrase options will also be shown when working with a preset
that contains phrases.

5.1.1 Interface Controls

At the top left are the buttons used to expand/shrink the interface. Enabling the Macros
button will open the macro control section, while the Editor button will open the full
Redux interface.

5.1.2 Loading & Saving Presets

The Preset Selector is found at the top center of the interface and is used to load, save,
browse, search and filter presets, amongst other things. By default, this will be set to
the blank preset, Init (initial values).
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5.1.3 Instrument Properties

Just to the right of the Preset Selector are the Instrument Properties, which are global
controls used to affect the sound and behaviour of the entire instrument.

5.1.4 VU Meters, Help and Preferences

Found at the top right of the interface are the VU meters showing the current volume
level of Redux, the question button to open the Help menu and the button below it to
open the Preferences menu.

5.1.5 Keyboard

The keyboard will display any keys pressed on the computer keyboard or played by a
MIDI device. You can also use the mouse to click on the keys to play them. Not all of the
keys are visible at once, so the arrow buttons at the left and right sides will move the
keyboard an octave in that direction. If a key is 'greyed-out' then it will not produce a
sound, because the key has been restricted in the Keyzones section or Keymap mode.

5.1.6 MIDI Controllers

Just to the left of the keyboard are MIDI controllers for mod-wheel, channel pressure
and pitch-bend. The controllers will respond to MIDI messages received by Redux, but
you can also use the mouse to click and drag on them to change their values.

5.2 The Full Editor
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Clicking on the Editor button at the top-left will open the full Redux interface, which can
also be resized by click-dragging its lower right corner. The extra options available to
you in this mode are almost identical to those in the Sampler and Phrase Editor
sections of Renoise.

5.2.1 Disk Browser

Found at the very top right of the interface, clicking the  arrow button will open the
Disk Browser as an additional method of loading and saving presets.

5.2.2 Keyboard

In the full Editor, the keyboard changes to show the specific layout of the notes on the
computer keyboard, but otherwise still functions exactly as it does in Compact mode.
There are also two additional options at the left:

Keyboard Octave: The current octave of both the computer keyboard and
external MIDI keyboard. Moving this value up and down alters the octave of the
notes played and hence their pitch. For more information, see the section on
Playing Notes with the Computer Keyboard.

• 

Computer Keyboard Velocity: When enabled, the computer keyboard will play
and record notes at the velocity set in the value box. When disabled, only the
note itself will be recorded into a phrase, leaving the existing velocity value

• 
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untouched.

5.2.3 MIDI Controllers

In the full Editor, the MIDI controllers to the left of the keyboard can now be mapped as
macros.

5.2.4 Phrase Controls

With the phrase controls to the right of the keyboard you can select phrases from the
grid, create or delete phrases (+/- buttons), preview them with the play and stop
buttons and choose their playback method.

5.2.5 Lower Status Bar

Only visible at the bottom of the interface in full Editor mode, the Lower Status Bar will
display significant information regarding the status and current operations of Redux.

5.3 Guide Yourself Through the Interface: Tooltips

As you are using Redux, watch out for Tooltips, which can be seen by hovering the
mouse pointer over a button or part of the interface for a second. Almost every button
in Redux will provide you with a small tip about its function.
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5.4 Redux Work-flow: Learning the Keys

While Redux supports drag'n'drop and mouse gestures, it is primarily a keyboard-based
application. As such, there are keyboard shortcuts for practically every function. If you
are interested in a shortcut specific to an interface area, you can right-click to open a
context menu. The keyboard shortcuts can also be customised in the
"Edit->Preferences->Keys" menu.

A list of most important shortcuts can also be found in the Keyboard Shortcuts section
in this manual.
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6 Disk Browser
The Disk Browser allows you to load and save files, preview samples or instruments,
and store your favourite locations for quick access. In Renoise, it is located at the
bottom right corner of the interface. It is closed by default in Redux and is opened by
clicking the  arrow button at the very top right of the interface when in full Editor
mode.

6.1 Load & Saving Files

First choose the appropriate file type using the selector tabs shown below. To load a file
simply double-click on it in the file list. To save a file, type the desired name into the
text box at the bottom and press the Save button.

6.1.1 File Type Selector

Using this panel you select what file type to load or save. Note that the File Panel will
display all of the files that are capable of being read, but the files which are relevant to
the selected file type are highlighted and listed at the top.

 - (Renoise only) Load and save Renoise song files (XRNS), or load
other song formats that Renoise can import (see below for full list).

• 

 - Load and save Instruments (XRNI files). Clicking the  arrow to the
left of an instrument will show any samples contained within, which can then be
loaded individually.

• 

 - Load (see below for format list) and save samples (will always save
in WAV format).

• 

 - Load other file types (saving is done by other means).• 
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Renoise Only - Depending on the file type selected, Renoise may also show some
additional options & buttons at the bottom:

Song: A "Render" button will appear, which will open the render window and
allow you to render the current song as a .wav file.

• 

Instr./Sample: A small preview icon that, when enabled, will play samples when
they're selected (click the  arrow to the left of an instrument to show any
samples contained within). Just to the right of that is another icon that allows you
to select whether the sample will be played back on the Master Track or the
currently selected track (including all track effects). To the right of that is a slider
that adjusts the pre-hear volume - double-clicking it will reset the volume to 0dB.

• 

6.1.2 Supported Formats For Song Importing

.xrns, .rns, .ptk, .ntk - Renoise Songs• 

.xm - FastTracker II• 

.it - ImpulseTracker II• 

.mod - Amiga Mod• 

.mid, .midi - standard MIDI• 

6.1.3 Supported Formats For Sample Importing

6.1.3.1 Lossless

.aif, .aiff - AIF wave (uncompressed only)• 

.wav - PCM wave (uncompressed only)• 

.fla, .flac - Flac audio• 

.aifc - compressed AIF (requires Quicktime)• 

.au, .snd - rare Mac formats (requires Quicktime)• 

.caf - Core Audio file format used by many Apple apps (requires Quicktime)• 

6.1.3.2 Lossy

.ogg - Ogg Vorbis• 

.wma - Windows Media Audio• 

.ac3 - Dolby Digital (can be up to 5.1 surround, but only stereo channels will be
imported)

• 

.mp2, .mp3 - standard MP2/3 (requires mpeg123 on Linux)• 

.m4a, .mp4, .mp4a, .aac - new MP4, AAC format (requires Quicktime)• 

6.2 Folder Panel (Renoise only)

Initially, only the current folder will be shown, with the arrow at the right moving the list
to the parent directory. To expand the Folder Panel and show the directory tree, either
toggle on the folder icon  or click and hold the bar shown below then drag down:
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The Folder Panel gives you an overview of the directory structure. Left-clicking on a
folder will display its contents, while double-clicking will enter the folder.

 - Go up one level in the directory hierarchy.• 
 - Set current folder as new root directory (only show folders below the current

position).
• 

Right clicking on a directory within the Folder Panel will also present you with more
options:

To the right of the folder panel are four numbered buttons, which are user-configurable
presets that can be assigned to your favourite file locations. Right-clicking a button will
store the current File Panel directory as a preset. Left clicking will recall a previously
stored location. Each file type (Song, Instrument, Sample and Other) has its own set of
four customisable presets. Hovering over a preset button with the mouse will show its
full directory path.

Below this are a set of common default locations: your home folder, the default library
folder (different for each file type: Song, Instrument, Sample and Other) and a list of all
available installed system drives.

6.3 File Panel

The contents of the selected directory are displayed in the File Panel. By default, only
files that are readable by Renoise/Redux are shown.

 - Toggle showing the Folder Panel.• 
 - Type in a search phrase to filter the file-list.• 
 - When enabled, all file types are shown, not just the ones readable by

Renoise/Redux.
• 

 - Save a file (the file is named using the text box to the left of the save
button).

• 
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Right clicking on any file will present more options:

File-Context menu

"Load file with options" can be used to specify exactly how a file should be imported.
The options available to you change depending on the type of file selected. They are as
follows:

WAV File Import Options

RAW Audio File Import Options

MIDI File Import Options
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Device Chain File Import Options

6.4 Resizing The Interface (Renoise Only)

The interface can be expanded horizontally by left-click-dragging the left edge of the
panel, and vertically by left-click-dragging on the bar between the Instrument
Properties and the Disk Browser.

 - Closes or opens the entire right panel, hiding both the Instrument Selector
and the Disk Browser. Note that when closed, the visibility icon below will move
next to the Scopes icons, allowing you to still view the Instrument Selector.

• 

 - Toggles the visibility of the Instrument Selector.• 

6.5 Loading Multiple Entries at Once

You can load multiple sample or instrument entries by ctrl-clicking individual files
and/or shift-clicking to select a range of them. The selected files can then be loaded
using the context menu or dragged into a specific spot. Samples can be dragged into
the instrument-list area and have an instrument created for each sample, or dragged
into the sample-list area and be loaded into a single instrument.

6.6 Navigating the Disk Browser with the Keyboard

The default keyboard focus is set to control whatever you're working on in the large
central section of the interface, but you can also activate other sections for keyboard
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navigation by any of the following methods:

Right click on the File Panel or Folder Panel to show the context menu and select
"(Set Keyboard Focus here)".

• 

Navigate the keyboard focus through the various interface areas with the
[Control/Command + Tab], [Control/Command + Shift Tab] shortcuts.

• 

Click with the middle mouse button on the File Panel or Folder Panel.• 

6.7 Importing Raw Audio Files (Convert Any File to Audio
Sample)

It is actually possible to load any file and use it as an audio sample. In order to do this:

Select the "Sample" category in the File Selector.• 
Make sure the "Show All Files" option is enabled.• 
Double click a file which is not normally recognized as a sample file (TXT
document, JPEG picture, AVI movie etc.)

• 

Additionally, right-clicking on the file and selecting "Load File with Options" gives
you additional options for importing (sample rate, bit depth etc.)

• 
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7 Libraries & Presets
A library acts as a container for other presets, stored in the file format .xrnl, which is
easily installed via drag and drop. Once installed, the library’s contents will be available
to use through the preset menu(s). Since a library’s contents can be many different
things, the installer will helpfully tell you what was installed - whether it was a bunch of
new instruments, some multi-sample presets, or perhaps a collection of effect chains.

You may find it useful to watch a short video on this subject.

If you save one of your own presets, it is stored in a special location - the User Library.
This is found in the same folder as any installed libraries and is shared for use between
Renoise and Redux:

Windows: HOME/[My ]Documents/Renoise• 
MacOS: HOME/Documents/Renoise• 
Linux: HOME/Renoise• 

7.1 Specific Preset Types

Instruments are constructed from a variety of parts: Phrases, Keyzones, Waveforms,
Modulation and Effects. Specific preset types for each of these sections are available
from a drop-down menu at the top right corner, where you can load, save, import and
export. This allows an existing instrument to load the various presets into their specific
sections without overwriting the whole instrument. A library can contain any of the file
types associated with these sections:
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Phrases (.xrnz) - A phrase preset is an XML file describing the number of lines,
columns and other settings (loop, tempo etc.) that make up a single phrase.

• 

Keyzones (.sfz) - A multi-sample preset is an .sfz soundfont file, an open
standard format for describing musical instruments.

• 

Waveform (.flac) - Waveform presets are just samples stored as .flac files.• 
Modulation (.xrno) - A Modulation Set preset is a collection of modulation
envelopes that affect various sample domains (volume, panning, etc.). The
preset itself is a simple XML file.

• 

Effects (.xrnt) - An Effect Chain preset describes the effect devices and
parameter values that make up an effect-chain. The preset itself is a simple XML
file.

• 

A library can also contain two other file types:

Effect-Devices (.xrdp) - An Effect-Device preset defines the parameters of a
single effect device. This can be any of the regular devices or a Doofer (a special
combination of other devices).

• 

Themes (.xrnc) - Themes are alternative visual styles for the interface and are
stored as simple XML files. New Themes can be created, or existing ones edited,
in the Themes tab of the preferences menu.

• 

7.2 XRNL Library Creation

The easiest way to build your own library is to create a copy of an existing user library,
save presets to it from inside Renoise and then do the file/folder organisation
externally.

7.2.1 Build The Collection

Libraries are laid out in the same way as the user library. For example, it might have
the following structure: �

+ Samples
+ Multi-Samples
+ Instruments

Note that these folders are created automatically as you save a preset. It's possible to
move presets around or reorganise them into sub-folders, but this needs to be done
from within your OS explorer/finder window. Any changes performed there will
automatically be reflected in the Renoise user interface.

So, after a bit of customization your file structure might now look like this (with folders
expanded): �

+ Samples

- Ambience
- Channel
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- Field Recordings
+ Multi-Samples
+ Instruments

- Synth
- Bass
+ FX

- Scifi

7.2.2 Add A Manifest

Once you feel the content is ready to be exported, add a manifest to the root folder
(use a basic text editor such as Notepad and copy the following text as a starting
point). �

<?xml version="1.0" encoding="UTF-8"?>
<RenoiseContentLibrary doc_version="0">
  <Id>org.username.examplepack</Id>
  <Name>Example Pack</Name>
  <Author>Username (plus email, link, whatever)</Author>
  <Version>1.0</Version>
  <Description>Amazing pack by username for Renoise+Redux</Description>
</RenoiseContentLibrary>

� The only thing that is important to get right is the name - it needs to follow a certain
naming convention, in the form `abc.def.ghi`. For example `com.renoise.elements` for
one of our Renoise-published libraries, but you can use whatever name you like as long
as it has those three parts.

By now the file structure might look like this: �

+ Samples
+ Multi-Samples
+ Instruments
manifest.xml

� You can even add additional files if you wish to - perhaps a PDF document or a
'readme'. These files will not be useful to Renoise, but will still be installed on the user's
machine as part of the library.

7.2.3 Creating The Library File

Using a zip archive utility (on Windows, 7Zzip is recommended), you first compress the
inside of the root folder, and then assign it the name provided in the manifest plus the
Renoise library file extension .xrnl. So, in the case of our example pack, the file name
would become `org.username.examplepack.xrnl`

7.2.4 Test Install

You can now install the library to check that everything has worked by simply dragging
the file on top of the Renoise window. To install in Redux either drag the file on top of
the plugin window or click the load button  of the Preset Selector.

Renoise 3.4 User Manual

7.2.1 Build The Collection 28

https://www.7-zip.org


A successful install should result in a message like this: �

Library 'xxx' was successfully installed.
It contains Instrument presets.

� If the installer encountered a problem you will be provided with a error message
containing information that will be useful in tracking down the problem.
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8 Transport Panel
Found at the top-left of the Renoise interface, the Transport Panel allows you to control
song playback and alter other relevant global options.

8.1 Song Controls

 - Start playing the song or pattern.

 - Toggle pattern looping, which constantly repeats the current pattern.

 - Stop song/pattern playback. Click twice or right-click to activate Panic: stopping
all sounds immediately.

 - Toggle Edit Mode. With Edit Mode enabled, all notes played via the keyboard are
recorded into the pattern/phrase. Notes can be recorded into the Pattern Editor while
the song is stopped or as it is playing (if Pattern Follow is on).

 - Toggle Pattern Follow mode. When enabled, the cursor will follow the playback
position down the pattern as the song plays. This allows you to record "live", inserting
notes at the current point in the song. When disabled, you can freely move the cursor
around as the song plays, inserting notes and making edits wherever you like (most
useful with pattern looping on).

 - Toggle the metronome. Extra metronome options are available in the Options and
Song -> Song Options menus in the Upper Status Bar.

8.2 Song Parameters

 - Block Loop: This causes a section of the current pattern to be looped and
works independent of the full pattern loop option. The value box to the right allows you
to adjust the exact fraction size of the looping section. If you need to concentrate on
recording and editing only a small section of a pattern, then this option can be very
useful.

 - Sync: Sets the clock source that Renoise will synchronize to. Internal:
No external source is used. MIDI Clock: Use the external MIDI Clock Slave chosen in the
Preferences. Ableton Link: Use other Ableton Link peers on your wireless network. Only
active if other peers exist, whereupon the number of peers will be listed in the
drop-down menu. If Renoise is unable to reliably detect the actual output latency then a
custom offset can be set in the Audio panel of the Preferences menu.
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 - Beats per Minute: The current tempo of the song, also known as BPM.
As well as whole numbers, the value box can accept numbers with a decimal point, e.g.
125.5. To do this, double click on the value box and enter a new BPM value with the
keyboard. To adjust the tempo as the song is playing, you can use the Effect Command
ZTxx, where xx is the new BPM in hexadecimal. This can also be automated on the
Master Track. If a MIDI Clock Slave has been set up, a new toggle button  for it will
appear here.

 - Lines per Beat: This changes the number of lines in the Pattern Editor
that make up a musical beat. The higher the LPB, the greater the resolution available to
you for editing notes, effects and automation. This can be also be adjusted as the song
is playing via the Effect Command ZLxx, where xx is the new LPB value in
hexadecimal. This can also be automated on the Master Track.

 - Computer Keyboard Velocity: When enabled, the computer
keyboard will play and record notes at the velocity set in the value box. When disabled,
only notes will be inserted, leaving the existing velocity value untouched.

 - Keyboard Octave: The current octave of both the computer keyboard
and external MIDI keyboard. Moving this value up and down alters the octave of the
notes played and hence their pitch.

 - Selected Instrument: If the Instrument Selector is hidden then
the currently selected instrument will be displayed here instead. The drop-down menu
can be used to select from the list of available instruments.
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9 Track Scopes & Spectrum
The Track Scopes and Spectrum panel provides two different visual representations of
your song, allowing you to see what's currently happening in each individual track or
examine the frequency and amplitude of the final audio signal. When the
Scopes/Spectrum panel is open, you can expand its vertical size by click-dragging the
horizontal bar just beneath it. You may find it useful to watch our video on this subject.

The icons for toggling the panel can be found near the top right of the interface:

 - Shows the Track Scopes.• 
 - Shows the Spectrum.• 

 - Opens or closes the Scopes/Spectrum panel. Note that you can have them
independently open or closed when viewing the Pattern Editor/Mixer or the
Instrument Editor.

• 

 - When the main interface's right panel, containing the Disk Browser and
Instrument Selector, is closed, this icon will appear, allowing you to still view the
Instrument Selector.

• 

Note that when the Mixer has been detached as a separate window the Spectrum panel
and its button are moved with it.

9.1 Track Scopes

The Track Scopes show the audio output from all tracks simultaneously. The waveform
represents not just the volume of the sound, but also its basic frequency characteristics
(bass sounds will appear broad and flat, while high pitches look sharp and jagged). MIDI
instruments, which only send MIDI events and thus have no audio visualisation, are
represented by a small red dot in the lower-right corner of the Scopes.

The currently selected track is highlighted with a different text colour. At the left side of
each Scope is the track name (top) and number (bottom). If the track is part of a Group
or is routed to a Send track then this will be shown next to the track number.

The background of the Scopes can be colored to match the track colors, if they're
active. Go to Preferences > GUI > Scopes and activate "Show track color blends".
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9.1.1 Mouse Operations

The Pattern Editor’s current track can be changed by clicking on its name or by
scrolling through the tracks with the mouse wheel.

• 

Left clicking a Scope will mute the audio coming from that track and left clicking
again will un-mute it.

• 

Right clicking will solo a track, which mutes all of the others so that only the
audio from that track is heard. Right clicking again will un-mute the other tracks.

• 

The middle mouse button will mute this track for the current pattern of the
pattern sequence (see Pattern Matrix).

• 

Note that if the track-function is set to Mute in the Preferences menu, the Scope will
display Mute instead of OFF and affect the playback accordingly.

9.2 Spectrum

The Spectrum analyses the spectral composition of the audio produced by the selected
tracks and displays the results within the dynamic range of human hearing (roughly 20
to 20,000 Hz). This can be useful in analysing the character of your music and noting
whether any frequencies are dominating or lacking in the mix.

For an exact value of both the frequency and volume at a specific point, move the
mouse pointer into the grid and it will display a cross. The frequency and volume values
present at the centre of the cross will be shown at the top and left sides of the grid,
respectively.

At the right-hand side is a Phase Meter, displaying the stereo balance and phase of the
master audio output. Directly underneath this is the Phase Correlation Meter, which
shows you how in/out of phase the left and right signals are.

Right clicking on the Spectrum will open a menu with the following options:

Show Phase View: Toggles the Phase Meter on/off.• 
Show Scopes/Spectrum: Choosing Scopes will display the audio produced by
the Master Track in stereo. It can be a useful visual tool for examining the
amplitude of the left and right channels of your final mix.

• 

Track Display A/B: With these options you can select two sound sources to
compare against each other in the Spectrum. You can choose from any available
track, group or send.

• 

Drawing Mode: Choose how the audio is represented from four different styles.• 
Spectrogram Colors/Speed: Only available with the Spectrogram drawing
mode selected, this changes its color and speed.

• 

Frequency Scaling: Switches between Logarithmic and Linear frequency
scaling.

• 

Block Size: Alters the drawing resolution of the visuals.• 
Channel Mix: Choose whether the Spectrum is calculated from a combined
stereo signal or from each channel separately (requires more cpu power).

• 
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Peak Fall: The speed at which the visuals will fall from a higher volume to a
lower one.

• 

Slope Factor: Displays an artificial amount of added volume per octave.• 
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10 Instrument Selector
Located at the top right of the Renoise interface, the Instrument Selector lists the
Instruments that are contained within the song. The currently selected instrument is
highlighted and will be played back and recorded when editing or recording notes into
patterns. Instruments are numbered on the left and this number is used by the Pattern
Editor to refer to each specific instrument during playback. When an instrument is
playing, the playback indicator to the left of its name will light up. A chain icon next to
the playback indicator shows that this instrument is restricted to playing in a single
track. The icons to the right of an instrument's name show whether it contains samples,
plugins, MIDI or phrases and clicking on an icon will take you to the relevant section of
the Instrument Editor.

You can find out how to create new instruments or edit existing ones in the Instruments
section of the manual.

10.1 Resizing The Interface

The interface can be expanded horizontally by left-click-dragging the left edge of the
panel, and vertically by left-click-dragging on the bar between the Instrument
Properties and the Disk Browser. There are also a couple of options at the top right
corner:

 - Closes or opens the entire right panel, hiding both the Instrument Selector
and the Disk Browser. Note that when closed, the visibility icon below will move
next to the Track Scopes icons, allowing you to still view the Instrument Selector.

• 

 - Toggles the visibility of the Instrument Selector. When hidden, the current
instrument can still be selected with a drop-down menu that appears in the
Transport Panel.

• 

10.2 Instrument Options

 - Removes the selected instrument from the list.• 
 - Inserts a new empty slot below the selected instrument.• 
 - When enabled, upon changing the pattern or track, the instrument under or

nearest to the cursor will be automatically selected in this list.
• 
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Right clicking on the Instrument Selector presents you with some extra options:

Duplicate: Creates a new copy of the selected instrument.• 
Clear: Deletes the selected instrument and leaves a blank slot in its place.• 
Rename: Give an instrument/sample a new name.• 
Render Plugin To Instrument: Available for plugin instruments only. This will
create a sample-based instrument from the selected plugin instrument. After
rendering, the new instrument replaces the plugin, which is also unloaded. Using
this method you can share Renoise songs with people who may not have a
specific plugin.

• 

Render Plugin To New Instrument: Available for plugin instruments only. This
will create a new sample-based instrument from the selected plugin instrument.
The new instrument is placed into an empty instrument slot, leaving the original
plugin untouched.

• 

Delete Unused Instruments: Will remove and unload all instruments which
are unused, i.e. not played on any pattern within the song.

• 

Load Instrument...: Opens a new dialog box to select a file for importing.• 
Save Instrument As...: Export an instrument to a file for later use and
importing. This can also be done in the Disk Browser.

• 

10.3 Moving Instruments

The list can be reorganized by dragging and dropping instruments in the Instrument
Selector. When this is done, Renoise automatically adjusts the numerical reference of
instruments within the Pattern Editor, ensuring that the song still plays the same. If you
wish to swap or replace one instrument with another, you can do so by copy/pasting it,
or by remapping it in the Advanced Edit panel.

Samples and instruments can be dragged and dropped from the Disk Browser to the
instrument list and files can also be dragged and dropped from external Windows
Explorer (PC) or Finder (MacOS) windows. Note that in this case the currently selected
instrument slot will be used, possibly overwriting an existing instrument.

10.4 Shortcuts

ALT + UP/DOWN: Select previous/next instrument in the list.• 
NUMPAD KEYS -/+: Select previous/next instrument in the list.• 
ALT + LEFT/RIGHT: Select previous/next page in the Instrument Selector.• 
NUMPAD KEYS 1-9: Select first to ninth instrument currently visible in the list.• 
ALT + SHIFT + UP/DOWN: Scrolls through the list of samples contained in the
current instrument.

• 
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10.5 Instrument Properties

At the very bottom of the Instrument Selector is the Instrument Properties section,
which can be opened/closed using the  button at the top right. This is intended to
give you quick and easy access to the more common instrument options of the selected
instrument without having to open the Sampler, Plugin or MIDI tabs. When this section
is open, pressing the  button will open the selection menu, allowing you to choose
which options will be shown.
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11 Playing Notes with the Computer Keyboard
Note: The following explanation applies to QWERTY type keyboards, as shown below.
The Z-key may be positioned differently on other types of keyboards.

In Renoise and Redux you can use your computer keyboard to play, record and edit
notes. This virtual keyboard is always enabled and has the following layout, with the
blue keys representing the current octave, green keys the upper octave and red the
octave above that:

11.1 Note Off

In addition to the normal musical notes, there is also a Note-Off command to signal that
the previous note has stopped. When recording live, this is automatically entered into
the Pattern Editor as the note is released. Otherwise it is recorded manually with
Caps-Lock or the A key.

You may find it useful to watch our video covering both Note-Off and NNA.

A Note-Off command will trigger an instrument's release element(s), which can be:

Playing Note-Off Layer samples.• 
Finishing loops of samples which have the Finish Loop option enabled.• 
Advancing AHDSR or Envelope modulation devices to their Release phase.• 
(Renoise only) Any custom release events from Plugin or MIDI instruments.• 

11.2 Octave Settings
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By default, the lower keys (ZXCVBNM) are set to octave 3 and the upper ones
(QWERTYU) use octave 4. To play lower and higher octaves than this, you can change
the "Oct" setting in Renoise with the Transport Panel, or "Octave" to the left of the
keyboard in Redux's full Editor mode. You can also use the / and * buttons located on
the numpad (alternatively, use "Left Ctrl + [ or ]"). Be aware that the octave setting
also applies to the MIDI master keyboard input.

11.3 Note Velocity

In Renoise, this option is found in the Transport Panel, while in Redux, it is to the left of
the keyboard when in full Editor mode. When enabled, the computer keyboard will play
and record notes at the velocity set in the value box. When disabled, all notes will be at
maximum velocity.

11.4 Computer Keyboard Limitations

To simply edit and record notes in the Pattern Editor or Phrase Editor, the computer
keyboard will do the job just fine. You can even use the computer keyboard for
Recording and Editing Notes as the song is playing (Renoise only). Unfortunately, most
computer keyboards do not allow all key combinations to be pressed at the same time,
nor are they velocity sensitive. So when the accurate recording of "live" playing is
essential, the use of a MIDI keyboard is highly recommended. See the Setting Up MIDI
Devices section for full instructions on how to configure a MIDI keyboard in Renoise.
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12 Tracker Interface
Time runs vertically in a tracker, moving down line-by-line from the top of a
pattern/phrase to the bottom, triggering the sequence of notes and commands found in
each line. Notes and effects are recorded into the tracker interface in the order that
they are to be played back.

The Pattern Editor and Phrase Editor both organise their notes and effect commands in
the same way, though a phrase is the equivalent of a single track from the Pattern
Editor.

12.1 Columns

There are two types of main column: Note and Master FX. Note columns are used to
record instruments/samples by entering notes into the note sub-column, while the
other sub-columns affect how the note is played. The note sub-column is always visible,
while the others can be turned on/off with their corresponding buttons in the Pattern
Editor Control Panel or Phrase Editor Options. Master FX columns are used to apply
Effect Commands that affect the behaviour of the entire track/phrase. The images
below illustrate the column layout for Renoise and Redux:

Note Column
Note: e.g. C-4, A#3. The first two characters represent the musical note,
while the third character is the octave number. The notes are not entered

♦ 
• 
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letter by letter like a text editor, but like a piano, using the computer
keyboard or a MIDI master keyboard.
Instrument/Sample Number: The instrument/sample number that will
play the note. Optional in the Phrase Editor only.

♦ 

Volume: (00-80) - The note velocity/volume, where 00=minimum and
80=maximum. Additional effects can also be triggered from here.

♦ 

Panning: (00-80) - The panning of the note, where 00=full left, 40=center
and 80=full right. In Renoise, this will only be applied to samples (MIDI and
VST plugins will be unaffected by values in this sub-column). Additional
effects can also be triggered from here.

♦ 

Delay: (00-FF) - A time delay added to the note, where 00 is no delay and
FF will result in the note being delayed until immediately before the next
line.

♦ 

Local FX: Effect Commands entered into this column will only affect the
notes being played in this particular Note column.

♦ 

Master FX: Effect Commands entered into this column will affect the entire
track/phrase.

• 

12.1.1 Muting Columns

An individual Note column can be muted by left-clicking on the 'Play' text underneath
its name. Clicking again will un-mute it. Right-clicking a Note column's 'Play' text will
solo it within a track, muting all of the others so that only the audio from that column is
heard. Right-clicking again will un-mute the other columns.

12.1.2 Renaming Columns

A Note column can be renamed by double-clicking on its name (by default this is 'Note')
and typing in a new one, finishing with Enter.

12.1.3 Adding, Deleting & Moving Columns

You can add or delete the two main column types with the  buttons at the top left and
top right of a track or phrase. There can be up to twelve Note and eight Master FX
columns. To reposition a column left-click and hold the button on its name, then drag
the column to either side.

12.2 Lines

Each individual pattern/phrase can have a different length, from 1 to 512 lines, which
can be changed by altering the value in the box at the top left of the tracker interface:
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12.2.1 Lines, Beats and Pattern Resolution

There is a "Lines per Beat" option which changes the number of lines that make up a
musical beat. The higher the LPB, the greater the resolution available to you for editing
notes, effects and automation. In the Pattern Editor, this is found in the Transport Panel
and it affects the entire song. It can be changed during playback with the ZLxx effect
command. The Phrase Editor uses the Phrase Properties panel to adjust the LPB for
each individual phrase.

By default the LPB is 4, meaning that placing a note on every highlighted line will
create a simple 4/4 beat in a pattern that is 16 lines long. How many lines you use for a
beat is totally up to you, but it can be important to get it correct if you're interacting
with other beat-based instruments or sequencers (e.g. plugins which use beat timings),
or when syncing a song/phrase with other applications via ReWire.

When working with time signatures other than 4/4, it's useful to set your number of
lines in a pattern to a factor of the time signature's numerator multiplied by the LPB.
For example, when working in 3/4 and a LBP of 4, you could use a pattern length of 12,
24 or 48; when working in 5/4 you could use a pattern length of 20 or 40 etc. This will
allow you to place your notes on exact pattern lines without having to delay notes with
the delay column.

In Renoise the line highlighting of the Pattern Editor automatically matches the LPB, but
you can change this to a specific value via the Song Options menu.

12.3 Navigating & Selecting

Moving the cursor around the Tracker Interface can done with the arrow keys or by
left-clicking with the mouse (either single or double click depending on your
preference). The "Page Up/Down" buttons will move the cursor up and down 16 lines at
a time. To quickly jump to the next note column press "TAB", while "Left Shift + TAB"
will jump back to the previous note column. "F9", "F10", "F11" and "F12" will move to
the beginning, first quarter, half, and last quarter of the pattern, respectively. Press
"End" to skip to the last line in a pattern.

To select an area, hold down the "Left Shift" key while moving around with the arrow
keys. This can also be done by left-clicking and dragging with the mouse (holding "Left
Control/Command" will scroll through lines much quicker). By holding down the left
"Alt" key, you can fine-tune both of these methods to select individual sub-columns. A
selection can also be made by starting with "Left Control/Command + B", moving the
cursor to another position and ending with "Left Control/Command + E".

The selection can be now cut, copied and pasted using the standard shortcuts of "Left
Control/Command + X (Cut), C (Copy), V (Paste)", or affected by more complex
transformations with the Advanced Edit panel or the shortcuts listed below.
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Alternatively, the selection can be moved by left-click and dragging the selected area
to a new position. Holding down the "Left Control/Command" key while releasing the
mouse button will copy the selection to the new location and keep the original
selection, instead of just moving it.

12.3.1 Other Keyboard Shortcuts

To quickly copy, paste and perform edits in the Pattern Editor (current pattern only) and
the Phrase Editor:

F1 + MODIFIER: Transpose one note down• 
F2 + MODIFIER: Transpose one note up• 
F3 + MODIFIER: Cut• 
F4 + MODIFIER: Copy• 
F5 + MODIFIER: Paste• 
F6 + MODIFIER: Flip• 
F11 + MODIFIER: Transpose one octave down• 
F12 + MODIFIER: Transpose one octave up• 

Where MODIFIER is:

Left ALT: Selection in the Pattern/Phrase• 
Left CONTROL/COMMAND + SHIFT: Current Column• 
Left SHIFT: Current Track/Phrase• 
Left SHIFT + ALT: Current Group• 
Left CONTROL/COMMAND: Whole Pattern/Phrase• 

12.4 Hexadecimal

You may find hexadecimal easier to understand by watching our video on the subject.

In the tracker interface many values use the hexadecimal system. We're all familiar
with counting; a digit has a range of 0 to 9. It counts upward one at a time and after
reaching 9 it becomes 10 – one-zero. The counting begins again, going up to 19, then it
becomes 20 – two-zero… and so on until 99.
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In hexadecimal though, the digit range doesn't stop at 9. It extends past this with the
letters A B C D E and F, which represent the values we know in decimal as 10 11 12 13
14 and 15. It then becomes one-zero, which represents 16. The counting begins again,
going up to 1F and then becomes two-zero, which is 32… and so on until FF.

So in decimal the range of possible values with two digits is 100: 00 to 99. In
hexadecimal, the range of 00 to FF is 256. This allows for more instruments and
samples to be represented by just two digits and also gives greater accuracy for the
volume, panning and delay columns, and when applying values to Effect Commands.
It's important to note though, that although the values in the Local and Master FX
columns use hex, the Effect Commands themselves do not. They use letters, but it's to
represent what the effect does, e.g. S for 'Slice' or V for 'Vibrato'.

So where did hex come from and why are we using it? Well, it has its roots in binary
and coding, but the real reason it's used in Renoise and Redux is because of their
tracker heritage, where efficiency and that extra resolution was very important. Even
though much has changed, these things are still relevant today.

It can take a while to get used to working this way, but it does become easy. To get
started, here's a simple example of the hexadecimal system:

00 = 0%• 
40 = 25%• 
80 = 50%• 
C0 = 75%• 
FF = 100%• 
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13 Recording and Editing Notes
There are two ways of recording notes in Renoise (Redux only uses Step By Step):

Step By Step: Enter and edit notes manually with the computer keyboard or a
MIDI keyboard, step by step. This can be done while the song/phrase is stopped
or while it's playing back.

• 

Live Recording: Record what you are playing 'live' as the song is playing back.
This is how most sequencers record notes.

• 

13.1 Edit Mode

To be able to record anything, first make sure that Edit Mode is enabled by pressing the
"ESC" key on your keyboard. Alternatively, in Renoise you can click the record button in
the Transport Panel, while in Redux there are two options in the Phrase Editor: the Edit
button at the bottom left and the 'edit on/off' area at the top right corner of the phrase.

The red border around the Pattern/Phrase Editor indicates that Edit Mode has been
activated and inputs will now be recorded at the cursor position:

13.2 Entering Notes Step By Step

To record notes step by step, simply play notes with Edit Mode enabled. The note will
be inserted into the Note column at the current cursor position and the cursor will move
downwards within the editor.

The amount of lines that the cursor moves by can be changed with the Edit Step
parameter, which can even be set to zero. In the Renoise Pattern Editor the Edit Step
value box is found in the control panel underneath the tracks, while in the Phrase Editor
of both Renoise and Redux it's at the bottom-left corner of the phrase. The keyboard
shortcut to change the Edit Step value is "Left Ctrl + 1,2,3,4,5,6,7,8,9,0".
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A note can be deleted by pressing the "Delete" key when the cursor is over it. Pressing
"Backspace" will delete any note or blank space under the cursor, causing all notes and
effects in entire track below this point to move up.

You can also record/delete notes step by step while the song/phrase is playing, though
when doing this in the Renoise Pattern Editor, ensure that Pattern Follow is disabled to
decouple the cursor from the playback position.

13.3 Live Recording (Renoise Pattern Editor Only)

To record notes "live":

Turn Pattern Follow ON  in the Transport Panel (or use the "Scroll Lock" key),
which couples the cursor to the playback position.

1. 

Start the song playing with Edit Mode enabled.2. 
Play notes with the computer keyboard or your MIDI master keyboard.3. 

The played notes will now be recorded into the track at the current playback position in
the Pattern Editor.

Tips

To enable Edit Mode and start playing with a single button press, you can also
use the "Right Shift" key.

• 

To just start playing, you can use either the "Spacebar" or "Right Ctrl".• 
Pressing the "Right Alt" key will start playing, but will also loop the current
pattern.

• 

To enable a count-in for live recording, turn on the Metronome precount via the
Options menu in the Upper Status Bar. You can also adjust the amount of bars
the count-in lasts here.

• 

13.3.1 Real-time and Manual Quantization

When recording notes "live", by default they will be recorded with the highest possible
precision using the Note Delay sub-column in the Pattern Editor. The note delay column
allows you to delay notes with a precision of 1/256th of a line.

If you do not want to precisely record your notes, you can let Renoise quantize them
either in real-time or after recording something. This is done with the quantize controls
in the Pattern Editor control bar:

The "Q" button enables or disables live quantization, while the value box to the right
specifies the quantization value in lines. Use the drop down menu next to the value box
to manually quantize a range within the current pattern after recording.
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13.4 Polyphonic vs. Monophonic Recording

Sequential (monophonic) recording can often be better when recording drums or
monophonic instruments. The Mono button allows you to toggle between recording a
single note at a time or multiple notes simultaneously (chords). This is located in the
Instrument Properties panel, found at the top right of the interface in Redux and near
the top right while in the Sampler, Plugin and MIDI tabs of Renoise.

13.5 Entering Chords with the Computer Keyboard

When entering notes step by step with the computer keyboard, they will by default be
placed sequentially. If you want to quickly insert chords without live recording, you can
do this by holding down "Left Shift" while entering the notes. This will automatically
create new note columns to the right and enter the new notes there.

Note that MIDI keyboards will always record chords when pressing more than one key
at a time.

13.6 Ghost Notes

A ghost note is a note in the Pattern/Phrase Editor that’s had its instrument or sample
number removed by the user. When played it will retrigger the most recently played
instrument or sample in its column, but with some useful differences from the normal
behaviour. This concept and its consequences for playback can be quite technical even
for advanced users, so it's strongly recommended that you watch the tutorial video
with its demonstrations to gain a firm understanding.
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13.6.1 What Is Retriggered?

It's incredibly important to wrap your head around exactly what a ghost note will be
retriggering, because this can vary depending on the point at which song or phrase
playback has begun.

What's triggered is the previous regular note (one with an instrument/sample number)
that has been encountered in this column. So if the song or phrase is started from a
point where any ghost notes are played after a regular note was played then this is not
a problem. But, if a ghost note is played without having encountered a regular note
during this playback then the instrument or sample triggered will be the last one ever
played in this column.

This can actually be from a previous playback of the song or phrase, and for the Pattern
Editor this also includes any instrument that has since been manually played by the
user with the cursor in the same column as the ghost note.

13.6.2 Free-Running Modulation

Although playback of an instrument's samples are restarted for a ghost note, the
Modulations are not; they continue uninterrupted. This affects all of the instrument's
samples with regard to the Modulation Set that they’ve been assigned. If you’d like this
modulation benefit to apply to an instrument that’s using phrases, then you’ll need to
create the ghost notes within the phrase itself.

13.6.3 Volume & Panning

The volume and panning values of the original note are passed on to the ghost notes if
they don't specify their own values. When a value is specified though, the changes
apply to that individual ghost note only, meaning that the values will revert back to the
original form for each consecutive ghost note.

None of this applies to delay values, but the other things that are affected are the I and
O effect commands, in both the volume and fx columns, and the J and K commands in
the panning column. These will continue fading in or out, or panning left or right
without restarting for ghost notes.

Everything mentioned in this section applies to playback within phrases as well, but
does not work when ghosting phrases from the Pattern Editor.
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13.6.4 Phrases – Pitching & Switching

While the previous two sections applied to samples only, this one also applies to the
Plugin and MIDI components of an instrument.

When an instrument makes use of phrases, ghosting it from the Pattern Editor doesn't
restart the phrase playback, but instead it performs the same function as an instant
glide. While this is convenient by itself, it's the combination with phrase switching (Zxx)
that makes it so powerful. Switching from one phrase to another and continuing from
where the previous one left off can normally only be done by inserting that specific line
with Sxx. However, using a ghost note will make this process automatic.

When switching to a phrase that uses ghost notes remember that the sample to be
triggered in each column will be the last one that ever played there.
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14 Pattern Editor

The Pattern Editor is the main editor used to create music in Renoise and is opened
with the Edit tab at the top left of the interface. Instruments are recorded by entering
notes onto lines in the order that they are to be played, from top to bottom. This is
done with the Tracker Interface, so if you're unfamiliar with this method of working, you
should read through that section of the manual before continuing here.

A pattern can contain multiple tracks, typically one for each different instrument and
each with their own separate set of effects. Songs are created by arranging a sequence
of patterns with the Pattern Sequencer and the Pattern Matrix. So, a pattern is normally
used to represent a specific section of a song that may be repeated again in future. The
length and speed of a pattern can be changed, so the exact nature of a specific pattern
can vary wildly depending on the whims of the composer.

You may find it useful to watch a video about the various track types.

14.1 Track Types

There are four different types of track in the Renoise Pattern Editor:

14.1.1 Tracks
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These standard tracks are where you record notes onto the lines of a Note Column.
Each track also features Effect Columns, which are used to apply Effect Commands to
instruments and to control Track Effects.

14.1.2 Group Tracks

Used to group together similar Tracks, such as all percussion, all synths etc. The child
tracks have their output automatically routed through the parent track, though you can
change this with the Pre Mixer. This means that Track Effects, Automation and Effect
Commands used in the Group Track will affect the audio coming from the regular
Tracks contained within it. Notes cannot be entered into Group Tracks and so they only
feature Master FX columns.

14.1.3 Send Tracks

Send Tracks are fed audio from other tracks using Send Devices and are typically used
to apply the same set of Track Effects to multiple tracks at once, though there is a
whole range of possibilities for creatively complex routing. Notes cannot be entered
into Send Tracks and so they only feature Master FX columns.

You may find it useful to watch our video covering the subject of Send Tracks &
Devices.
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14.1.4 Master Track

The Master Track is where all audio produced by the other tracks finally ends up, so
effects placed here will therefore affect the output of the entire song. To help manage
the master signal, the Post-Mixer device in the Master Track has a few more options
than the other tracks. Notes cannot be entered into the Master Track and so it only
features Master FX columns.

14.2 Track Options

14.2.1 Muting Tracks

An individual track can be muted by left-clicking on the 'Play' text underneath its name.
Clicking again will un-mute it. Right-clicking a track's 'Play' text will solo it, muting all of
the others so that only the audio from that track is heard. Right-clicking again will
un-mute the other tracks. Similar operations can be performed on the Track Scopes.

14.2.2 Organising Tracks

Any track can be renamed by double-clicking on its name and typing in a new one. This
is also true for Note Columns.

To add or remove tracks, you can use the "Edit->Insert Track" (Left Control/Command
+ T) and "Edit->Delete Track" (Left Control/Command + Left Shift + T) commands from
the menu in the Upper Status Bar. If the currently selected track is a regular Track, then
a new Track will be added to the right of it. If the currently selected track is a Send
Track or the Master Track, then another Send Track will be added.

To add a group track, use the "Edit->Insert Group" (Left Control/Command + G)
command or drag one track onto another while holding down Alt. This will create a new
group and add both tracks to it.

To reposition a track left-click and hold the button on its name, then drag the track to
either side. This can be done in both the Pattern Editor and the Mixer. You can also
move tracks by using the Ctrl/Command + Alt + Left/Right shortcuts.
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To duplicate tracks, you can use the "Edit->Duplicate Track" (Left Control/Command +
D) command from the menu in the Upper Status Bar.

14.2.3 Collapsing Tracks

To collapse a track, press the small arrow to the left of the track's name. This just hides
most of its information; the track will still play as normal. You can collapse a Group of
tracks in the same way and also collapse the Group's Master FX column using the arrow
to the right of its name.

Using Single Track Edit Mode will cause all of the tracks and groups to collapse, except
for the track that the cursor is currently in. Moving the cursor to other tracks while in
this mode will automatically expand those tracks and collapse the one you were
previously in.

14.2.4 Changing Track Colors

To change the color of a track, left-click on the color slot above the track name. Using
the color picker you can move around the grid to choose a color, while the left-hand
slider controls the saturation value. You can also pick colors from the available
swatches or right click on a swatch to save the current color to it. The "Background
Blend" slider controls the amount of color present in the track's background. Enabling
"Apply to all tracks" will apply the slider value to all of the tracks at once.

14.3 Pattern Editor Control Panel

At the bottom of the Pattern Editor is the control panel:

Single Track Edit Mode: When enabled, all tracks will be collapsed except for
the currently selected track.

• 

Pattern Wrap Mode: Toggle what will happen upon reaching the end of a
pattern when entering notes step-by-step in Edit Mode. When enabled, the cursor
will move to the top of the next pattern in the sequence. When disabled, the

• 

Renoise 3.4 User Manual

14.2.2 Organising Tracks 54



cursor will move back to the top of the current pattern.
Pattern Automation Recording Mode: When enabled, right-clicked and MIDI
mapped parameters are recorded into Automation instead of the track's Master
FX Column.

• 

Quantize Controls: Toggle live quantization. The value box to the right
specifies the quantization value in lines. Use the drop-down menu next to the
value box to manually quantize a selected area of the current pattern after
recording. Quantization is covered in-depth in this video.

• 

Edit Step: Set how many lines the cursor will skip down in the Pattern Editor
when entering a note or effect.

• 

Vol/Pan/Dly/FX: Toggle the volume, panning, delay and Local FX sub-columns
for the currently selected track.

• 

FX Drop-down Menu: Quickly show and insert Effect Commands.• 
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15 Pattern Sequencer
The Pattern Sequencer crafts a song's overall progress by defining the order in which
the various patterns are played. A song begins with the pattern at very top of the
sequence. When this pattern has finished, the next in the sequence is started. This
carries on until the final pattern has played and the end of the song is reached. At this
point, a song can either loop back to the beginning again or just stop.

The sequencer refers to patterns via their number. Patterns with different numbers hold
different content within them, while patterns that share a number contain identical
content. When you begin creating a new song there will be only a single empty pattern
present: "0".

The pattern which you're currently editing in the Pattern Editor is shown in the Pattern
Sequencer with a shaded border around it. On the far left of the interface is the
sequence number, which also doubles as a pattern trigger button. At the immediate left
and right of the pattern number are two arrows which change its value. You can also
double-click on the number and type in a new value with the keyboard.

To the right of the pattern number are a set of buttons. The plus and minus buttons
insert and delete patterns. Beneath this is the Clone Pattern button, which inserts a
copy of the current pattern into the pattern sequence. At the top is the Section Header
button, used to enter text into the sequence to provide descriptions and keep things
organised.
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To aid with this, you can also name each pattern. Click and drag the right edge of the
Pattern Sequencer over to the right. This will expand it and reveal the name slots. Click
on a slot and enter a name with the keyboard, finishing with "Enter".

15.1 Creating/Cloning/Adding/Removing Patterns

Create a new pattern
Left-clicking the circled plus button creates a new empty pattern
below the current pattern. Right-clicking repeats the current
pattern.

Delete the current pattern
Clicking the minus button will delete the current pattern and all of
its contained information.

Clone the current pattern
Clicking the Clone Pattern button creates a new pattern with
duplicates all of the note, effects and automation data from the
current pattern. Cloning is the same as copying & pasting
everything from an old pattern to a new one.

15.2 Decoupled Playback

You can detach the playback position from the current edit position, letting you edit a
pattern while other patterns are playing. To do this turn off the "Pattern Follow"
option in the Transport Panel. This way you never have to stop the song while editing a
separate section.

15.3 Triggering Patterns

Patterns can be scheduled for playback via the number/play buttons to the left of the
numbers in the Pattern Sequencer. Without stopping playback, you can trigger new
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sequences in the song in real-time. This lets you freely change the order of playback to
sketch out and improvise new ideas.

While the song is playing, left-clicking on a specific number/play button will move
the sequence on to that position as soon as the current pattern reaches the end.

• 

While the song is playing, clicking with the right mouse button will immediately
jump to and play that pattern without starting from the top.

• 

Double-left-clicking will immediately jump to and play that pattern from the top.• 
Holding "Left Shift" while left-clicking on a number/play button allows you to
specify more than one pattern for playback, so you can set up a "playlist" of
patterns (the next pattern to be played is highlighted, as shown in the image
above).

• 

15.4 Looping Patterns

Using the column to the immediate left of the pattern numbers, you can cause a
pattern or sequence of patterns to loop. Left-click and drag in this column to indicate
the patterns you want to loop. To remove a loop just click on a single slot twice.
Clicking here next to a section header will automatically select all of the patterns in that
section.

15.5 Working With Selections

Clicking on the number slot itself allows you to select it. Likewise, clicking and dragging
will select a sequence of patterns. You can also click once and then Shift-click on
another pattern to select a range in just two clicks. Clicking the blank slot next to a
Section Header will automatically select all of the patterns contained within that
section. To remove a selection, just click on any of the empty space in the Pattern
Sequencer, such as above/below the buttons or numbers.

Once patterns have been selected, they can then be copied, pasted, moved or cloned
(make sure you have released the mouse button after selecting).

Drag and Drop without any modifier to move the selected patterns to a new
position.

• 

Holding down "Left Control/Command" will insert copies of the selected patterns.• 
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Holding down "Left Alt" will insert repeats (aliases) of the selected patterns.• 

Right-clicking on any pattern number will bring up a menu with available shortcuts and
yet more operations that can be applied to a selection:

15.6 Auto-Sorting Patterns

By default, Renoise will automatically organise the sequence so that unique patterns
are numbered ascendingly (from 0 upwards). If you'd prefer to disable this, click with
the right mouse-button somewhere in the sequencer and untick the "Keep Sequence
Sorted" option in the context menu. This option is memorized per song. The menu also
offers other sorting options in the "Organize" sub menu.

15.7 Sequencer Shortcuts in the Pattern Editor

While editing patterns in the Pattern Editor, you can also quickly navigate and modify
the sequence using keyboard shortcuts:

Left Control/Command + Arrow Up/Down: Select the next/previous pattern
in the sequence.

• 

Left Control/Command + Arrow Left/Right: Change the current pattern's
number.

• 

Left Control/Command + Insert Key: Insert a new pattern into the sequence.• 
Left Control/Command + Delete Key: Delete the current pattern from the
sequence.

• 

Left Control/Command + Spacebar: Schedules the pattern currently being
edited for playback. This only works with decoupled playback enabled.

• 
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Left Control/Command + Left Shift + Spacebar: Immediately plays the
pattern currently being edited. This only works with decoupled playback enabled.

• 
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16 Pattern Matrix
To open the Pattern Matrix, click on the "P<>M" button at the top left corner of the

Pattern Editor: 

The Matrix is a "bird's eye view" of the patterns and tracks in the pattern sequence.
Patterns and tracks are divided into blocks that can be moved, copied and pasted,
enabling you to manage the flow of the music quickly and easily.

The Pattern Matrix also allows the muting of different tracks in duplicate patterns
(indicated with a cross in the picture below) and the aliasing of individual blocks. With
these simple yet versatile tools, it is possible to create a whole song (or song draft)
from a single pattern. Starting with one pattern containing many tracks, you can repeat
this pattern again and again in the sequencer, muting and aliasing individual blocks to
build up the song structure. Later on you can create new patterns from the original to
add variations.

16.1 Matrix Blocks

When you input data into a track in the Pattern Editor, a coloured block automatically
appears in the current track and sequence position in the Pattern Matrix.
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The blocks can be re-sized by clicking the small and large square icons under the

"P<>M" button: 

Left-clicking these icons changes the height of the blocks, while right-clicking changes
their width.

16.1.1 Drag and Drop

To move a block from one place to another, select a block by left-clicking and releasing,
then dragging and dropping it into the desired place.

Hold down "Left Control/Command" while dragging to copy blocks instead of just
moving them.

• 

Hold down "Left Control/Command + Left Alt" while dragging to alias blocks.• 
Hold down "Left Control/Command + Left Shift" while dragging to copy the
blocks and place them into a newly created pattern.

• 

Hold down "Left Control/Command + Left Alt + Left Shift" while dragging to alias
blocks and place them into a newly created pattern.

• 

16.1.2 Selection & Mouse

To select multiple blocks at once, you can click on an unselected block, hold and drag.
Alternatively, left-clicking and releasing, then holding down "Left Shift" before clicking a
second time will allow you to select a range of blocks. To remove or add a single block
at a time, "Left Control/Command + left-click".
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With these key combinations you could, for example, select everything from Track 1 to
Track 5, then exclude a single block in Track 2.

16.1.3 Muting Blocks

"Left Alt + left-click" or click the middle mouse button on blocks to mute/un-mute them.
This also works for muting/un-muting multiple selected blocks at once.

The same key combination or use of middle mouse button also works in the Track
Scopes.

16.1.4 Cloning Blocks

To quickly clone the contents of a block into one or more other patterns, position the
mouse pointer over the bottom edge of the desired box. The cursor will change to a
downwards facing arrow. Now left-click, hold and drag down over the desired patterns.
This also works for a selection of multiple boxes.

16.1.5 Aliasing Blocks

Block aliases are identical copies, where any changes made to the content of one alias
are automatically made to the others. This only applies to content within the Pattern
Editor, so when used with Automation this can be a quick and easy way to build up a
song structure with minimal individual blocks.

The easiest way to alias a block or a selection of blocks is to position the mouse over
the bottom edge and drag downwards while holding down ALT. The number of the
aliased pattern is now shown in the bottom right corner of each aliased block.

You can also alias a block by right clicking on it and selecting "Create Alias" from the
menu. A flashing cursor will appear in the block. Using the keyboard, type in the
number of the pattern in the pattern sequence that you wish to create an alias of,
followed by Enter. To remove the alias, right-click and choose "Un-alias".

16.1.6 Colouring Blocks

By default, blocks are coloured equally per track. To change a track's colour, click on
the small colour indicator below the track name in the Pattern Matrix. Using the color
picker you can move around the grid to choose a color, while the left-hand slider
controls the saturation. You can also pick colors from the available swatches or right
click on a swatch to save your current color to it.
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It is possible to colour each block individually. To do this, select one or more blocks,
then right-click on them and select "Set Slot Color..." in the context menu. The custom
colours will still be used if the blocks are copied.

16.1.7 Basic Shortcuts

Clone selected blocks into new patterns with "Control/Command + K".• 
"Left Control/Command + I" instead of "Control/Command + V" to insert instead
of pasting.

• 

"Left Control/Command + Left Shift + Arrow Up/Down" to quickly select multiple
rows.

• 

"Left Alt + P" and "Left Alt + T" to select the whole Pattern or Track.• 
"Left Control/Command + P" will create an alias, while "Left Control/Command +
U" will remove the alias from a slot.

• 

To bring Focus to the Pattern Editor, hit "ESC". To bring Focus back to the Pattern
Matrix, press "Left Shift + ESC".

• 

16.2 Visualization Options

Right-click on a slot in the Pattern Matrix to view the context menu, where you can
choose to show/hide the Track Names, the colors and the VU Meters.

If you activate the "Show Identical Repeated Slots" option from the context menu, a
tiny icon will be shown in the bottom-right corner of the slot(s) to indicate repeating
content.
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When the repeating content spans many slots, a gradient will be applied to their colour.
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17 Advanced Edit
To open the Advanced Edit panel, click on the "A<>E" button at the top right of the

Pattern Editor: 

The Advanced Edit panel allows you to perform batch operations on pattern and
automation data, such as transposing notes, remapping instrument numbers,
interpolating effect command values etc. There are multiple sections to the Advanced
Edit panel, which can be hidden/shown to either take up less space or to fully reveal
their options. Each section deals with a specific topic of modification.

17.1 Processing Scope

The first thing that needs to be set up is what will be edited and where this will take
place. This is done with the "Section to Process" and "Content Mask" panes at the top:

17.1.1 Section to Process

This section is always visible because it applies to all of the other sections beneath it,
by defining what part of the song will be affected:

Selection: Perform actions on what is currently selected in the Pattern Editor.• 
Column in Pattern: Perform actions on the note or effect column where the
cursor is, in the current pattern only.

• 

Column in Song: Perform actions on the current note or effect column where
the cursor is, in all patterns.

• 
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Track in Pattern: Perform actions on the whole track (all columns) in the
currently selected pattern only.

• 

Track in Song: Perform actions on the whole track (all columns) in all patterns.• 
Group in Pattern: Perform actions on the group in the currently selected
pattern only.

• 

Group in Song: Perform actions on the group in all patterns.• 
Whole Pattern: Perform actions on the entire current pattern.• 
Whole Song: Perform actions on the entire song; all columns, all tracks and all
patterns.

• 

17.1.2 Content Mask

With the Content Mask you can specify what will be processed and what will be ignored.
Left-clicking enables/disables a mask. Right-clicking enables a mask, but disables all
other masks (solo).

Notes: Apply processing (Cut, Copy, Paste, Flip) on note sub-columns in Note
Columns.

• 

Instrument: Apply processing (Cut, Copy, Paste, Flip) on instrument
sub-columns in Note Columns.

• 

Volume: Apply processing (Cut, Copy, Paste, Flip, Interpolate and Modify) on
volume sub-columns in Note Columns.

• 

Panning: Apply processing (Cut, Copy, Paste, Flip, Interpolate and Modify) on
panning sub-columns in Note Columns.

• 

Delay: Apply processing (Cut, Copy, Paste, Flip, Interpolate and Modify) on delay
sub-columns in Note Columns.

• 

Effect Number: Apply processing (Cut, Copy, Paste, Flip) on effect numbers in
the Effect Columns.

• 

Effect Value: Apply processing (Cut, Copy, Paste, Flip, Interpolate and Modify)
on effect values in the Effect Columns.

• 

Automation: Apply processing on graphical Automation attached to the tracks.
Copy/pasting Automation in general only works when copying patterns or tracks,
not selections.

• 

17.2 Performing Actions

All other panels allow you to modify the content you've specified in various ways:
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17.2.1 Cut/Copy/Paste

Cut: Copy then delete the content. Not all selections have clipboards and in
those cases the "Cut" button will be changed to "Delete".

• 

Copy: Copies the selected content. Not available for all selections.• 
Paste: Pastes previously copied content.• 

Flip: Reverse the content in place in the time-line (starting content will become
ending content). When applying this to selections which cover more than one
pattern, the patterns will be flipped one by one.

• 

Shrink: Halves the length of time that the content takes to play. Note that if the
content does not have enough room to be placed on individual lines after being
shrunk, some of the content will be removed.

• 

Expand: Doubles the length of time that the content takes to play. This is
especially useful when doubling the Lines Per Beat value to add more resolution.
If you were to only double the LPB without expanding the content, then it would
just play twice as fast as before.

• 

Mix-Paste: When pasting with mix-paste enabled, empty notes, instruments, effects
etc. are not copied. This way you can merge the copied selection with the existing
content that you're pasting on top of.

17.2.2 Modifying Notes

Safe Mode: Applies transpose settings only when the transposed note does not
fall outside of the available octave range in Renoise. With Safe Mode disabled,
notes that fall below C-0 or above B-9 will be removed.

• 

Apply to: Either apply the following operation to all instruments in the current
selection, or just the one specified in the value box.

• 
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Transpose: Transpose notes by a specific amount with the value box and
'Transpose' button, or by a semitone/octave at a time with the four buttons
underneath.

• 

Mirror: Swaps every note's height around the specified "center note". This can
be very useful for creating variations of melodies.

• 

Preserve Lengths: When enabled, any Note-Offs found within the processing
scope will not be quantized.

• 

Quantize: Quantize notes by the given sub-line factor (the factor used in the
note delay column). 100 sub-lines (256 in decimal) make up one full line. For
example, to quantize by 3 lines, you would use 300 sub-lines. Quantization is
covered in-depth in this video.

• 

Nudge: Moves notes up/down by the specified amount of sub-lines.• 

17.2.3 Modifying Instruments

Src instr.: Select the instrument number that will be modified.• 
Dest. Instr.: Set the destination instrument number that the source instrument
will be transformed into.

• 

Swap: Swap both the source and destination instruments within the selection.• 
Remap: Swap only the source for the destination within the selection.• 
Delete: Delete the source instruments within the selection.• 

17.2.4 Modifying Effects

Using these controls you can interpolate, fill in values, create fades for a given effect,
or apply mathematical operations on effect values (multiply, divide, sub, add,
randomize and humanize).

17.2.4.1 Interpolating Values

Suppose you wanted to create a volume fade in a track between the pattern lines 00
and 64. You could type the values in manually, line by line. However, you can instead
specify the desired starting and ending values of the fade on lines 00 and 64. Then by
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selecting the area from 00 to 64 in the appropriate track and using interpolation, the
intermediate numbers will automatically and accurately be filled in.

Lin: Create a linear range.• 
Log: Create a logarithmic range.• 
Exp: Create an exponential range.• 

Note that Renoise will require valid starting and ending values in order to perform
interpolations. When interpolating effect column values, you must also ensure that the
starting and ending effects use the same effect numbers.

To quickly interpolate selections in the Pattern Editor, you can also use the shortcuts,
"Left Control/Command + I" to interpolate linearly and "Left Control/Command + L" to
interpolate logarithmically.

17.2.4.2 Modifying Values

Apply Perform the following action, modified by the specified value.
Set: Set all values in the selection to the specified value.♦ 
Add: Add the specified value to the existing values.♦ 
Sub: Subtract the specified value from the existing values.♦ 
Mul: Multiply the existing values by the specified value.♦ 
Div: Divide the existing values by the specified value.♦ 
Humanize: Randomise the existing values by adding or subtracting a
number within the specified value range.

♦ 

• 

Tip: Humanizing can be used to randomize note delay, volume and panning for
instruments. Small variations to such values can create a more human feel.

For example, to humanize drum note delays in a single track for the whole song:

In "Section to Process", enable "Track In Song".1. 
In the "Content Mask", enable "Delays" only.2. 
Set '"10"' as the factor in "Modifying Values" and select "Hum" as the processing
type.

3. 

Move the cursor to a drum track in the Pattern Editor.4. 
Hit the "Apply" button in "Modifying Values".5. 

You can try repeatedly pressing the "Apply" button, or use values other than "10" to
make the effect stronger.
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17.3 Advanced Edit and Pattern Editor Interaction

Content Mask settings in the Advanced Edit panel (as well as the mix-paste option) also
apply to the Pattern Editor's regular Cut, Copy, Paste and Flip commands. So you can
apply the mask settings and use Pattern Editor shortcuts to quickly affect selections.

Note that neither Drag and Drop of selections in the Pattern Editor, nor any operation in
the Pattern Matrix are influenced by the Advanced Edit options.
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18 Instruments
An instrument in Renoise may contain one or any combination of samples, plugins and
MIDI, and each type can be edited by selecting the appropriate tab from the top left of
the Renoise interface. To edit an existing Renoise instrument or create a new one,
select a slot from the list in the Instrument Selector panel. Changes made to an
instrument in the Instrument Editor are applied before the sound reaches the Pattern
Editor.

An instrument in Redux is mostly identical to a sample-based instrument in Renoise,
but with more emphasis on the use of the Phrase Editor to compose musical phrases
and then activate them when specific notes are played.

You may find it useful to watch our "An Introduction To Instruments" video.

18.1 Preset Selector

Found at the top center of the interface, the Preset Selector is used to load, save,
browse, search and filter instrument presets, amongst other things. By default, the
selected preset will be blank and set to initial values. In Redux, when a preset is loaded
in, a short description will be displayed underneath the name.

18.1.1 Preset Browser

Clicking on the name (or description in Redux) will open the Preset Browser, which can
be resized by dragging its lower right corner. Near this corner is a check-box labelled
'Auto-Close', that, when ticked, will enable the automatic closing of the window after
loading a preset. When unticked, the window will remain open while you load in
different presets.
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18.1.1.1 Browsing

The left panel displays the preset folders in a hierarchical tree structure. At the top is
the Bundled Content (also known as factory content). These are the presets that come
pre-installed and are organized in sub-folders of their own. Below the factory content
you may see one or more entries with a similar icon but a different name. These are
Content Libraries, which are packs of extra sounds or presets that you can download
from our community server or elsewhere. If there are no such entries then extra
content packs have not been installed. The last entry (with the 'user' icon) is the User
Library, where any presets you have created, either completely from scratch or by
modifying existing ones, will be stored.

The middle panel is where the preset entries are displayed. Whenever you click a folder
in the left panel, all of its contents (presets and any sub-folders) are displayed in the
middle panel. So in the screenshot above, the top-level folder called Bundled Content is
selected, which causes all of the bundled content presets to be displayed. Selecting one
of the sub-folders will show its contents only.

18.1.1.2 Searching & Filtering

Searching for presets is done by typing text into the search field, found at the top of the
middle panel. The search results are updated in real-time, matching the search term
against the current list of entries. When a search term is entered you are searching not
just for file names, but also for folders in which presets are located. So if the search
term is 'Bass', you might get a match for a preset called 'DigiBass', but you might also
get a match for another preset called 'Acoustic Double', that's located inside a folder
called 'Bass'.

18.1.1.3 Preset Descriptions

Presets can also contain a brief description, often providing useful information about
how it is supposed to be used. This description is shown immediately in the right panel
when a preset is clicked on. A description can be created or changed by clicking the  /

 info icon in the Preset Selector, bringing up an edit box. Any preset can have its
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description edited, even bundled content, but new versions of those presets must be
saved into your User Library.

18.1.2 Loading & Saving Presets

There are three methods of loading in a preset:

Open the Preset Browser and double-click on an entry from the list in the middle
panel.

• 

The arrows next to the preset name allow you to cycle through the available
presets by automatically loading them in.

• 

(Redux only) Clicking the  load icon at the bottom right of Preset Selector will
open a window where you can load from the file system.

• 

To save a preset to the User Library, click the  floppy-disk icon in the Preset Selector.
This opens the file browser, where you can choose the location and name of the preset.
Type a name and hit Save to store it in your User Library.

18.1.3 Organizing Presets

To organize the presets in your User Library, just use the file browser of your OS to
create folders and move files. Right-clicking an entry in the Preset Browser will open a
context menu with the option to 'Reveal In Finder/Explorer'. Selecting this will take you
directly to that file.

Note that folders will only be displayed in the Preset Browser if they contain one or
more recognized files. Empty folders will not be shown.

18.1.4 Creating Libraries

It's possible to create a new non-User Library yourself.

18.2 Instrument Properties

Sample-based instruments can have their volume, scale and key properties changed
via MIDI messages. If the instrument contains Plugin or MIDI components then the
messages will be directed there instead, leaving the samples unaffected.

18.2.1 Renoise
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An instrument's properties affects the audio produced by all three sources (samples,
plugins and MIDI). You will find these options at the top right of the instrument editor.

Key: When a scale is selected, this option chooses the scale's key.• 
Scale: Playing and recording notes is restricted to a chosen scale by forcing
notes that are not part of the scale to play as ones that are (shown by default as
red on the keyboard). Scale & Key are covered in-depth in our video.

• 

Quantize: The time resolution of quantization. Choose from Line, Beat or Bar.
Quantization is covered in-depth in this video.

• 

Mono: When playing/recording notes, this restricts the instrument to using only
a single note at once. Simultaneous notes in the Phrase Editor will still be played.
We have a short video on this subject.

• 

Glide: Only applies when Mono is on. Any value other than 'Off' will glide the
pitch between held notes without re-triggering the instrument's Modulation
envelopes. The higher the value, the quicker the glide. GFF will be instantaneous.

• 

Pitch: The instrument's pitch, in semi-tonal increments.• 
Volume: The instrument's volume.• 

These options are also available in the Instrument Properties section under the
Instrument Selector, giving you easy access to them while using the Pattern Editor or
Mixer.

18.2.2 Redux

An instrument's properties are global controls used to affect the sound and behaviour
of the entire instrument. You will find these options at the top of the Redux interface.

Key: When a scale is selected, this option chooses the scale's key.• 
Scale: Playing and recording notes is restricted to a chosen scale by forcing
notes that are not part of the scale to play as ones that are (shown by default as
red on the keyboard). Scale & Key are covered in-depth in our video.

• 

Quantize: The time resolution of quantization. Choose from Line, Beat or Bar.
Quantization is covered in-depth in this video.

• 

Mono: When playing/recording notes, this restricts the instrument to using only
a single note at once. Simultaneous notes in the Phrase Editor will still be played.
We have a short video on this subject.

• 

Glide: Only applies when Mono is on. Any value other than 'Off' will glide the
pitch between held notes without re-triggering the instrument's Modulation
envelopes. The higher the value, the quicker the glide. GFF will be instantaneous.

• 

Volume: The instrument's volume.• 
Pitch: The instrument's pitch, in semi-tonal increments.• 
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18.3 Detaching The Editor (Renoise Only)

Just above the instrument properties and to the left of the Track Scopes options is the
 Detach button. It opens the instrument editor in a completely separate window,

which can be moved around and resized. There are also additional buttons at the
window's top right corner for minimizing, maximizing and closing. Clicking  Attach will
reattach the window to the main interface.

18.4 Scopes (Renoise Only)

The Track Scopes provide a visual representation of your song, allowing you to examine
the frequency and amplitude of the final audio signal or see what's currently happening
in each individual track. The icons for toggling the Track Scopes can be found near the
top right of the interface:

 - Show the Track Scopes.• 
 - Show the Spectrum.• 

 - Open or close the Scopes/Spectrum panel. Note you can have them
independently open or closed for the main interface and the Instrument Editor.

• 

 - When the main interface's right panel containing the Disk Browser and
Instrument Selector is closed, this icon will appear, allowing you to still view the
Instrument Selector.

• 

18.5 Keyboard

The keyboard will display any keys pressed on the computer keyboard or played by a
MIDI device. You can also use the mouse to click on the keys to play them. If not all
keys are visible, the arrow buttons at the left and right sides will move the keyboard an
octave in that direction. If a key is 'greyed-out' then it will not produce a sound,
because the key has been restricted in the Keyzones section or Keymap mode.

18.5.1 Redux Full Editor Keyboard

In the full Editor, the keyboard changes to show the specific layout of the notes on the
computer keyboard, but otherwise still functions exactly as it does in Compact mode.
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There are also two additional options at the left:

Keyboard Octave: The current octave of both the computer keyboard and
external MIDI keyboard. Moving this value up and down alters the octave of the
notes played and hence their pitch. For more information, see the section on
Playing Notes with the Computer Keyboard.

• 

Computer Keyboard Velocity: When enabled, the computer keyboard will play
and record notes at the velocity set in the value box. When disabled, only notes
will be inserted, leaving the existing velocity value untouched.

• 

18.6 MIDI Controllers

Just to the left of the keyboard are MIDI controllers for mod-wheel, channel pressure
and pitch-bend. The controllers will respond to incoming MIDI messages, but you can
also use the mouse to click and drag on them to change their values. They can also be
mapped as macros, using the  buttons.

18.7 Track Selector (Renoise Only)

Unless the Instrument Editor has been detached, this option will be present at the
bottom left of the interface and allows you to select a track to play sounds on without
having to move back to the Pattern Editor.
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19 Phrase Editor
With the Phrase Editor you can compose musical phrases that will be activated when
specific notes are played. Phrases are created using a scaled-down version of the
Renoise Pattern Editor, consisting of just a single track and pattern. While both Redux
and Renoise use samples to create phrases, Renoise can also make use of the Plugin
and MIDI components of an instrument.

Instruments are recorded by entering notes onto lines in the order that they are to be
played, from top to bottom. This is done with the Tracker Interface, so if you're
unfamiliar with this method of working, you should read through that section of the
manual before continuing here. An instrument can feature up to 120 different phrases,
one for each available key. Phrases are part of an instrument (.xrni) and so are
loaded/saved along with any samples and other instrument data.

Phrases (.xrnz) can be loaded and saved as presets using the drop-down menu located
at the top right corner.

19.1 Creating Phrases

If an instrument does not have an existing phrase then the  button will need
to be pressed.

While the Phrase Editor is open, notes played with the computer keyboard will play the
instrument as if no phrase exists, allowing you to still enter notes as normal without
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triggering the phrase you're working on. However, notes played via a MIDI device or the
on-screen keyboard will trigger the phrase itself. Recording notes and effects is done by
the exact same method used for the Pattern Editor. The phrase length (number of lines)
is changed by altering the value in the box at the top left corner of the phrase. A phrase
can be renamed by double-clicking on its name at the top of the phrase and typing in a
new one.

19.1.1 Pattern Editor Effect Variations (Renoise only)

A few Effect Commands will behave differently when used in the Renoise Pattern Editor
to affect a phrase:

-Bxx - Play phrase backwards (xx = 00) or forwards (xx = 01).• 
-Sxx - Trigger phrase from line xx.• 
-Ixx, -Oxx, -Txy - Will also affect any Plugin or MIDI playing in the phrase.• 

19.1.2 Phrase Editor Options

These options are found at the bottom of the Phrase Editor interface. The drop down
menus can quickly insert notes or commands into the relevant sections, while the
sliders will insert values.

Edit Step: Sets how many lines the cursor should skip down in the Phrase Editor
when entering a note or effect.

• 

##/Vol/Pan/Dly/FX: Toggles the sample, volume, panning, delay and local FX
sub-columns.

• 

19.1.3 Automatically Generating A Phrase

It's possible to automatically generate a phrase using notes and effect commands from
the Pattern Editor. Right-click on the track/column you would like to source from and
choose 'Create Phrase' from the Track/Column sub-menu. Alternatively, select an area
and choose 'Create Phrase' from the Selection sub-menu. Note that this method is
restricted to sourcing from a single instrument in a single track.

19.2 Phrase Controls
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With the controls at the bottom-right of the interface you can select phrases from the
grid and preview them with the play and stop buttons. The +/- buttons can be used to
insert a new phrase or delete the selected phrase. It's also possible to duplicate a
phrase by right-clicking on it and selecting 'Duplicate' from the menu.

The three buttons at the bottom-right are used to either turn phrases off entirely or
select the playback method. Program mode is usually a good choice, as it allows
unrestricted access to the entire range of the MIDI keyboard. For convenient access to
phrases in Program mode, it's recommended to assign the various programs to
separate buttons on your MIDI controller. If your host supports the recording of program
changes, it should be possible to capture a performance where you switch programs
on-the-fly.

The Zxx effect command or an *Instrument Macros device can be used to automatically
change an instrument's phrase as the song is playing.

19.2.1 Phrases in Keymap Mode

In Keymap mode, phrases can be played across a range of keys and are shown
spanning this range above the keyboard. A phrase can be selected by left-clicking on it,
making it the active phrase with a highlighted colour and its properties displayed above
the keyboard. You can shrink/expand the range of an active phrase by click-dragging its
left or right edge, though phrases cannot overlap each other. Click-dragging the phrase
body (not the edges) will move it around.

If you hold down "Left Shift" and left-click on another phrase, both this and the active
phrase are selected, along with any phrases between them. When multiple phrases are
selected, any changes made to the active phrase will also affect the others.

To insert additional phrases just double-click on a blank space in the phrase area above
the keyboard. If there is no blank space, you will need to shrink an existing phrase to
make room (phrase ranges cannot overlap). A phrase can be deleted or duplicated by
right-clicking on it and selecting the appropriate option from the context menu. Phrases
can also be duplicated by holding Ctrl and click-dragging to a blank area of suitable size
(the duplication will fail if the area is too small).

19.2.2 Changing Triggering Mode

For even greater flexibility, you can switch between these behaviours in real-time. The
triggering mode is controlled via MIDI program change events. This illustration shows
how the values are distributed:
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0 turns phrases Off entirely. 1-126 is Program Mode, with the value selecting a specific
phrase. 127 activates Keymap Mode.

19.3 Phrase Properties

These options are found just above the keyboard and can be different for each
individual phrase.

Edit: (Redux only) Toggle Edit Mode. With Edit Mode enabled, all notes played
via the keyboard are recorded into the pattern/phrase.

• 

Beats per Minute: (Redux only) The current tempo of the phrase, also known
as BPM. This value is set by the host DAW.

• 

Lines per Beat: This changes the number of lines in the Phrase Editor that
make up a musical beat. The higher the LPB, the greater the resolution available
to you for editing notes and effects. A phrase's LPB operates independently from
the song's LPB.

• 

Shuffle: Shifts the playback timing of each alternate line back and forth to
create a 'swinging' feel. Higher values have a more intense effect, while 0%
disables it entirely. The playback style is affected by Lines per Beat values above
4, which groups multiple lines together and delays them as a whole instead of
individually. You may find it useful to watch our video, Global Groove & Phrase
Shuffle.

• 

Autoseek: (Renoise only) During song playback, a phrase is normally only heard
once it has been triggered by reaching its position in the pattern. Enabling
Autoseek allows the phrase to be heard at any point during song playback
without the need for triggering. Note that Autoseeking for samples does not
function within a phrase.

• 

Loop: Toggles whether the phrase will loop upon reaching the end.
Start & End Lines: Specifies the start and end lines of the Loop.♦ 

• 

Key Tracking: Sets the behaviour of the phrase across a key range.
None: The phrase is played exactly the same for all keys.♦ 
Transpose: The pitch of the phrase's notes are transposed to the key
played. The playback speed of the phrase is unaffected.

♦ 

• 
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Offset: Different keys will cause the phrase to begin playing from
different lines (lower keys from earlier in the phrase, higher keys from
later).

♦ 

Base Note: The note representing the original pitch of the phrase when "Key
Tracking" is set to "Transpose". Renoise only: This can also be changed by
right-clicking a note on the keyboard, where the current Base Note is shown as a
black circle.

• 
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20 Sampler

Redux Note: Full Editor mode is the Redux equivalent of the Renoise Sampler.

Renoise has a strong focus on samples (a singular focus in Redux, since it only uses
samples) and at the heart of this is a powerful built-in Sampler for creating and
sculpting sounds. An instrument may contain any number of samples and these are
listed in the Sample List section at the left side of the interface.

New sounds can be recorded directly into the Sampler from external sources, or
created by hand with the simple Draw tool. Existing samples can be imported and any
changes made are exclusive to each individual song or instrument. The source samples
are never modified unless you explicitly overwrite the file by saving it in the Disk
Browser. Besides being non-destructive, the Sampler also supports endless
undo/redo-ing of all your actions.

The Sampler is split into five different sections, each devoted to a different aspect of
sample-based instrument construction:

The Phrase Editor is a scaled-down version of the Renoise Pattern Editor where
you can compose musical phrases that will be activated when specific notes are

• 
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played.
Keyzones allow different samples to be triggered over a variety of note and
velocity ranges.

• 

The Waveform editor displays the samples so you can edit them with the
provided tools and see the results graphically. It's also where new samples are
recorded.

• 

Modulation devices form an interactive chain, constructing an envelope to shape
a sample directly.

• 

Adding various Effects to samples greatly expands the possibilities of their sound
beyond the original audio.

• 

Specific preset types for each of these sections are available from a drop-down menu at
the top right corner, where you can load, save, import and export.

20.1 Sample List

Located at the left, this section provides a list of the instrument's samples and is always
accessible, no matter what central section you're working with, allowing you to switch
between different samples whenever you wish. To select a sample, left-click on it in the
list. This will also show the sample's name, waveform and assigned Modulation/FX sets
at the bottom. When a sample is playing, the playback indicator to the left of its name
will light up.

20.1.1 Selecting Multiple Samples

Left-click on a sample to select it. Now if you hold down "Left Shift" and left-click on
another sample, both samples and any between them in the list will become selected.
Holding "Left Ctrl" ("Command" on Mac) and left-clicking on samples will select/deselect
them individually, allowing you to pick any combination from the list. When multiple
samples are selected any changes made to the Sample Properties will affect them all.
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20.1.2 Controls

 - Delete the selected sample from the list.• 
 - Insert a new blank sample into the list.• 
 - When enabled, a sample from the list will be automatically selected when it

is played on the keyboard or by MIDI.
• 

 - Open the Keyzones section. Note that the Keyzone range of each sample in
the list is displayed to the right of it.

• 

 - Preview the selected sample. Renoise only: The preview track is set in the
Waveform editor.

• 

 - Open the selected sample in the Waveform editor.• 

 - Assign a Modulation Set to the selected sample. Pressing
Edit will open the Modulation section.

• 

 - Assign an FX Chain to the selected sample. Pressing Edit will
open the Effects section.

• 

20.1.3 Note On/Off Layers

Samples can be triggered for either Note-On (key press) or Note-Off (key release)
inputs. To move a sample to the Note-Off Keyzone layer, right-click on its name in the
Sample List and select "Move to 'Note-Off Layer'". Use the same method to move
samples back to the Note-On layer. When there are samples using the Note-Off layer,
tabs will appear at the top of the Sample List allowing you to switch between the layers
and view the samples contained within.

20.2 Sample Properties

Directly under the Sample List, the properties of the currently selected sample(s) are
displayed. The  button at the top right toggles the opening and closing of this section.
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Volume: The sample playback volume.• 
Panning: The panning of the sample.• 

Transpose: Transpose the note playback in semi-tonal increments.• 
Finetune: Fine-tuning of the Transpose value.• 

Beatsync: When enabled, the length of sample playback will be automatically
changed so that it lasts for the selected amount of pattern lines, and this will
auto-update to match any changes to the BPM or LPB. This is especially useful for
syncing drumbeat loops. As an alternative, you can leave the checkbox disabled
and instead press the  button, which will set the Transpose and Finetune
values to match the current tempo. Our video tutorial goes into more detail.

• 

Mode: When Beatsync is enabled, you can choose how this affects the sample
playback from the following three methods:

Repitch: The sample is 'locked' at the pitch that matches the song’s
tempo and you will be unable to use it at other pitches. This also disables
the Transpose and Finetune parameters.

♦ 

Time-Stretch (Percussion): The sample can be played at any pitch via
time-stretching, with a priority for preserving fast attacks, making it ideal
for percussion.

♦ 

Time-Stretch (Texture): The sample can be played at any pitch via
time-stretching, with a priority for preserving tonal accuracy, making it
ideal for textures.

♦ 

• 

Trigger: When One-Shot is enabled, Note-Off (key release) messages are
ignored and the sample continues playing. This is incredibly useful for triggering
samples from external hardware that is not traditionally 'held down' e.g. drum
pads.

• 

Loop Finish: Toggles whether a sample will instantly stop or finish its current
loop after a Note-Off input.

• 

Loop Type: When looping is enabled by selecting a loop type from the menu,
start and end points are inserted into the Waveform, causing playback to loop
between them. The loop points can be moved by click-dragging their tabs at the
top/bottom of the waveform.

Off: No loop.♦ 
Forward: Loop playback from start to end.♦ 
Reverse: Loop playback from end to start once the end point is reached.♦ 
PingPong: Loop playback from start to end to start to end etc.♦ 

• 

Mute Group: Samples which are assigned to the same Mute Group will "Cut"
each other off in the same track. A sample's Mute Group number is also
displayed to the left of its name in the Sample List. Useful for drum kits built
within a single instrument, since different samples of the same drum can
realistically interrupt each other without interfering with the others. Our video
tutorial goes into more detail.

• 

NNA: New Note Action. When a note is in the process of playing and a new note
is played in the same column, NNA dictates how the previous note will behave.
By default, samples will be set to "Note-Off", which stops the note and triggers
any Note-Off actions. "Cut" will also stop the note's playback, but doesn't trigger
Note-Off actions, instantly silencing it. To achieve polyphony you normally just
use multiple note-columns, but by setting the NNA to "Continue", you can create
the sustained playback of multiple notes using a single column. You may find it

• 

Renoise 3.4 User Manual

20.2 Sample Properties 86

https://youtu.be/-GtrYbPm-0U
https://youtu.be/q2IuyBehL7E
https://youtu.be/q2IuyBehL7E


useful to watch our video covering both Note-Off and NNA.

Playback
Autofade: Automatically inserts a quick fade at the beginning and end of
a sample. Useful for preventing unwanted audio clicks.

♦ 

Autoseek: During song playback, a sample is normally only heard once it
has been triggered by reaching its position in the pattern. Enabling
Autoseek allows the sample to be heard at any point during song playback
without the need for triggering. Highly recommended for vocals,
background ambience and other lengthy recorded audio.

♦ 

• 

Interpolation
Anti-aliasing: When enabled, interpolation is oversampled and
band-limited. This helps to reduce aliasing noise, especially when using
wavetable-like waveforms that are not multi-sampled. This increases CPU
usage.

♦ 

Quality: The quality of re-sampling used when samples are played at
pitches other than the original. "Cubic" is an excellent default
interpolation, offering the best ratio of sound quality and CPU usage.
"Sinc" is more precise but requires more CPU power, while "Linear" is the
opposite and sounds rougher when played at lower pitches. Set to "None",
samples will sound a bit more metallic and rough, which can be good if
that's the kind of sound you're after and is also useful when creating
wave-table generators with very short sample loops.

♦ 

• 

20.3 Macros

Macros allow for powerful handling and automation of an instrument's Modulation and
Effects parameters. In Renoise this is controlled with the *Instr. Macros track effect,
while Redux uses the options available within its host DAW.

You may find it useful to watch our video on this subject.
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Pressing the  button at the top left of the interface will open a panel with eight
macros, each of which can be assigned to multiple parameters. To map a macro, press
the  button next to it. This opens the mappings list and highlights any mappable
parameters (shown here as green, but the highlighted colour may vary according to the
current interface Theme). Clicking on a parameter will add it to the list and allow you to
specify its Min/Max values and Scaling. Now altering the value of a macro will change
the values of all assigned parameters.

Clicking the X at the right of a mapping will delete it. Closing the mappings list removes
the parameter highlighting and returns the interface to normal again. To rename a
macro, just click on its name and type one in, finishing with Enter.

Found just to the left of the on-screen keyboard and representing pitch-bend, a
mod-wheel and channel pressure, the MIDI controllers can also be mapped as macros.

Renoise only: Macros are also available in the Instrument Properties section under the
Instrument Selector, giving you easy access to them while using the Pattern Editor or
Mixer.
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21 Keyzones
Each sample has a Keyzone that defines its playback range along Note and Velocity
axes. This range initially covers the entire Keyzone grid, so the sample can always be
played. By reducing the range, a sample can be restricted to only play on certain notes
at certain velocities. Keyzones can be created for both Note-On (key press) and
Note-Off (key release) inputs via separate layers.

Multi-sample files (.sfz) can be loaded and saved as presets using the drop-down menu
located at the top right corner.

The interface consists of a large central grid that displays the Keyzones, with various
options above and below. The grid's note range of C-0 to B-9 is represented
horizontally, while the velocity range of 00 to 80 is shown vertically. When a key is
pressed, either with the computer keyboard or via a MIDI controller, its note and
velocity values are translated into a coordinate on the Keyzone grid. If this co-ordinate
is within a Keyzone's range then it will be activated and its sample is usually played
(the Overlap mode can change this). If the coordinate falls in empty space then nothing
happens.

Placing the mouse pointer over the grid and scrolling the mouse wheel will zoom in/out,
giving you access to more/less detail horizontally. The scrollbar underneath can be
used to move around while zoomed in.
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21.1 Creating Keyzones

21.1.1 Selecting & Adjusting the Zones

A zone can be selected by left-clicking on it or by selecting a sample from the Sample
List. This becomes the active zone with a highlighted colour and small squares on all
four sides. The active zone's range is displayed in the Note and Velocity value boxes
underneath the grid. You can resize the range of an active zone by click-dragging one
of its edges. Click-dragging inside the zone will move it around.

If you hold down "Left Shift" and left-click on another zone, both this and the active
zone are selected, along with any zones between them on the grid. You can also
left-click (anywhere except the active zone) and drag to select a range of zones.
Holding "Left Ctrl" ("Command" on Mac) and left-clicking on zones will select/deselect
them, allowing you to pick any combination from the grid. When multiple zones are
selected, any changes made to the active zone will also affect the others.

Double clicking a zone will open the sample in the Waveform editor.• 
It is possible to have overlapping zones so that multiple samples are triggered
with a single note.

• 

If the auto-select option  in the Sample List is enabled, zones will be
automatically selected by notes that are played within their range.

• 

21.1.2 Inserting & Deleting Zones

To create a new Keyzone you can either insert a new sample via the Sample List or
right-click on the grid to open the context menu and choose "Insert New -> Load
Sample(s)". Alternatively, select one or more samples from the Disk Browser, drag
them onto the Keyzone grid and place them where you want (the horizontal size can be
adjusted by moving the mouse pointer up and down before letting go of the mouse
button).

A zone can be deleted by selecting it and pressing "Delete" or using the right-click
menu and selecting "Remove".

21.1.3 Note On/Off Layers

At the top left of the interface are two buttons that switch between creating Keyzones
for Note-On (key press) and Note-Off (key release) inputs. To move a sample's Keyzone
to the Note-Off layer, right-click on the zone or its name in the Sample List and select
"Move to 'Note-Off Layer'". Use the same method to move zones back to the Note-On
layer.
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21.1.4 Automatically Distributing Zones

You will find the distribution options at the top right corner of the Keyzones interface.

Drumkit: This will assign each zone to a single note, starting from the note
selected in the value box. Clicking  will open a drop down menu with two
additional options. "Use White Keys Only" will only assign zones to the white
keys, while "First Octave for Transposing" will assign an entire octave to the first
sample of the instrument.

• 

Distribute: This evenly distributes all zones across the entire note range.• 
Layer: Every zone will span the full note and velocity range. This causes all of an
instrument's samples to be simultaneously triggered by any note played.

• 

21.1.5 Keyzone Options

These options are located underneath the main central grid.

Base Note: The note representing the original pitch of the selected zone's
sample. This can also be changed by right-clicking on the note axis along the
top/bottom of the grid (the current Base note is shown there as a coloured
block). A Base note is automatically assigned to a newly created zone. Moving a
zone around the grid will not change its Base note.

• 

Note: The note range of the active zone.• 
KEY->Pitch: When disabled, the sample will always play at the pitch of the Base
note.

• 

Velocity: The velocity range of the active zone.• 
VEL->VOL: When disabled, the sample will always play at full volume. This can
be useful for lower velocities when samples have already been recorded at a
lower volume.

• 

Overlap: This dictates how samples will be played when their zones overlap. The
default option, "Play All" will play all samples simultaneously. "Cycle" will play
each sample in the sequence one at a time. "Random" will randomly play a
sample in a round robin sequence (all samples will be played at least once in the
randomised sequence).

• 

21.2 Using Keyzones with a Sliced Sample

With a sliced sample your options are far more limited: the Note-Off layer is
unavailable, zones cannot be adjusted by velocity and (aside from the initial sample)
can only be a single note in width. However, the "KEY->Pitch", "VEL->VOL" and
"Drumkit" options are still available.
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22 Waveform
The Waveform editor displays an instrument's samples so you can edit them with the
provided tools and see the results graphically. New sounds can be recorded directly
into the Sampler from external sources, or created by hand with the simple Draw tool.
Existing samples can be imported and any changes made are exclusive to each
individual song or instrument. The source samples are never modified unless you
explicitly overwrite the file by saving it in the Disk Browser. Besides being
non-destructive, the Sampler also supports endless undo/redo-ing of all your actions.

Samples (.flac) can be loaded and saved as presets using the drop-down menu located
at the top right corner.

The large central section displays the waveform and allows you to select parts of the
sound for editing. Loop points and Slice markers are also placed and displayed here.
The top section features the sample-type options, Draw, Slice and Snap controls. The
lower section contains the options used to edit or modify the sample, with additional
options available via the right-click context menu.

22.1 Working With The Waveform

22.1.1 Upper and Lower Rulers

Directly above and below the waveform are rulers which display various time
measures. You can set the measures individually by right-clicking on a ruler and
selecting an option from the menu:
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0S Effect: The waveform is automatically split into 256 equal parts. Sample
playback can be triggered from the position of one of these parts using the 0S
Effect Command (this behaves differently if the sample has been sliced).

• 

Beats: Measures how many beats the waveform lasts for. This will change
depending on the song's current BPM.

• 

Samples: These are the individual data points that the waveform is constructed
from. At a sample rate of 44.1KHz, there are 44,100 samples in a single second.

• 

Minutes: This will show the time in minutes, seconds and fractions of a second.• 

22.1.2 Mouse Navigation and Selection

Left Mouse Button:
Single-click sets a cursor (edit/play) position.♦ 
Click and drag spans an area in the editor. In a stereo sample, moving the
mouse pointer above/below the top/bottom 0dB line will allow you to
select the left or right channel only.

♦ 

Click and drag with "Left Shift" extends/shrinks either side of the selection
area.

♦ 

Double-click selects the entire visible area of the waveform.♦ 
Click, drag and move the cursor past the left/right side of the waveform
editor to select while zooming out. Holding down "Left Ctrl" ("Command"
on Mac) while doing so will speed up the zooming.

♦ 

• 

Right Mouse Button:
Single-click opens the context menu.♦ 
Click and drag extends/shrinks either side of the selection area (same as
left-click and drag with "Left Shift").

♦ 

Click, drag and move the cursor past the left/right side of the wave editor
to select while zooming out. Holding down "Left Ctrl" ("Command" on Mac)
while doing so will speed up the zooming.

♦ 

• 

Middle Mouse Button:
Single-click plays the sample from the clicked position to the end of the
visible waveform. In a stereo sample, moving the mouse pointer
above/below the top/bottom 0dB line will play the left or right channel
only.

♦ 

Click and drag selects an area then immediately plays that selection.♦ 

• 

Scroll Wheel:
Zoom in/out of the waveform. Note that the zooming happens from the
position of the mouse pointer.

♦ 

Hold "Left Alt" while scrolling to scroll horizontally instead of zooming.♦ 

• 
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22.1.3 Keyboard Shortcuts

Arrow Left/Right: Move cursor position to the left/right. In combination with
"Left Shift", a selection is created.

• 

Arrow Down/Up: Move cursor position up/down (in a stereo sample).• 
Ctrl/Command + Arrow Down/Up: Zoom in/out at the cursor position.• 
PageDown/PageUp: Zoom in/out vertically.• 
Home/End Key: Move cursor to the start/end of the waveform. In combination
with "Left Shift", a selection is created.

• 

Enter: Play/restart the sample from cursor position.• 

Standard operations such as Copy/Paste ("Left Ctrl + C/V") etc. are available as well.

22.1.4 Lower Scroll/Zoom Bar

As an alternative to using the mouse or keyboard shortcuts to navigate around in the
waveform, you can use the scrollbar beneath the Lower Ruler to scroll or zoom. Drag
the bar to scroll or drag the side handles to zoom. Clicking on a free space next to the
scrollbar will jump to the immediate left or right of the waveform's current location. Just
to the right of the scollbar are extra zooming controls:

 - View full sample (zoom back out to show the whole sample, horizontally and
vertically).

• 

 - Zoom in one step vertically.• 
 - Zoom out one step vertically.• 

22.2 Upper Control Bar

22.2.1 Recording

 - Found at the top left of the Waveform panel. Opens up the recording
window to record new samples from various sources (e.g. microphone, line-in
etc.) For further details, see the Recording New Samples section.

• 

22.2.2 Drawing

 - The Draw button is located at the top center of the Waveform panel.
Draw mode allows you to draw on the central waveform area with the mouse,
where you can create brand new sounds or make adjustments to existing
sounds, such as removing clicks.

• 

22.2.3 Create/Adjust Sample Properties

Changes the basic properties of an existing sample or, in a blank sample slot, creates a
new sample. This is located at the top center of the Waveform panel.

 /  - Edit sample properties / Create new sample.• 
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22.2.4 Slice Markers

By placing markers onto a sample it can be sliced up. Those slices can then be used as
if they were individual samples themselves. This process is non-destructive because the
original sample is left untouched. The slicing controls are located at the top right of the
interface.

 - Activating the Slice Marker Tool allows you to left-click on the waveform
to place the markers at useful points - individual drum hits, notes, vocal phrases
etc.

• 

 - Automatically insert markers into the waveform at points where significant
changes within the waveform are detected (beats/transients).

• 

 - The sensitivity of the auto-slicing beat detection can be adjusted using
this value box. Higher values will lead to more markers being inserted.

• 

 - If enabled, a triggered slice will stop playing at start of the next slice. Can
only be changed while the original sample is selected.

• 

As markers are placed onto a sample, the Keyzones editor will automatically assign the
new slices to different notes according to its current Drum Kit settings, allowing you to
trigger each slice from a different key on the keyboard. You can also trigger a slice via
the -Sxx Effect Command, where the xx value corresponds to a slice number. Each slice
you place is given a numbered tab at the top and left-click-dragging on it will move the
slice around.

Right-clicking on a tab will bring up a menu with the option to: select all markers,
delete the current marker or delete all markers. There’s also the powerful “Render
Slices To Phrase” feature and its various options, which will reconstruct the original
sample as a phrase using some or all of the slices.

Although you can still edit the original sample, you cannot edit the individual sample
slices. However, the Loop type and all Sample Properties like volume, panning etc. can
be changed per slice. A newly created slice will inherit the original sample's properties.
To destructively render an instrument's slices into individual samples, right-click on the
waveform and select "Slices > Destructively Render Slices" from the menu.

You may find it useful to watch our "Sample Slicing" video.

22.2.5 Snapping

The Snap controls are located at the top right of the interface.
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Snapping applies to the waveform when selecting with the mouse, using keyboard
shortcuts to navigate, and when applying or dragging loop points and slice markers. It
can be useful to have "0 Crossing" enabled, as this will ensure that cutting and pasting
parts of a sample does not produce clicks in the audio, because the start and end
points will always match up at 0dB.

Selecting "0S Effect" will snap to the 0S markers typically shown along the bottom of
the waveform, while selecting "Markers" will cause the selection to "stick" to sample
slice markers as the mouse pointer approaches them.

Snapping to beats (the length of time for a single beat) is useful when cutting out beats
from loops, in combination with the "Copy Into New Instrument" context
menu/keyboard shortcut. The other Snap options are smaller fractions of a beat.

22.3 Processing Controls and Options

Located underneath the waveform, most of the processing options below will apply to
the whole sample unless a specific area has been selected.

22.3.1 Undo/Redo Support

 - Enable/disable undo in the Waveform editor. When working with very
large samples, temporarily disabling undo may be useful to save time. All
undo/redo processing is saved to disk, so running out of memory should not be a
problem.

• 

22.3.2 Cut/Copy/Paste

 - Cut the selection (or whole sample if nothing is selected).• 
 - Trim to selection (delete everything outside of the selection).• 

22.3.3 Amplitude

 - Change the volume of the sample or selection (will open up a window to
specify the exact amount).

• 

 - Raise the volume of the sample or selection to the maximum possible value
without clipping.

• 

 - Insert silence into the selected range, or silence the whole sample if no
range is selected.

• 

22.3.4 Fading

 - Fade the sample in linearly (can fade logarithmically via the right-click
context menu or shortcuts).

• 

 - Fade the sample out linearly (can fade logarithmically via the right-click
context menu or shortcuts).

• 
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22.3.5 Reverse & Swap

 - Reverse the sample or selection.• 
 - Center the sample or selection to the DC line, correcting any unwanted DC

offsets. You may find it useful to watch our video on the subject.
• 

 - Invert the phase of the sample or selection.• 
 - Swap the left and right channels of the sample or selection. Only possible for

stereo samples.
• 

22.3.6 Process Track FX

 - (Redux only) Apply the selected sample fx chain directly to the sample's
waveform. Note that this will not automatically extend the length of the sample
for reverbs, delays etc. that last longer than the original sample.

• 

 /  - (Renoise only) Apply the selected track/sample fx chain directly to the
sample's waveform (applies both native and plugin effects). Note that this will
not automatically extend the length of the sample for reverbs, delays etc. that
last longer than the original sample.

• 

 - (Renoise only) Select between track and sample fx chains for the previous
option.

• 

 - Smooth the sample. A simple interpolation process which removes hiss and
sharp edges from the waveform. Useful to smooth out hand-drawn samples.

• 

22.3.7 Loop Controls

 - Automatically create a smooth cross-faded loop.• 
 - Toggles whether a sample will instantly stop or finish its current loop after a

Note-Off input.
• 

 - When looping is enabled by selecting a loop type from the menu,
start and end points are inserted into the waveform, causing playback to loop
between them. The loop points can be moved by click-dragging their tabs at the
top/bottom of the waveform.

Off: No loop.♦ 
Forward: Loop playback from start to end.♦ 
Reverse: Loop playback from end to start once the end point is reached.♦ 
PingPong: Loop playback from start to end to start to end etc.♦ 

• 

22.3.8 Other Controls & Info

 – When enabled, the computer keyboard and MIDI note input will play the
sample from the cursor position to the end of the visible waveform, or play the
selection if one is present. This bypasses any Phrases, Keyzones, Modulation and
Effects, but is unaffected by the track-select option to the right.

• 

 - Start/Stop playing sample from the cursor position to the end of the visible
waveform, or Start/Stop playing the selection if one is present.

• 

 - (Renoise only) Select where the sample will be played back: On the Master
Track to bypass the current track's effects, or on the selected track to hear the
sample with the currently active effects.

• 

 - The current cursor position or selection range positions are shown in
the format of the Lower Ruler. To change the format, right-click on the Lower

• 
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Ruler and choose from the list.

22.3.9 Right-Click Context Menu

Right-click on the waveform to open this menu. There are extra processing options
beyond the ones detailed above:

Mix Paste: To use this, "Copy" a sample or a selection of a sample into the
clipboard. When you select "Mix Paste" from the menu, a window will appear that
offers options for mixing the clipboard content with the existing content.

• 

Copy Into New Sample/Instrument: Automatically copies a selection of a
sample and places it in either the current instrument or a new instrument. This
can be very useful when copying parts of a large sample for further playback and
editing.

• 

Process
Fade In/Out Logarithmically: Fades the selection area in/out
logarithmically instead of with the standard linear process.

♦ 

Set Loop Start/End: Inserts a loop start/end point directly onto the
cursor position. If a selection area is present then both the start and end
points will be placed to loop that exact range.

♦ 

• 

22.3.10 Copy/Paste With External Sample Editors (Windows only)

On Windows, the clipboard content is shared with the entire system, meaning you can
quickly swap sample data to and from Renoise/Redux when using an external sample
editor that supports this feature. In many external editors you have to select/activate
this feature first. To find out how to do this, please look at the external editor's manual
and search for the keywords: "System Clipboard", "Copy".

22.4 Recording New Samples

You can create new samples by recording them from various sources, including a line-in
jack or microphone. To do so, press the  button found at the top left of the
Waveform panel. Or in Renoise, choose, "File->Record New Sample..." from the main
menu at the very top left of the interface.

To begin recording new samples, first configure the device you want to use for
recording. For Redux, this is set up inside the host DAW, so refer to its specific
documentation. In Renoise, this is done via the "Edit->Preferences->Audio" panel, but
is only necessary when using DirectSound (Windows), Core Audio (MacOS) or ALSA
(Linux); ASIO is pre-configured to be used as a recording and playback source. When
your soundcard has more than one input channel you'll be able to choose from them in
the Audio Preferences or the recording window.

Renoise only: Opening the recording window and controlling the main record options
can be mapped to a MIDI Controller with the MIDI Mapping options. This way you can
quickly make new recordings using just your MIDI controller or master keyboard.
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22.4.1 Recording Controls

• 

This VU meter displays incoming audio activity, allowing you to monitor the signal and
make adjustments if necessary. The  button lets you listen to the input through
Renoise/Redux while recording.

• 

Select which channel you would like to record: left, right or both (stereo).

Everything below this point applies to Renoise only.

• 

Select the input device that will be the source for the recording. This may not be
present depending on your selected Audio Device.

• 

Select the track effect chain that will be used with the recording. The "Record dry
(monitor FX)" option allows you to either directly apply this onto the recording or just
hear it with the recording preview.

Sync start & stop:
None - No quantization is applied. Hitting the start/stop button will
start/stop recording immediately.

♦ 

Pattern - Applies quantization from the start to the end of the current
pattern. When the song or pattern plays, recording will be started or
stopped only at pattern boundaries or block loops. This is useful to record
"live" (e.g. playing a guitar riff along to your Renoise song). The resulting

♦ 

• 
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samples can then be placed into the patterns and will always match your
song.

Record dry (monitor FX): When enabled, the input signals are recorded
without the Track FX applied, but will be previewed with them. This way you can
hear and record exactly what will be played later when adding the recorded
sample to the selected track.

• 

Create a new instrument on each take: When enabled, each recording is
placed into a new instrument slot in the Instrument Selector, so you can simply
hit start/stop again and again to create multiple takes without overwriting
anything.

• 

Compensate input and output latencies: When enabled, the latency of your
soundcard will automatically be compensated for when creating synced
recordings.

• 

Extra latency (ms): Soundcards or other devices can introduce latencies that
Renoise may not be aware of. When your recordings are slightly out of sync on
playback, you can manually compensate the latency offset of future recordings
here.

• 

Start: Start or stop the recording (changes into "Stop" when recording has
started).

• 

Done: Closes the recorder window when no recording is taking place. While
recording, this will "Cancel" the current recording.

• 

22.4.2 Recording Without Quantization

Once everything is set up, hit "Start" to begin recording. A red border will appear
around the recording window to indicate that recording is active. To stop recording and
load the sample into the instrument slot, simply hit the "Stop" button. Currently active
recordings can be discarded by pressing "Cancel".

22.4.3 Recording With Quantization

When using the quantization (Sync start & stop) option, Renoise will make sure that
recordings are started and stopped at pattern boundaries only. To use the sync you
have to start playing the song first. A progress bar will display playback information.
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23 Modulation
Adding modulation to samples greatly expands the possibilities of their sound beyond
the original audio. The modulation is created by inserting devices into an interactive
chain, constructing an envelope. Separate envelopes are used to modulate the three
basic domains of a sample - Volume, Panning and Pitch - and an optional filter with its
own domains. These various envelopes are collected together as a Modulation Set,
which can be used to affect any number of samples simultaneously. Modulated samples
are processed polyphonically (each instance of a sound is generated independently).

Modulation Sets (.xrno) can be loaded and saved as presets using the drop-down menu
located at the top right corner.

The interface is split into three sections. At the upper-left is the Set list, the large
section to the right of this shows a graphical representation of the selected domain's
envelope, and the lower section contains the domain selector and device chain.

23.1 The Set List

A Set is a collection of modulation envelopes that affect various sample domains. Any
number of Sets can be created and each instrument has its own unique Set list. The
individual samples of an instrument can be assigned any one of its Sets, allowing
different samples to be affected by modulation in different ways. A Set can also be
assigned to multiple samples simultaneously, so any changes made to a Set will affect
all linked samples.
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The Set assigned to the current sample is marked with a circle at the list's left. Clicking
on an empty circle slot will assign that Set to the sample. Clicking anywhere else on a
Set will select it for editing. Double-clicking on a Set's name allows you to rename it.

Modulation Sets can be added or removed using the buttons at the bottom left:

 - Delete the currently selected Set.• 
 - Insert a new blank Set below the currently selected Set.• 

Right-clicking on a Set will select it and open a context menu with additional options:

Cut All Devices: Cut all of the Set's devices.• 
Copy All Devices: Copy all of the Set's devices.• 
Paste All Devices: Paste all of a previously copied Set's devices (overwrites the
selected Set).

• 

Delete All Devices: Delete all of the Set's devices.• 

Insert New Set: Insert a new blank Set below the selected Set.• 
Delete Set: Delete the Set.• 
Duplicate Set: Create an identical copy of the Set.• 

Load: Load in a Set (will overwrite the selected Set).• 
Save As: Save the currently selected Set.• 

23.2 Creating Modulation Sets

The bottom section of the Modulation interface is dedicated to the creation of
envelopes for the three basic domains of a sample: Volume, Panning, Pitch, as well as
other optional filter domains (they will be unavailable until a filter is chosen from the
drop-down menu). Each domain has its own Input slider, which is used to adjust the
starting value of the envelope.

The envelope is constructed by inserting modulation devices, creating an interactive
chain. To add a device from the list, either double-click on it or drag and drop it into the
chain at the desired position. Positioned before each device are four buttons which
change how the envelope will be altered by the output value of that device: Add,
Subtract, Multiply and Divide. The envelope graphic in the top right panel will show the
real-time results of changes made to the device chain.
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Note: The Pitch domain has an extra control at the top-left of the envelope panel,
where you can control the Pitch Range that the modulation will take place within (1-96
semitones).

23.3 Modulation Devices

Note that the name of a device will change to reflect the domain it is modulating, e.g.
Volume LFO, Panning LFO, etc.

23.3.1 Common Device Layout and Controls

Each modulation device has a standard set of buttons to perform common functions:

 - Remove the device from the chain.• 
 - Minimize/maximize the device.• 

 - Move the device to the left or right. Right-click to move to the start or end
of the chain.

• 

 - Enable/disable the device.• 

 - Toggle synchronizing the device to milliseconds or beats. Not present on all
devices.

• 

 - Toggle values to bipolar (positive and negative) or unipolar (only positive).• 

23.3.2 Right-click Context Menu

Right-clicking on a device will select it and open a context menu with additional
options:

Cut: Cut the device.• 
Copy: Copy the device.• 
Paste: Paste the previously copied device after the selected device.• 

Delete: Delete the device.• 
Rename: Rename the device.• 

Bypass/Activate: Enable/disable the device.• 

Copy Settings: Copy the parameter settings from the device.• 
Paste Settings: Paste the previously copied settings into the selected device.
Note that settings cannot be pasted between different types of devices.

• 

Init Settings: Reset the device settings to their default values.• 

Modulation Set: The options function exactly as they do in the Set List, with the
addition of:

Append: Paste a previously copied Set's device chains onto the end of the
existing chains.

♦ 

• 

Min/Maximize All: Min/maximizes all devices in the Set.• 
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23.3.3 AHDSR

The AHDSR device is an envelope whose five properties alter its shape over time. By
default, interpolation between different values of the phases happens in a straight line,
but Attack, Decay and Release have an additional parameter to create curves and
control their easing. You may find it useful to watch our video on this subject.

Attack: How quickly the value rises up from zero.• 
Hold: The value is held for this length of time before falling.• 
Decay: How long it takes for the value to decrease to the percentage level set
by Sustain.

• 

Sustain: The value will be sustained at this level until a Note-Off (key release)
event.

• 

Release: How long it takes for the value to fall to zero.• 

23.3.4 Envelope

This device is a heavily customisable envelope with additional Sustain and Release
properties.

The main graphical section of this device displays the envelope and the points used to
create it. Left-clicking on a point will select it and click-dragging will move it around.
Using "Left Ctrl" will display the current value of a point and also lock it in place
horizontally, allowing you to fine-tune its value vertically. Double-clicking in the
envelope will create a new point, while double-clicking on an existing point will remove
it. For more advanced editing options, see the Using The External Editor section.

The following options are directly under the envelope graphic, from left to right:

Time: The selected point's location in time.• 
Value: The value of the selected point. Left-click to enter a new value.• 
Envelope Type: Dictates how the envelope's value will change over time.

Points: Only changes value when a point is encountered.♦ 
Lines: Initially interpolates in a straight line, but the handles between
points can be used to create curves and control their easing.

♦ 

• 
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Curves: Interpolates with a smooth cubic curve, easing into and out of
points.

♦ 

Length: Length of the envelope.• 

These are the options found on the right side of the device:

Ext. Editor: This will open the envelope graphic in the large central section of
the Modulation interface, allowing for finer control over details and access to
additional tools. For more details, see the Using The External Editor section.

• 

Loop: When looping is enabled by selecting a loop type from the menu, start
and end points are inserted into the envelope, causing playback to loop between
them. The loop points can be moved by click-dragging their tabs at the
top/bottom of the envelope.

Off: No loop.♦ 
Forward: Loop playback from start to end.♦ 
Reverse: Loop playback from end to start once the end point is reached.♦ 
PingPong: Loop playback from start to end to start to end etc.♦ 

• 

Sustain: When enabled, a Sustain line will appear in the envelope and can be
moved by dragging the top tab. When playback reaches the Sustain line, it will
be held there until a Note-Off (key release) event.

• 

Release: Changes how long it takes for the volume to fall to silence after a
Note-Off (key release) event. Higher values equal less time. Only available for
the Volume envelope.

• 

Presets: Store and recall your favourite envelope settings. Right-clicking will
save a preset, while left-clicking will restore a previously saved preset. Presets
are stored by Renoise/Redux and will show up every time you use the Envelope
device in future.

• 

23.3.5 Fader

A configurable fader used to create a variety of fade in/outs.

Scaling: The scaling that will be applied to the fade. The default is linear, but
you can also select from two exponential and two logarithmic scales.

• 

From: The starting value.• 
To: The ending value.• 
Duration: The length of time the fade will last.• 
Delay: The start of the fade will be delayed by this amount of time.• 

23.3.6 Key Tracking

This device alters its output value by responding to the key values of notes. The full
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output value range of 0 to 1 is scaled to fit within the min/max range.

Min: Minimum key value.• 
Min: Maximum key value.• 

23.3.7 LFO

The Low Frequency Oscillator generates a signal that cycles through a relatively slow
pattern. The signal is constructed by applying the various parameters to a repeating
waveform, which can be chosen from four simple shapes.

Mode:
 - Sine wave♦ 
 - Sawtooth♦ 
 - Pulse/Square♦ 
 - Random♦ 

• 

Frequency: The speed of the oscillation.• 
Amplitude: The maximum range that the value will oscillate to.• 
Dephase: Changes which part of the oscillation cycle that the output will start
at.

• 

Delay: The amount of time at the start of the modulation that the LFO cycle will
be delayed by.

• 

23.3.8 Operand

A simple value output device. The "Input" slider at the beginning of the chain is also an
Operand device.
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Value: The value which will be output.• 

23.3.9 Stepper

This device features an envelope that can be customised by placing points onto
individual 'steps'. Every time a note is played the cursor moves within the envelope,
changing the output value. You may find it useful to watch our video on this subject.

The cursor can either move forward by a set number of steps or select a step at
random. When moving forwards, the stepping 'wraps around' once the end of the
envelope is reached. If the Length and the Step values are not divisible as whole
numbers then the wrap-around will begin at a step other than 0, and the sequence will
be different each time.

The main graphical section of this device displays the envelope and the points used to
create it. Left-clicking on a point will select it and click-dragging will move it around.
Holding down 'Left Ctrl' will display the current value of a point and also lock it in place
horizontally, allowing you to fine-tune its value vertically. Double-clicking on an empty
step will create a new point, while double-clicking on an existing point will remove it.
For more advanced editing options, see the Using The External Editor section.

The following options are directly under the envelope graphic:

Envelope Type: Dictates how the envelope's value will change over time.
Points: Only changes value when a point is encountered.♦ 
Lines: Initially interpolates in a straight line, but the handles between
points can be used to create curves and control their easing.

♦ 

Curves: Interpolates with a smooth cubic curve, easing into and out of
points.

♦ 

• 

Length: Number of steps that make up the envelope (1 - 256).• 

These are the options found on the right side of the device:

Ext. Editor: This will open the envelope graphic in the large central section of
the Modulation interface, allowing for finer control over details and access to

• 
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additional tools. For more details, see the Using The External Editor section.
Step: The number of steps forward that the cursor takes every time a note
played (0 - 16). Reducing the value below 0 enters Random mode, where new
notes will select a step at random.

• 

Reset: Returns the cursor to step zero (the start of the envelope). Automating
this with a macro allows the cursor to be moved to a specific step.

• 

23.3.10 Velocity Tracking

This device alters its output value by responding to the velocity values of notes.

Mode
Clamp: Note values played outside of the min/max range will be clamped
at the min/max values.

♦ 

Scale: The entire velocity range is scaled to fit within this device's
min/max range.

♦ 

• 

Min: The minimum output value.• 
Max: The maximum output value.• 

23.4 Using The External Editor

Pressing the "Ext. Editor" button will open the envelope graphic in the large central
section of the Modulation interface, allowing for finer control over details and access to
additional tools. Using the mouse-wheel on the envelope will zoom in/out. Clicking
either the top right "X" or "Ext. Editor" button will remove the larger editor.

Left-clicking on a point will select it and click-dragging will move it around. Holding "Left
Shift" while moving a point will remove all other points that it touches. Using "Left Ctrl"
will display the current value of a point and also lock it in place horizontally, allowing
you to fine-tune its value vertically. Double-clicking in the envelope will create a new
point, while double-clicking on an existing point will remove it. Left-click-dragging
across the envelope will create a highlighted area and select any points contained
within, allowing them to be adjusted all at once.

23.4.1 Processing Controls And Options

Draw: Draw mode allows you to draw points on the envelope with the mouse.• 
Time: The selected point's location in time.• 
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Snap to Grid: Will snap the horizontal creation and movement of points to the
current resolution of the grid.

• 

Scaling: (Only available in Lines mode) Controls the easing of the curve
between the selected point and next one.

• 

Value: The value of the selected point. Left-click to enter a new value.• 
Snap to Value: Will vertically snap points to values of 1/divisor (the divisor is
set in the value box).

• 

Envelope Type: Dictates how the envelope's value will change over time.
Points: Only changes value when a point is encountered.♦ 
Lines: Initially interpolates in a straight line, but the handles between
points can be used to create curves and control their easing.

♦ 

Curves: Interpolates with a smooth cubic curve, easing into and out of
points.

♦ 

• 

Length: Length of the envelope.• 

 - Cut the whole envelope.• 
 - Copy the whole envelope.• 
 - Paste the whole envelope.• 

 - Move the envelope or selected points to the left/right. Will wrap around the
edges.

• 

 - Flip the envelope or selected points horizontally/vertically.• 
 - Humanizes the envelope or selected area by randomly adding or subtracting

a small amount to the point values.
• 

 - Opens the envelope editor in a completely separate window, which can be
moved around and resized. There is also an additional maximize button at the
window's top right corner. Clicking  "Attach" will reattach the window to the
main interface.

• 

23.4.2 Right-click Context Menu

Cut: Cut the points contained within the selection area.• 
Copy: Copy the points contained within the selection area.• 
Paste: Paste the previously copied points into the envelope from the cursor
position (left-clicking in the envelope will set the cursor position for pasting
operations).

• 

Paste Continuously: Paste the previously copied points into the envelope from
the cursor position and repeat until the end of the envelope.

• 

Insert Paste: Paste the previously copied points into the envelope from the
cursor position and move the rest of the envelope to the right. Note that this will
not affect the length of the envelope and so any points shifted outside of it will
be lost.

• 

Cut Selected Time: Cut the selected area.• 
Delete Envelope: Delete the whole envelope.• 

Process: Applies to the entire envelope or the selected area if there is one.• 
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Create Random Points: Create points of random value.♦ 
Create Exponential Curve: Create an exponential curve rising from 0 to
1. Use the flip buttons to achieve other curves.

♦ 

Create Linear Curve: Create a linear curve rising from 0 to 1.♦ 
Create Sine Curve: Create a single cycle sine curve.♦ 
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24 Effects
Adding effects to samples greatly expands the possibilities of their sound beyond the
original audio. The way this is achieved is by using various audio effects and other
devices to construct an FX Chain, which can affect any number of samples
simultaneously. FX Chains (.xrnt) can be loaded and saved as presets using the
drop-down menu located at the top right corner.

By default, instruments that make use of FX Chains will only be played in a single track
in Renoise, or a single output bus in Redux.

The interface is split into two sections. At the top is the FX Chain list, which also shows
some of the devices and output routing. The lower section is where the selected FX
Chain is constructed.

24.1 The FX Chain List

An FX Chain is a collection of effect devices. Any number of Chains can be created and
each instrument has its own unique FX Chain list. The individual samples of an
instrument can be assigned any one of its FX Chains, allowing different samples to be
affected in different ways. An FX Chain can also be assigned to multiple samples
simultaneously, so any changes made to a Chain will affect all linked samples.

The FX Chain assigned to the current sample is marked with a circle at the list's left.
Clicking on an empty circle slot will assign that FX Chain to the sample. Clicking
anywhere else on an FX Chain will select it for editing. Double-clicking on an FX Chain's
name allows you to rename it.
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FX chains can be added or removed using the buttons at the bottom left:

 - Delete the currently selected FX Chain.• 
 - Insert a new blank FX Chain below the currently selected Chain.• 

To the right of the FX Chain's name is a minimized view of that Chain's devices, which
you can scroll through using the arrow buttons at either side. Further right is the output
routing for the Chain, where you can route the audio to a specific track/bus.

Right-clicking on an FX Chain or device will select it and open a context menu with
additional options:

Cut: Cut the selected device.• 
Copy: Copy the device.• 
Paste: Paste the previously copied device after the selected device.• 

Delete: Delete the device.• 
Rename: Rename the device.• 

Bypass/Activate: Enable/disable the device.• 
Open External Editor: If the effect is a non-native plugin, this will open the
plugin's editor.

• 

Device
Copy Settings: Copy the property settings from the device.♦ 
Paste Settings: Paste the previously copied settings into the selected
device. Note that settings cannot be pasted between different types of
devices.

♦ 

Init Settings: Reset the device settings to their default values.♦ 

• 

Device Chain
Cut: Cut all of the Chain's devices.♦ 
Copy: Copy all of the Chain's devices.♦ 
Paste: Paste all of a previously copied Chain's devices (overwrites the
selected Chain).

♦ 

Delete: Delete all of the Chain's devices.♦ 
Load: Load an FX Chain (will overwrite the selected Chain).♦ 
Save As: Save the currently selected Chain.♦ 

• 

24.2 Creating FX Chains

The method of inserting and connecting devices to create Chains is identical for both
sample FX and track effects, so for the sake of efficiency this is covered in one separate
section: Effect Chains. Please refer to it for full details on this subject.
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24.3 Output Routing

When you create an FX Chain within the Sampler, by default, that instrument will then
be restricted to playing on a single track in Renoise, or a single output bus in Redux.
However, at the right of each FX Chain is the Output routing option, which can be set to
route the audio to a specific track or output bus, and this can be different for each FX
Chain.

In Renoise, the default value is ‘Current Track’. When playing the instrument via the
keyboard or MIDI controller, this refers to the track currently selected in the Pattern
Editor. When playing back a song this refers to the track that the most recent note was
triggered in. If notes are played in more than one track simultaneously, output will be
routed to the right-most of those tracks.

You may find it useful to watch our video on this subject.
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25 Plugin

Renoise has the ability to load in and make use of external plugin instruments (VST, AU,
DSSI). Besides the common MIDI properties, they also offer a custom GUI, audio routing
options and can be rendered down to sample-based instruments. Plugins can normally
only be played in a single track at a time, though multi-channel Plugins can be set up to
use audio routing to play in multiple tracks.

Plugins can be used in the Phrase Editor to compose musical phrases that will be
activated when specific notes are played. Clicking on the Phrases and Editor buttons
will switch between those two sections.

You may find it useful to watch our video covering both plugin instruments and effects.

25.1 Plugin Instrument Properties

25 Plugin 116

https://youtu.be/U2fQcXP4I5s


 - Enable to pin the plugin's external editor to the Renoise window.• 
 - Set up compatibility options for the plugin. Hovering the mouse over this

button will display some information about the plugin, such as latency, where the
file is loaded from etc.

• 

Instrument: The plugin instrument which you would like to use. This will initially
display "None". Click to show a list of available plugins. Please note that any VST
& VST3 plugins will be split into their own separate categories.

• 

Program: When available, select a specific preset for the plugin. Note that some
plugins only allow changing and setting up presets in their external editor.

• 

 - Load, save or rename the currently active preset.• 
 - Load or save all presets as a bank.• 

Channel: The MIDI channel that will be used to trigger the plugin. For most
plugins any channel will do, but when using multi-timbral plug-ins you can use
multiple channels to play different sounds from a single plugin instance.

• 

Transpose: Transpose note playback in semi-tonal increments.• 

Auto Suspend: When enabled, Renoise will completely shut off the plugin when
it is no longer producing sound. This is mainly done to reduce CPU usage. While
plugins are Auto Suspended they will automatically wake up as soon as they are
triggered again by playing notes or automation. Note: when suspended, some
older plugins will be unable to use the virtual keyboard in the custom GUI.

• 

Volume: The overall playback volume of the instrument.• 
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Render to Samples: Render the plugin (freeze it) to a sample-based
instrument. Left-clicking will replace the current plugin, while right-clicking
creates a brand new instrument. See Render or Freeze Plugin Instruments to
Samples for a detailed description and/or watch our video on the subject.

• 

MIDI Routing: Allows you to route the MIDI output of the current plugin into
another instrument beneath it in the Instrument Selector. This target instrument
can be another plugin with its own MIDI output (allowing you to chain
MIDI-generating plugins together), a 'normal' plugin (one that just generates
sound) or even the built-in sampler in Renoise. The only real limitation is that you
can’t trigger instrument phrases via a MIDI plugin.

• 

Audio Routing: Click the  button at the right to open the panel. By setting up
track routing you can force each Output Bus to be bound to a single track, no
matter which track you send the notes from. This can be useful if you want to
route different aliases to different tracks to keep things organised, or route
multiple instruments to the same track to use its effect chain. The method of
assigning these outputs from within the plugin will be different for each one, so
please refer to their manual for more information.

• 

You can also load in plugins and change the program via the Instrument Properties
section under the Instrument Selector.

25.2 Setting Up VST Paths

Plugins (VSTs or Audio Units) are external components that are installed on your
computer. Renoise will try to locate them automatically, but is sometimes unable to do
so. If you have plugins installed but they don't appear in Renoise, you can specify
directories where Renoise will look via the "Edit->Preferences->Plug/Misc" menu. See
the Plugins/Misc section of the Preferences for more information.
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25.2.1 Selecting a Plugin

Initially, the Instrument box will show "None". Click on it to select, search and organize
plug-ins. To select a plugin, double click on its name. To unload it, select "None" from
the list.

As soon as the plugin list is opened, you can start typing in the search field. If, for
example, you want to load a plugin called "Filter Modulator", then typing "Filter" will list
only plugins which have the term "Filter" in their plugin category or name. To select a
plugin using the keyboard, hit the "TAB" key to set the focus on the plugin list, then
navigate with the arrow keys to the desired plugin and hit "ENTER". Hitting "ESCAPE"
will close the list without selecting anything.

25.2.2 Organising/Customising the Plugin List

Right-clicking on a plugin name will bring up a context menu with the following options:

Add To Favorites: Adds the selected plugin or vendor to your favorites list.• 

Add To Group: Opens a new dialog box where you enter a name for the group.
If it is a new name, then the group will be created and the selected plugin(s)
moved under it. If the group already exists, then the plugin(s) will be moved over
to the group.

• 

Ungroup: (Only available when clicking on an existing group or vendor name)
Removes the selected group from the effects list.

• 

Rename: (Unavailable for native effects) Opens a new dialog box where you can
change the plugin or vendor name. Any changes made here will only be saved
within Renoise; the actual plugin name remains the same, since it may be used
by other applications.

• 

Hide: Excludes a plugin or a category of plugins from the list. This can be useful
if you no longer use a plugin, but don't want to uninstall it because old songs still
use it. To make a hidden plugin visible again, enable the "Show Hidden Devices"
option, then simply "Unhide" it again.

• 

Collapse Whole Tree: Collapses the entire effects list, showing only the
Favorites (if any exist), Native and VST categories. Handy if you need to show
just a few effects.

• 

Expand Whole Tree: The effects list will expand back to its full size again.• 

Show Hidden Devices: Enables hidden plugins to become visible again.• 
Show Short Names: Instead of sorting plugins by vendor, you can also display
them as a single list. With this option enabled you can still categorise the plugins
by renaming them as described above.

• 

25.2.3 Favorites List

To add a plugin to your custom favorites list, click the star icon to the right of it. Your
favorites are located at the very top of the instruments list. To remove a plugin from
your favorites, simply click the star icon again.
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25.3 Plugin Aliases (multi-timbral plugins)

Some plugins allow the use of multiple MIDI channels to play different sounds from a
single plugin instance. This is not absolutely necessary, as you can always load a
separate instance of a plugin to use a different sound, but it can be helpful to save on
CPU consumption. To find out if your plugin supports this, search for the keyword
"multi-timbral" or "routing" in the plugin's manual.

To create an alias, first load your chosen plugin into an instrument slot, use the
Instrument Selector to select another instrument slot and then open the plugin list
again. You will see at the top of the list is the new category, "VST Aliases" (or "AU
Aliases" if you've used an Audio Unit). The aliases refer to the previously loaded plugin.
Double-click on one of the aliases in the list to create it, then change the channel
number to use it.

The instrument is shown in the Instrument Selector with its alias name:

Note that any changes made to the options in the plugin properties panel, except for
"Channel" and "Transpose", will be applied to all of the aliases, as well as the original
plugin. Furthermore, deleting the original plugin will also delete all of the aliases. The
Audio Routing option is used to assign different plugin sounds to different outputs.

25.3.1 Plugin Effect Aliases

It is also possible to create aliases for track effect plugins, which allows you to control
the plugin in ways that are not normally possible by sending MIDI data.

25.4 Plugin Compatibility Options
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This dialog will appear after clicking on the  button in the plugin properties after a
plugin instrument is loaded. In most cases these options will already have the correct
settings, as Renoise comes with a database which sets the defaults for you. If you are
experiencing any of the problems described in the dialog, then you might want to try
altering the settings.

25.5 Typing Text Into A Plugin

Some plugins allow you type text into their window, but if you find Renoise is not
allowing this and is playing notes instead, then you can enable typing by clicking the
'Enable Keyboard' option at the bottom-left of the plugin window.
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26 MIDI

With the MIDI section you can use external MIDI devices to trigger an instrument in
Renoise or vice versa. The MIDI input and output events are listed in the large central
panels, where you can also filter the listing of certain events.

MIDI can be used in the Phrase Editor to compose musical phrases that will be activated
when specific notes are played. Clicking on the Phrases and Monitor buttons will switch
between those two sections.

26.1 MIDI Input

You can assign individual MIDI input devices to an instrument or even several different
instruments. You can also specify the MIDI channel and note range that the instrument
is activated by, as well as assign it to be played on a particular track within Renoise.
These options are particularly useful when performing live.

26 MIDI 122



Input Device: The MIDI input device. If the MIDI Master device is used as the
input, from that point on it will only trigger the assigned instruments.

• 

Channel: The MIDI channel which the instrument will be activated by.• 
Start/End Note: The note range which the instrument will be activated by.• 
Assigned Track: The track that the instrument will be played on. Note that a
single Renoise track only supports up to 12 notes triggering at once. So when
linking several instruments to a single device it is possible for this limit to be
exceeded, resulting in some notes going unplayed. To avoid this, assign each
instrument to a dedicated track.

• 

Show Routing Overview: Opens a dialog box with an overview of all routings
that have been made in the song. You can quickly reset them with the "Clear All"
button.

• 

26.2 MIDI Output

With a MIDI instrument you can play external synthesizer hardware or control software
synthesizers running on your computer. The latter is done by using virtual MIDI devices
(MIDI Yoke on Windows, the IAC BUS on Mac MacOS) and programs which receive MIDI.
When running Renoise as a ReWire master, loaded ReWire slaves (e.g. synthesizers like
Reason) will also show here as virtual MIDI devices.

Output Device: The MIDI device that you would like to send MIDI to. Without
setting up a device, no MIDI data can be transferred, so this is your first priority

• 
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when creating a MIDI instrument.

Transpose: Transpose note playback in semi-tonal increments.• 
Latency: A custom manual latency that all events will be sent with. This is
sometimes needed to get external devices properly synchronised. Please note
that in order to use a negative latency, the Mode (see below) must be set to "ext.
MIDI" and that the smallest possible negative latency is limited to the current
latency of your soundcard. If you need further negative latency, you can make
changes to this in the Audio Preferences.

• 

Note Length: When set to INF, Note-Off (key release) events must be explicitly
sent in order to stop notes from playing. When enabled (not INF), the MIDI
instrument will behave as if it has a finite duration. This can be especially useful
for playing drum samples, since you no longer have to manually turn them off
every time.

• 

Channel: The MIDI channel that will be used to trigger the MIDI device.• 
Bank: When set, this is the bank number you want to apply before the
instrument is loaded with songs. When disabled, no bank change information will
be sent to the device. You can use the box immediately below to choose the
MSB/LSB order for MIDI program changes, in case your gear is picky about the
order in which these message arrive.

• 

Program: When set, this is the program number you want to apply before the
instrument is loaded with songs. When disabled, no program change information
will be sent to the device.

• 

Mode: Adjusts the latency depending on how you capture the audio from your
external instrument (see Latency handling with External MIDI Instruments for a
more in-depth explanation):

ext. MIDI: The MIDI device is routed to an external synthesizer, which
then outputs its own sound directly.

♦ 

LineIn Ret: The MIDI device is routed to an external synthesizer, but the
audio signal is routed back to Renoise via a #Line Input device.

♦ 

• 

You can also access some of these options via the Instrument Properties section under
the Instrument Selector.

26.2.1 Latency Handling with External MIDI Instruments

The syncing of external MIDI instruments can become rather complicated and so
requires some explanation. There are a number of factors to take into account including
the soundcard's audio output latency, the MIDI connection's MIDI latency, the automatic
plugin delay compensation (PDC) and the soundcard's audio input latency (if feeding
the external audio back into Renoise).

ext. MIDI Mode

If you're feeding any audio produced by external equipment directly to the speakers,
set the instrument's mode to "ext. MIDI". This will delay all MIDI events sent to the
instrument by Renoise's internal audio latency (which is composed of the soundcard's
output latency plus any PDC). This way it will be sent to the external synth at the same
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time that the audio generated internally by Renoise reaches the soundcard outputs. If
your MIDI interface and external synth introduce no extra delays in handling the MIDI
signal, the audio produced by the synth and Renoise should now be perfectly in sync.

In reality however, it is likely that there will be a few milliseconds of MIDI latency
between the time that Renoise sends out the MIDI event and the time that the synth's
audio output reaches the speakers. To compensate for this extra MIDI latency you can
either use the Latency value in the MIDI Output panel or the track delay setting in the
Mixer for the track that the MIDI instrument is being triggered from.

LineIn Ret Mode

If you want to feed the audio from the external equipment back into Renoise for further
processing, set the instrument's Mode to "LineIn Ret". Now add a #Line Input device to
the same track that you're triggering the external instrument from. In the #Line Input
device, set Latency to "MIDI Return Mode". You also need to make sure that PDC is
enabled in the Renoise Preferences. Now MIDI events sent to the instrument will not be
delayed by the audio latency (as with "ext. MIDI" mode), but instead they are sent out
immediately. This is because the audio coming back from the synth into Renoise will be
subject to the soundcard's input latency (which is the same as the output latency). So
assuming no MIDI latency, the externally produced audio should now be in sync with
the internally generated audio.

As with "ext. MIDI" mode, the MIDI connection to the external instrument is likely to
introduce some delay here. This time however, you can only compensate for it by using
the track delay setting in the Mixer for the track on which you are triggering the MIDI
instrument. The MIDI Output Latency value does not allow negative latencies in "LineIn
Ret" mode, since in this mode Renoise sends out MIDI events the instant they are
encountered. The following diagram illustrates this:

For this routing scheme to work, it's important that you keep the #Line Input device on
the same track that you trigger the MIDI instrument from and that PDC is enabled.
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Without PDC enabled, Renoise will not compensate for audio latencies.

26.3 MIDI Messages

These are the MIDI messages that a Renoise/Redux instrument can understand. Note
that in Renoise, the currently selected instrument is the one receiving messages. This
can be changed for each song by setting up a specific MIDI input.

Changing the volume, scale key and scale mode will adjust the Instrument Properties
for sample-based instruments. If the instrument contains Plugin or MIDI components
then the messages will be directed there instead, leaving the samples unaffected.

Type Description Value

MIDI Note Note Message
Trigger phrases or samples

0-119 =
Velocity

Program Change
Program Change
Control phrase-triggering mode, select phrase in Program
Mode

0 = Phrase
Off
1-126 =
Program
Mode
127 =
Keymap
Mode

CC#01 Mod-Wheel
� Freely assignable as a Macro 0-127

CC#07 Volume
Control the global volume 0-127

CC#14 Scale Key
Determine the root key for the scale 0-11

CC#15
Scale Mode
Apply a harmonic scale to the preset - Scale & Key are
covered in-depth in our video

0 = OFF
1-35 =
Scale

CC#64
Sustain Pedal
While sustain is enabled, any playing notes will continue
to play until the pedal is released

0-63 = OFF
64-127 =
ON

CC#121
All Controllers Off
Reset pitch-bend (PB), channel-pressure (CP) and
mod-wheel (MW)

Not used

CC#123 All Notes Off
Turns off any currently playing notes Not used

Channel
Pressure

Channel Pressure
� Freely assignable as a Macro 0-127

Pitch Bend Pitch Bend
� Freely assignable as a Macro

0-127
0-16384
(14-bit)

Renoise 3.4 User Manual

26.3 MIDI Messages 126

https://youtu.be/Qw0qfj7-1zY


Type Description Value
Mod-Wheel See CC#01

26.3.1 CC#14 - Scale Key

Messages with a value above 11 have no effect. Scale & Key are covered in-depth in
our video.

CC# Key
0 C
1 C#
2 D
3 D#
4 E
5 F
6 F#
7 G
8 G#
9 A
10 A#
11 B

26.3.2 CC#15 - Scale Mode

Messages with a value above 35 have no effect. Scale & Key are covered in-depth in
our video.

CC# Scale Keys In
Scale

0 No scale 12
1 Natural Major 7
2 Natural Minor 7
3 Pentatonic Major 5
4 Pentatonic Minor 5
5 Pentatonic Egyptian 5
6 Blues Major 6
7 Blues Minor 6
8 Whole Tone 6
9 Augmented 6
10 Prometheus 6
11 Tritone 6
12 Harmonic Major 7
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CC# Scale Keys In
Scale

13 Harmonic Minor 7
14 Melodic Minor 7
15 All Minor 9
16 Dorian 7
17 Phrygian 7
18 Phrygian Dominant 7
19 Lydian 7
20 Lydian Augmented 7
21 Mixolydian 7
22 Locrian 7
23 Locrian Major 7
24 Super Locrian 7
25 Neapolitan Major 7
26 Neapolitan Minor 7
27 Romanian Minor 7
28 Spanish Gypsy 7
29 Hungarian Gypsy 7
30 Enigmatic 7
31 Overtone 7
32 Diminished Half 8
33 Diminished Whole 8
34 Spanish Eight-Tone 8
35 Nine-Tone Scale 9
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27 Effect Chains
Effects can be applied in two ways: directly onto samples, affecting only those sounds,
or (Renoise only) inserted into tracks, affecting all sounds that are played there. Either
way, devices are inserted into an interactive effect chain, with the audio signal running
through each device from left to right. The devices can be chosen from the pool of
native effects or (Renoise only) any third-party plugin.

The native devices come in four different categories. Audio Effects alter the sound in a
variety of ways. Meta Devices do not change the actual audio signal themselves, but
instead alter the parameters of another effect. Routing Devices either send audio to
another FX Chain/track or receive a signal from an external source. Doofers are special
devices that contain their own effect chain within them and provide easy access to their
most useful parameters through macros.

A song or instrument created using only these native effects can be saved and given to
other people, where it will play back on their copy of Renoise/Redux exactly as it did on
yours. Renoise only: However, if plugin effects or plugin instruments (VST, AU, LADSPA,
DSSI) are used, these external programs must also be installed on their system,
otherwise they won't be played.

27.1 The Effects List

If you're adding effects to samples: In Renoise make sure you're in the Sampler ->
Effects section. In Redux, just click on the Effects tab.

If you're adding effects to a track in Renoise, use the effect list in the Pattern Editor by
selecting its icon at the lower left corner of the interface: 

Note that when the Mixer has been detached as a separate window the entire Track
Effects panel and its button are moved with it.

Either way, the list of available effects is found at the bottom left and is categorised like
so:

Native
Audio Effects♦ 
Meta Devices♦ 
Routing Devices♦ 
Doofers♦ 

• 
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(Renoise only) VST/VST3/AU/LADSPA/DSSI - note that VST & VST3 plugins are
split into separate categories

Plugin Effects♦ 

• 

You can quickly search for an effect by typing part of its name in the search bar at the
top of the list. This also works for categories, so typing in "VST" will show only VST
plugins in the list. To add a device from the list to the effect chain, either double-click
on it or drag and drop it into the chain at the desired position.

Renoise only - You can also drag and drop an effect into any track while using the
Mixer:

Renoise only - Note that although plugin effects and plugin instruments may have the
same format name i.e. VST, they are still fundamentally different. Plugin effects will
show up in the effects list shown here, while plugin instruments are handled in the
Plugin section of the Instrument Editor.

27.1.1 Organizing the List

By default, the plugin effects list is sorted by vendor name. Clicking the "More" button
next to the search field will vertically expand the list, giving you more room to organise
the effects.

Right-clicking on a plugin or vendor/group name will bring up a context menu with the
following options:

Add To Favorites: Adds the selected plugin or vendor to your favorites list.• 

Add To Group: (Renoise only) Opens a new dialog box where you enter a name
for the group. If it is a new name, then the group will be created and the selected
plugin(s) moved under it. If the group already exists, then the plugin(s) will be
moved over to the group.

• 

Ungroup: (Renoise only) (Only available when clicking on an existing group or
vendor name) Removes the selected group from the effects list.

• 

Rename: (Renoise only) (Unavailable for native effects) Opens a new dialog box
where you can change the plugin or vendor name. Any changes made here will
only be saved within Renoise; the actual plugin name remains the same, since it
may be used by other applications.

• 

Hide: Excludes a plugin or a category of plugins from the list. This can be useful
if you no longer use a plugin, but don't want to uninstall it because old songs still

• 
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use it. To make a hidden plugin visible again, enable the "Show Hidden Devices"
option, then simply "Unhide" it again.

Collapse Whole Tree: Collapses the entire effects list, showing only the
Favorites (if any exist), Native and VST/AU/LADSPA/DSSI categories. Handy if you
need to show just a few effects.

• 

Expand Whole Tree: The effects list will expand back to its full size again.• 

Show Hidden Devices: Enables hidden plugins to become visible again.• 
Show Short Names: Instead of sorting plugins by vendor, you can also display
them as a single list. With this option enabled you can still categorise the plugins
by renaming them as described above.

• 

27.1.2 Favorites List

To add a plugin to your custom favorites list, click the star icon to the right of it. Your
favorites are located at the very top of the effects list. To remove a plugin from your
favorites, simply click the star icon again.

27.2 Common Device Layout and Controls

Each effect device has a standard set of buttons to perform common functions:

 - Remove the device from the chain.• 
 - Minimize/maximize the device.• 

 - Move the device to the left or right. Right-click to move to the start or end
of the chain.

• 

 - Enable/disable the device.• 
 - Double click on the device name to rename it.• 

27.3 Storing/Recalling Effect Presets

 - Right-clicking on the A or B button will store the current set of parameter
values. If the parameters are then changed to something else, left-clicking will
restore them back to the stored values. Storing to both A and B allows you to
quickly switch between two different presets and compare them. Any presets
stored like this are saved with your song, so you don't need to worry about losing
them.

• 

 - Select, edit or create presets for this effect. Clicking the preset name
shows a list of available presets, along with some options:

• 
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By choosing ‘Save As...’ from the menu and entering a name, the current parameters
will be saved as a new preset in the User Library. The presets will show up every time
you use the effect device in future across both Renoise & Redux because they’re
compatible and share their data from this same User Library.

To save/load parameter presets to/from disk, use the "Import" and "Export" options in
the same context menu. This method allows you to share your presets with other users.

Finally, when they’ve been selected from the menu, user created presets can also be
renamed and deleted.

27.4 Pre and Post Mixer Effects

Two devices are always present in every effect chain and cannot be removed or
repositioned: the Pre and Post-Mixer devices.

The Pre-Mixer device is located at the beginning of each effect chain and controls the
routing, volume, panning of the incoming signal, and in Renoise it also controls the
width and delay.

Renoise only - In the Pattern Editor's standard Tracks, this is the audio from the notes
in that track. For Groups, Sends and the Master Track, this is the audio that is being
routed to them.
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The Post-Mixer is located at the end of the effect chain and controls the volume and
panning of the sound that leaves it.

Renoise only - The Post-Mixer device in the Master Track has a few extra options to
help manage the master signal:

DC Filter: When enabled, any DC offset in the master signal will be
automatically removed.

• 

Soft Clipping: When enabled, the master signal will be softly saturated when
clipping occurs.

• 

Auto Gain: Automatically lowers the master volume when clipping occurs. This
is the same as the Upper Status Bar's auto gain button: 

• 

Peak Levels: Shows the actual master signal. Using this you can easily see if
the master signal is clipping and by how much.

• 

27.5 Copy/Pasting Effect Chains

Right clicking on a device or into the free space between the effects will show a context
menu with various options for the whole chain, or the currently selected chain. This way
you can delete, cut, copy or paste whole chains, or min/maximize all effects in the
current chain. Please have a look at the following screenshot for all available options:
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27.6 Loading/Saving Effect Chains

It is possible to export effect chains to disk for later use through the "Other" category in
the Disk Browser. Beware when loading an effect chain though, that the existing chain
will be replaced with the new one. You can avoid this by right-clicking the chain file in
the Disk Browser and then selecting, "Load file with options...".

27.7 MIDI Mapping and Automating Effects (Renoise Only)

The MIDI Mapping feature can be used to bind an effect parameter to a hardware MIDI
controller, which is incredibly useful for recording and playing live. The parameters can
also be automated using either Graphical Automation or Effect Commands.
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28 Audio Effects
Renoise and Redux provide a wide range of native effect devices that can be used to
alter the input audio in a variety of ways.

28.1 Delay Devices

Delay devices repeat an audio signal and mix it with the original sound. By repeating
and dampening the sound over and over again, this simulates spatial effects.

28.1.1 Convolver

The Convolver applies the sonic character of an impulse response to the input audio by
convolution, which is a more complex intertwining of the sounds compared to a simple
reverb. An impulse response is typically a recording of an acoustic space's
reverberation after an impulse (short sound burst) is played within it. However, impulse
responses are not merely limited to reverb and can be created by any method,
including just loading in any audio file.

Load/Reload: Pressing the load button will open up a dialog box where you can
load in an audio file to use for convolving. The arrows will automatically load in
the previous/next file from the current directory. The reload button will simply
reload the current sample.

• 

Predelay: An initial delay that is applied before any convolution occurs.• 
Color: Used to attenuate or boost mid-range frequencies of the convolved
signal.

• 

Dry Mix: The gain of the non-convolved input sound.• 
Wet Mix: The gain of the convolved signal.• 
Impulse: Selecting "Mono" will use only the left signal of the impulse response in
order to lower CPU usage.

• 

Gain: The gain of the impulse response.• 
Start: Changes the point in time within the impulse response that convolution
will start from.

• 

Length: The length of the impulse response, as a percentage of its original
length.

• 

Resample: Changes the speed which the impulse response is convolved at.• 
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28.1.2 Delay

The Delay device is a classic audio effect that creates patterns of spatial echoes from
its input, which can be used both creatively and for more practical mixing purposes. It
features independently controllable left and right delay channels that can work within
two different modes. You may find it useful to watch our video about the Delay &
Multitap Delay devices.

L/R Delay/Offset: In un-synced mode, the sliders directly set the left and right
delay lengths in a range from 1 millisecond up to 2 seconds. In Line Sync mode,
they positively or negatively offset the delay timing from its automatically
selected length.

• 

L/R Feedback: Controls the amount of diminishing feedback that occurs on
each of the delays, altering the number of 'echoes' that are produced. 0% means
that the delay will only be heard back once, while at 100% it will keep repeating
forever.

• 

Send: The volume of the source audio that is sent to the delays, where the
maximum value of 0db is the same volume as the input sound.

• 

Line Sync: This switches the mode of the device from the default of 'un-synced'
to 'Line Sync'. When un-synced, the Delay sliders can be used to freely set a
delay length. In Line Sync mode, the delay lengths are tied to the "Play After
Line" values and the sliders change to an Offset percentage.

• 

Play After Line: The values are the amount of lines in the Pattern Editor that
the left and right delay echoes are to be played after. In un-synced mode, a 'Set'
button must be clicked to do this, causing the Delay slider to automatically move
to the correct delay timing, calculated according to the song’s tempo (BPM and
LPB). In Line Sync mode, the Set buttons disappear because the delay timings
are always linked to the song’s tempo through the Play After Line values, so
changing a value or the BPM/LPB will instantly adjust the delay lengths correctly.
However, the delays can be offset from that correct timing with the sliders to the
left, whose function has changed in this mode.

• 

L/R Output Pan: Controls the panning position of the left and right delay
outputs.

• 

Mute Src.: When toggled on, this silences the 'dry' source audio, leaving only
the delayed echoes produced by the effect.

• 

Tips and tricks

Regardless of whether the mode is un-synced or in Line Sync mode, any
parameter changes affecting the delay length produce a quick 'scrubbing' sound,
simulating a classic 'tape delay' speed change.

• 
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When both the L and R delay lengths are set to the same value, then the panning
of the output sound automatically becomes mono (unless the Output Pans are
used to create a stereo imbalance).

• 

Very low delay lengths cause the echoes to merge, allowing you to build
stereo-expansion style effects. This can be done with the standard Delay, but the
Multitap allows the customising of much more interesting results.

• 

Sometimes simplistic percussive and melodic input sounds can turn into
complex, exciting rhythmic flows by using synchronised delays. Experimenting
with different "Play After Line" values can yield interesting results. A common
echo rhythm can be created using a 6-beat delay, but other values may be
appropriate depending on the input rhythm and sound.

• 

Output panning can be especially important for stereo inputs when you want to
break away from the default, where the left and right channels of a waveform
will be kept to those sides. This may not be desirable though, so the Output Pan
sliders can be used to place the delay output in a different position from the
input. Common uses of this feature include panning the outputs to the center to
create a mono echo, or a left/right swap where the echoes appear on the
opposite side from the input. Techniques such as this can be very useful to fill
out the spatial character of a mix.

• 

28.1.3 Multitap Delay

The Multitap Delay is a more complex version of the regular device, featuring filtering
options and four individual 'Taps' that can be fed audio from both the original input
sound and the previous Tap. You may find it useful to watch our video about the Delay
& Multitap Delay devices.

L/R Delay/Offset: In un-synced mode, the sliders directly set the left and right
delay lengths in a range from 1 millisecond up to 5 seconds. In Line Sync mode,
they positively or negatively offset the delay timing from its automatically
selected length.

• 

L/R Feedback: Controls the amount of diminishing feedback that occurs on
each of the delays, altering the number of 'echoes' that are produced. 0% means
that the delay will only be heard back once, while at 100% it will keep repeating
forever. With a negative value the first echo is unaffected, then the waveform is
inverted as it is fed back into the device.

• 

Amount: The volume of the selected Tap's 'wet' delay output.• 

No Panic: Clicking the skull button immediately stops the feedback from the
Taps.

• 
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Mute Src.: When toggled on, this silences the 'dry' source audio, leaving only
the delayed echoes produced by the effect.

• 

Show/Hide Extra Controls: Clicking the arrow button expands/shrinks the
device to show/hide the extra controls available for each Tap.

• 

Tap 1-4: Swaps between each of the four Taps.• 

Additional parameters for each Tap are shown by pressing the "Show/Hide Extra
Controls" button:

Line Sync: This switches the mode of the device from the default of 'un-synced'
to 'Line Sync'. When un-synced the Delay sliders can be used to freely set a
delay length. In Line Sync mode, the delay lengths are tied to the "Play After
Line" values and the sliders change to an Offset percentage.

• 

Play After Line: The values are the amount of lines in the Pattern Editor that
the left and right delay echoes are to be played after. In un-synced mode, a 'Set'
button must be clicked to do this, causing the Delay slider to automatically move
to the correct delay timing, calculated according to the song’s tempo (BPM and
LPB). In Line Sync mode, the Set buttons disappear because the delay timings
are always linked to the song’s tempo through the Play After Line values, so
changing a value or the BPM/LPB will instantly adjust the delay lengths correctly.
However, the delays can be offset from that correct timing with the sliders to the
left, whose function has changed in this mode.

• 

Input Source: The volume of the source audio that is used in the selected Tap,
where the maximum value of 0db is the same volume as the input sound.

• 

Input Tap 1-3: (Available on Taps 2-4) How much of the previous Tap's signal is
used for this Tap.

• 

Filter Type: Choose from four different types to filter the Tap: Low/High/Band
Pass or Notch.

• 

Filter Freq.: Sets the cutoff/target frequency for the selected filter type.• 
Filter Q: (Available for Band Pass and Notch only) Adjusts the size of the filter’s
frequency range.

• 

Filter Drive: Adjusts the gain of the attenuated frequencies.• 
Filter Position: Specifies where the filter is applied in the Tap's signal path.

Off: Turns the filter off completely.♦ 
Input: Filters the input audio as it’s entering the Tap.♦ 
Feedback: Continually filters the sound each time it is echoed.♦ 
In + Feed: Combines the effects of the Input and Feedback methods.♦ 
Output: Filters the audio leaving the Tap. Since it’s only applied once, you
can change the filter settings to affect the feedback non-destructively.

♦ 

• 

Output Pan L/R: Controls the panning position of the left and right delay
outputs.

• 

Ping Pong: When toggled on, the left and right feedback delays play as normal
for the first echo, but then move to the opposite delay channel, using its length,
Feedback and Output Pan settings. As long as Ping Pong is enabled, the audio
will keep swapping back and forth like this every time it echoes.

• 

28.1.4 Repeater

This effect captures a small chunk of sound from what is currently playing in a track,
then keeps repeating it. You may find it useful to watch our video on this subject.
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Mode Type - Selects the method of repetition:
Off: Deactivates the repeating.♦ 
Free: Allows for the "Divisor" to be set to any value.♦ 
Even: Repeats the sound exactly once per "Divisor" value.♦ 
Triplet: Repeats the sound at two thirds (67%) the length of the "Divisor"
value.

♦ 

Dotted: Repeats the sound at one and half times (150%) the length of the
"Divisor" value.

♦ 

• 

Divisor: The length of the captured sound to be repeated. The value represents
this as a fraction of four beats, also know as a Whole Note or Semibreve (with
Lines Per Beat at the default value of 4, this is 16 lines of the Pattern Editor).

• 

Sync: Determines how parameter changes are handled. "Repeats" will
implement the change only after the end of the current repetition, while "Lines"
updates in sync with the pattern lines (if the current repetition extends past the
next line).

• 

Hold: With this setting off, the "Mode Type" will automatically return to "Off"
after the mouse button is released when using the "Grid".

• 

Grid: Clicking on the grid will change the "Mode" and "Divisor" settings.• 

Tips and tricks

Unlike other effects, just inserting a Repeater into a track doesn't automatically
affect the audio, because the default Mode is ‘Off’. The effect is activated when a
Mode other than ‘Off’ is selected.

• 

When the settings are changed, it is the sound playing at that exact moment
that is captured. So make sure a sound is actually playing when using the
Repeater, or only silence will be repeated.

• 

Hold down the left mouse button on the "Grid" and move the mouse around. This
will automatically change the "Mode" and "Divisor" settings and is especially
useful on the "Free" section at the top.

• 

Using the right mouse button, you can record changes made via the grid directly
to the Pattern Editor.

• 

28.1.5 Reverb

A straightforward reverb effect.
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Wet Mix: The gain of the reverberated signal.• 
Room Size: The size of the room, i.e. the delay time of the echoes.• 
Width: The width of the reverberated stereo signal. 0 = mono, 100 = full stereo.• 
Damp: A filter cut-off to simulate sound-absorption level of walls.• 
Dry Mix: The gain of the non-reverberated input sound.• 

28.1.6 mpReverb

A complex reverberation effect with many parameters to modify the sound of the
reverberated signal.

Duration: The reverberation time in milliseconds.• 
Predelay: An initial delay that is applied before any reverberation occurs.• 
Low Cut: The cut-off frequency of the dampening filter.• 
Low Gain: The gain of the dampening filter. Lower values create more
dampened sounds.

• 

Color: Used to attenuate or boost mid-range frequencies of the reverberated
signal, in order to simulate walls.

• 

Width: Controls the stereo separation of the reverberated signal.• 
Pan: The panning of the reverberated signal.• 
Wet Mix: The gain of the reverberated signal.• 
Dry Mix: The gain of the non-reverberated input sound.• 

28.2 Dynamics Devices

These devices are used to dynamically change the amplitude of an audio signal. The
Compressor, Bus Compressor and Gate are able to be used as a Receiver for the
#Sidechain device.
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28.2.1 Compressor

A Compressor 'squashes' the volume of an audio signal while it is above a specific
Threshold level, reducing its dynamic range. Generally speaking, the compression level
Attacks when the volume increases and Releases when it falls. The extra headroom
provided by compression allows the signal to be boosted in volume after compression,
resulting in a 'fattening' of the sound. You may find it useful to watch our Compression
video.

Threshold: The minimum volume level at which the compression will take place.• 
Ratio: The strength of the compression.• 
Attack: The speed that compression is pushed towards its maximum.• 
Release: The speed that compression is reduced, with the aim of removing it
completely.

• 

Makeup: A volume adjustment that is applied to the output.• 

28.2.2 Bus Compressor

Unlike the normal Compressor, the Bus Compressor doesn't merely react to the
incoming signal. A short delay is introduced so that the future behaviour of the input
waveform can be analysed. This allows the appropriate action to be taken for adaptive
compression. Short peaks are handled via a feed-back algorithm, while constant signals
use a feed-forward algorithm. You may find it useful to watch our Compression video.

Threshold: The minimum volume level at which the compression will take place.• 
Ratio: The strength of the compression.• 
Attack: The speed that compression is pushed towards its maximum.• 
Release: The speed that compression is reduced, with the aim of removing it
completely.

• 

Makeup: A volume adjustment that is applied to the output.• 
Knee: Controls how the gradually the compression is applied around the
Threshold point, as shown in the graphical representation underneath. Allows for
a softer, more natural sounding compression compared to the regular
Compressor.

• 
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28.2.3 Gate

A Gate reduces the volume of an input signal unless it exceeds a specific Threshold.
When it does, the Gate 'opens' allowing the original audio to be heard at its full volume.
For example, this can be used to silence a constant low noise floor, or to reduce the low
volume parts of a complex waveform (such as drum loops). With the input filters you
can target a specific frequency range to control the gating without filtering the output.
The 'Duck' option reverses the behaviour of the Gate.

Threshold: The minimum dB value at which the input signal will open the Gate.• 
Attack: The time it takes the Gate to react to the signal breaching the
Threshold.

• 

Hold: Determines how long the Gate will be held open after the signal has fallen
below the Threshold, delaying the Release phase.

• 

Release: The time it takes for the Gate to fully close again after the signal falls
below the Threshold. Longer Release times will result in slower fade-outs.

• 

Floor: The amount of volume reduction applied to the gated audio. Setting this
to the minimum value will silence it completely.

• 

Env. Input: Click to listen to the input after it has been affected by the High and
Low Pass filters. Useful to hear exactly what frequency range will control the
Gate.

• 

High/Low Pass: The frequency of the High/Low Pass filter applied to the input.
The output signal is not affected by the filters.

• 

Gate/Duck: Duck mode reverses the behaviour of the Gate, applying the Floor
value to the audio while it is above the Threshold.

• 

Mono/Stereo: Toggle the gating of stereo channels equally or individually.• 

28.2.4 Maximizer

The Maximizer is a hard limiter which boosts and limits audio signals. It will hard-clip a
signal that exceeds the Threshold, but then soften the Release when it falls back under
that Threshold (contrary to plain hard-clipping). The Maximizer is often used for final
mastering to block any stray, unnecessary peaks without harsh sounding full
hard-clipping.
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Boost: Gain applied to the signal before the Threshold.• 
Threshold: The dB value that the Maximizer limits the input to.• 
Peak Rel.: Compression release factor for peaks (transients).• 
Slow Rel.: Compression release factor for non-peaks (constant signals).• 
Ceiling: Final gain applied to the output.• 

The small red LED below the VU meters indicates when the Peak Rel. factor is being
used.

28.3 Filter Devices

Audio filters manipulate the frequency spectrum, sometimes for functional, mixing
purposes and sometimes for purely artistic reasons. The EQ devices tend to use filtering
for the former, while the Comb Filter concentrates on the latter. The Analog and Digital
Filters can do a bit of both.

28.3.1 Analog Filter

An analog style filter featuring zero delay feedback filters with character (saturation,
non-linearities) and optional oversampling (2x by default). Both the Analog & Digital
Filters are covered in this video.

The available filter models are:

2P K35: A 2 pole 12dB low pass, 6dB high pass filter with an extra pole on the
feedback path.

• 

2P Moog: A 12dB transistor ladder filter with a very unique sound and
resonance near to self-oscillation.

• 

4P Moog: A 24dB version of the 2P Moog filter.• 
4P Diode: A 4 pole 24bB low pass diode ladder filter, with high pass filtered
feedback path.

• 

There are three types of filtering:

Low Pass: Passes low frequency signals but attenuates frequencies higher than
the Cutoff value.

• 

Band Pass: Passes frequencies within a certain range and attenuates
frequencies outside of that range.

• 

High Pass: Passes high frequency signals but attenuates signals lower than the
Cutoff value.

• 
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Each filter type has five parameters:

Cutoff: The target frequency for filtering.• 
Resonance: Creates a ringing feedback loop for frequencies around the Cutoff
value.

• 

Inertia: Determines how fast parameter changes are applied. Low Inertia will
create sweeping effects by noticeably sliding from one parameter setting to
another. This can be useful to soften the effect of Cutoff changes applied to
sounds with mostly low frequencies.

• 

Drive: The strength of saturation that’s applied to the audio as part of the
filtering process.

• 

Oversampling: Oversampling can be useful to stabilise the filter at high
frequencies and reduce possible aliasing introduced by saturation. Note that an
oversampling factor of n also requires n times more CPU usage.

• 

28.3.2 Comb Filter

The Comb Filter gets its name from the series of regularly spaced notches in the
frequency spectrum that it uses to affect the audio. These notches are generated by
adding a delayed version of the input signal to itself, causing constructive and
destructive interference.

You may find it useful to watch our video on the Comb Filter and Ringmod effects.

Note & Transpose: Changes the character of the comb, 'tuning' it to produce
precise note values.

• 

Feedback: Amount of output audio fed back into the device. Values below zero
use a negative version of the waveform.

• 

Inertia: Determines how fast parameter changes are applied. Lower values
create sweeping effects, noticeably sliding from the old parameter setting
towards the new one.

• 

Dry/Wet: Ratio of the clean and modulated signals, as a percentage.• 

28.3.3 Digital Filter

A digital filter with optional oversampling (2x by default). Compared to the Analog Filter
this behaves in a stricter, cleaner fashion. Both the Analog & Digital Filters are covered
in this video.
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The available filter models are:

Biquad: A standard, precise and fast 2 pole (biquad) filter.• 
Butterworth 4n: A fourth order Butterworth filter. Butterworth filters are
designed to have a frequency response which is as flat as mathematically
possible in the passband, precisely cutting off frequencies.

• 

Butterworth 8n: An eighth order Butterworth filter, which has an even flatter
frequency response than the fourth order version.

• 

Chebyshev 4n: A fourth order Chebyshev filter with customizable ripple.• 
Chebyshev 8n: An eighth order Chebyshev filter with customizable ripple.• 

Each model has four types of filtering:

Low Pass: Passes low frequency signals but attenuates frequencies higher than
the Cutoff value.

• 

Band Pass: Passes frequencies within a certain range and attenuates
frequencies outside of that range.

• 

Band Reject: Passes most frequencies unaltered but attenuates those in a
specific range to very low levels.

• 

High Pass: Passes high frequency signals but attenuates signals lower than the
Cutoff value.

• 

Each filter type has up to five parameters:

Cutoff: Sets the target frequency for filtering.• 
Resonance/Q: In Low or High Pass filters, this creates a ringing feedback loop
for frequencies around the Cutoff value. In Band Pass or Reject filters, this
adjusts the attenuation range.

• 

Ripple: Adjusts the gain of the ripples in a Chebyshev filter.• 
Inertia: Determines how fast parameter changes are applied. Low Inertia will
create sweeping effects by noticeably sliding from one parameter setting to
another. This can be useful to soften the effect of Cutoff changes applied to
sounds with mostly low frequencies.

• 

Oversampling: Oversampling can be useful to stabilise the filter at high
frequencies and reduce possible aliasing introduced by saturation. Note that an
oversampling factor of n also requires n times more CPU usage.

• 

28.3.4 EQ 5 & 10

EQ 5 is an equalizer which can amplify or attenuate up to five separate frequency
bands. The EQ 10 device functions identically to EQ 5, but is even more customisable
since it has double the amount of frequency bands and Q parameters. There are three
display modes available and you can switch between them using the menu at the
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top-right of the devices. You may find it useful to watch our video on Equalization,
which covers these two devices and the Mixer EQ.

The regular display uses sliders to adjust the volume level of the target frequency. This
frequency can be changed at the left of the slider, while the Q, which adjusts the width
of the frequency band, can be changed at the right.

In the graph display, each band can be changed by click-dragging the points around
with the left mouse button, while click-dragging up and down with the right mouse
button will change the Q. Holding down the "Left Ctrl/Cmnd" key allows for more
fine-tuned adjustments and holding "Left Shift" will lock changes to the volume level
only, while "Left Alt" will lock changes to the frequency.

The "Full Display" mode shows both the sliders and the graph, and also makes available
a powerful option for choosing how the EQ is processed in the stereo field. 'L+R' is the
default, which applies the EQ to both the left and right channels equally. The separate
'L' and 'R' modes will apply the EQ to either the left or right channels only. This can be
useful by itself, but also provides the opportunity to use two devices to EQ each side in
different ways.

The most common version of this though is to mirror the values, which is why the 'L-R'
mode allows you to do this with a single device. The EQ is applied normally on the left
channel and inversely on the right channel. With well chosen frequency bands this can
help give an instrument its own unique space in the mix. It can also create some
interesting spatial effects, especially when automated.

The volume scale of the graph, as shown along its left side, can be changed by clicking
on the small button  in the bottom-right corner. You can also completely reset the
effect here.
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28.3.5 Exciter

This enhances a signal through use of dynamic equalization, phase manipulation,
harmonic frequency synthesis and the addition of subtle harmonic distortion. It is
traditionally used as a mastering device for adding clarity and width to a mix.

Band Selector: Choose from High, Mid and Low frequency bands. Each band
has its own separate set of parameters to affect. The two value boxes
underneath the graph allow you to alter the frequency band values. Clicking and
dragging on the vertical lines within the graph will also do this.

• 

Band Mode: Choose from "Stereo", which affects both Left and Right channels
equally, or "Mid & Side", which allows you to independently affect the central and
side spatial ranges of the mix.

• 

(Mid/Side) Sharpness: Increasing this value will weigh the effect more to the
higher frequencies of the selected band.

• 

(Mid/Side) Amount: The general strength of the effect.• 

28.3.6 Mixer EQ

The Mixer EQ is a standard equalizer that has been designed to sound and behave like
a common DJ mixer, with an emphasis on ease of use. You may find it useful to watch
our video on Equalization, which covers the the Mixer EQ and the EQ 5 & 10 devices.

Low Gain: The volume gain applied broadly to lower frequencies.• 
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Mid Gain: The volume gain applied to the 'Mid Freq.' frequency.• 
Mid Freq.: The target frequency for the 'Mid Gain' parameter. Useful for
automating to create mid-range filter sweeps.

• 

Mid Q: The width of the frequency band around the 'Mid Freq.' target.• 
Hi Gain: The volume gain applied broadly to the higher frequencies.• 

L/R/L+R: The separate 'L' and 'R' modes will apply the changes to either the left
or right channels only, while 'L+R' applies the changes to both channels equally.

• 

 - The volume scale of the graph, as shown along its left side, can be changed
by clicking on the small button in the bottom-right corner. You can also
completely reset the effect here.

• 

28.4 Modulation Devices

Modulation Device use controllable oscillators to change certain characteristics of the
input waveform. The Chorus, Flanger and Phaser effects have a lot of similarities, both
in their parameters and in how modulation is used to alter the audio. With the Reset
button they also share one powerful method of controlling the modulation. You may
find it useful to watch our video about these three devices.

28.4.1 Chorus

The Chorus effect enriches the original sound by layering on differently pitched
duplicates of itself. This can be especially useful for providing warmth and depth to
simple wave shapes, as well as the usual vocal enhancements.

Rate: Frequency of the applied modulation.• 
Depth: The upper limit of the modulation's amplitude.• 
Feedback: Amount of output audio fed back into the device. Values below zero
use a negative version of the waveform.

• 

Delay: Delay before the modulated signal is applied.• 
Dry/Wet: Ratio of the clean and modulated signals, as a percentage.• 
Phase: Horizontal phase offset of the modulation. Only applied to the right
channel, creating stereo separation.

• 

Reset: Resets the position of the modulation back to the beginning. Renoise
Pattern Editor only: See below for more details on syncing modulation.

• 

Filter Type: Type of filter that is applied to the modulated signal.• 
Filter Options 1-3: Additional parameters that will change depending on the
type of filter used.

• 
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28.4.2 Flanger

The Flanger mixes two identical signals together, with one of them delayed by a small
and gradually changing amount. Mild settings can help to bulk up a sound, while larger
values lead to the familiar ‘wandering’ effect.

Amount: Modulated signal volume. Negative values will invert the signal.• 
Rate: Frequency of the applied modulation.• 
Amplitude: The upper limit of the modulation's amplitude.• 
Feedback: Amount of output audio fed back into the device. Values below zero
use a negative version of the waveform.

• 

Delay: Delay before the modulated signal is applied.• 
Phase: Horizontal phase offset of the modulation. Only applied to the right
channel, creating stereo separation.

• 

Reset: Resets the position of the modulation back to the beginning. Renoise
Pattern Editor only: See below for more details on syncing modulation.

• 

Filter Type: Type of filter that is applied to the modulated signal.• 
Filter Options 1-3: Additional parameters that will change depending on the
type of filter used.

• 

28.4.3 Phaser

The Phaser focuses on EQ, using a series of filters to insert peaks and troughs in the
frequency spectrum. The positions of these peaks and troughs are modulated to vary
over time, creating a sweeping sound.

Floor: Lower frequency boundary of the filter modulation.• 
Ceiling: Upper frequency boundary of the filter modulation.• 
Rate: Frequency of the applied modulation.• 
Feedback: Amount of output audio fed back into the device. Values below zero
use a negative version of the waveform.

• 

Depth: The upper limit of the modulation's amplitude.• 
Phase: Horizontal phase offset of the modulation. Only applied to the right
channel, creating stereo separation.

• 
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Reset: Resets the position of the modulation back to the beginning. Renoise
Pattern Editor only: See below for more details on syncing modulation.

• 

Stages: Number of filters applied. The more filters, the stronger the effect.• 

28.4.3.1 Syncing Modulation

The modulation runs constantly, even while the song is stopped, so to synchronise the
modulation's cycle to the song's playback, which will ensure it runs the same way each
time, you have to automate the "Reset" button. This is achieved by right-clicking on it,
which places a command in the current track's Master FX column, and can be done
while the song is stopped or during playback (this is for track effects, sample fx need to
be automated through macros). You can also control the position of the reset by
manually entering the effect command: x7yy, where x stands for the location of the
device in the effect chain (1 if it's the first device, 2 if it's the second etc.) and yy is the
offset value. For example, if yy is equal to:

00 - The modulation restarts from the beginning.• 
40 - The modulation restarts from a quarter of the way through the cycle.• 
80 - The modulation restarts from halfway through the cycle.• 
C0 - The modulation restarts from three quarters of the way through the cycle.• 
FF - The modulation restarts from just before the end.• 

28.4.4 Ringmod

Ring modulation simply takes the incoming audio signal and multiplies it by an
oscillating waveform, chosen from the four different shapes provided by the device.
Low frequency oscillations will just modulate the volume of the signal, while higher
frequencies will generate new tones and harmonics.

You may find it useful to watch our video on the Ringmod and Comb Filter effects.

Oscillator: The shape of the oscillator waveform that is applied.• 
Note & Transpose: The frequency of the oscillator. The parameters allow you
to 'tune' the oscillation to precise note values.

• 

Inertia: Determines how fast parameter changes are applied. Lower values
create sweeping effects, noticeably sliding from the old parameter setting
towards the new one.

• 

Dry/Wet: Ratio of the clean and modulated signals, as a percentage.• 
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28.5 Shape Devices

As the name suggests, these effects modify the shape of the waveform passing through
them. The Distortion and Cabinet Simulator devices focus on making changes to the
signal vertically, while the LofiMat applies restrictions to both the vertical and horizontal
planes. All three feature separate Dry and Wet Mix sliders for complete control over the
volume of the original and altered audio. You may find it useful to watch our Shape
Devices video.

28.5.1 Cabinet Simulator

The Cabinet Simulator recreates the sound of hardware amplification cabinets. While
obviously aimed at affecting guitar and bass instruments, it’s also great for adding
some analogue-style roughness to anything you’d like. The effect consists of three
components: a tube pre-amp controlled by the Gain slider to create distortion, an
equalizer at the right and the Cabinet itself which can be any of 18 different models.

Cabinet: Select the type of the Cabinet that will be used. There are bass, guitar
and various other models available.

• 

Routing: Set how the Cabinet Simulator will internally route the signal through
the cabinet, EQ and tube.

• 

Gain: Amount of Gain applied in the tube. More Gain will result in more
distortion.

• 

Wet/Dry Mix: Volume of the processed/original signal.• 
Mono/Stereo: When set to Mono, incoming stereo signals will be combined and
processed as a mono signal only. The Cabinet is twice as fast in Mono, so this
can be useful to save on CPU consumption if the input signal is mono.

• 

EQ: A standard EQ with 5 bands and Q settings. See EQ 5 for a detailed
description.

• 

28.5.2 Distortion

The Distortion effect is a versatile way of warping the input sound to produce a range of
characteristic distortion sounds, from traditional overdrive to bizarre sonic extremes.
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8x: Eight times oversampling. Helps reduce aliasing, but also uses a lot more
CPU power.

• 

Mode Type - Four buttons select the type of distortion:
Razor: Razor mode cuts off the top of the waveform by amplifying and
clamping the signal, also known as clipping. This gives the traditional
digital overdrive sound that is quite harsh and full in character.

♦ 

Shape: Similar to Razor mode, except that instead of clipping, the signal
is saturated. This results in a warmer sounding overdrive that emulates
analogue distortion.

♦ 

Fold: Instead of clipping or saturating, part of the waveform is folded back
towards the DC line, giving the waveform a slightly triangular shape. This
is an aggressive foldback type distortion that mangles the sound and
growls fiercely at high gain.

♦ 

Shift: Shift mode generates a new waveform from the original by folding
amplitudes below the DC line. The introduced DC offset is corrected by
shifting the signal. This is a noise-floor distortion with a very scratchy
sounding character.

♦ 

• 

Drive: Controls the amount of distortion. Depending on the selected mode,
different amounts of drive produce different sound characteristics.

• 

Tone: Controls a pre-filter for adjusting distortion colour. Values above 0% add
brightness to the sound, whereas values below 0% dull the sound.

• 

Wet/Dry Mix: Volume of the processed/original signal.• 

Tips and tricks

The Wet Mix will usually need to be reduced, depending on the amount of
distortion applied.

• 

Sometimes the distortion can sound too harsh or 'cold' - this can be countered by
adding a small amount of Dry Mix to add warmth.

• 

Extreme distortion can bring out a lot of harmonic overtones and high frequency
detail - sometimes not all of it is desired. This can be controlled with a Low Pass
Filter after the distortion effect.

• 

28.5.3 LofiMat

The LofiMat device degrades a signal's audio quality by lowering the bit-depth and
sample rate. At higher settings this functions as a bitcrusher, while a more gentle
application can be useful for generating new harmonics.

Bit Crunch: The applied bit-depth (the amount of vertical steps there are to
represent different volume levels).

• 

Rate: The applied sample rate (the amount of times per second that a separate
point of volume will be represented).

• 
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Noise: The amount of extra noise that will be added to the signal. The noise will
also be degraded by the Bit Crunch.

• 

Wet/Dry Mix: Volume of the processed/original signal.• 
Smooth: Located at the top right, this will enable smoothing of the waveform.• 

28.6 Tools Devices

The Tools Devices are a small set of utilities which are often useful to "correct" sounds.
You may find it useful to watch our videos on DC Offset and the Gainer & Stereo
Expander.

28.6.1 DC Offset

The DC Offset device allows you to shift the signal up and down on the DC line. It is
mainly used to correct unwanted DC offsets from signals.

DC Offset: Shift the signal up or down on the DC line by a set amount. Use the
Track Scopes to analyse the changes.

• 

Auto DC: When enabled, incorrect DC offsets will be automatically corrected by
the device.

• 

28.6.2 Gainer

The Gainer provides sliders to adjust the volume and panning of the audio signal, just
as the Pre and Post-Mixer devices do. Useful for making those changes at any position
in the effect chain.

Gain: Sets the volume level.• 
Panning: Sets the panning of the signal.• 
Inverse: Allows you to invert the phase of each channel separately. This should
mainly be used to correct wrongly inverted phases in recordings.

• 
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28.6.3 Stereo Expander

The Stereo Expander can adjust the spatial width of a sound by making changes to the
signal's phase across the stereo channels.

Expand: Enhances or reduces the differences between the left and right
channel. This will have no effect on a mono signal.

• 

Surround: Functions the same as the Pre-Mixer's Width parameter, controlling a
phasing inversion effect that's applied to the left stereo channel. At 100%, very
high frequencies are completely inverted, while lower frequencies are less
affected. Higher values tend to feel 'boxed-in'. Very effective for mono signals.

• 

Mono Mix: When using the Expand option with a negative value, this parameter
defines which part of the stereo signal will be retained. "L+R" will use the
average of both channels.

• 
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29 Meta Devices
Meta Devices are effects that do not directly manipulate audio, but instead modulate or
control other parameters. They can even be linked between different tracks/FX Chains,
making for complex and powerful routing possibilities.

Common usages for Meta Devices are applying modulations with the *LFO device or
*Signal Follower, controlling plugin instrument automation via the *Instrument
Automation device, or sending MIDI to plugins using the *Instrument MIDI Control
device. There are also devices which can use various real-time inputs (notes, velocity,
audio output etc.) to guide their behaviour, such as the *Key Tracker or *Velocity
Tracker. Finally, there are devices which can also be used to route and control other
meta or audio effect parameters via the *XY Pad and *Hydra.

29.1 Instrument Devices (Renoise only)

Track Effects: These devices are used to directly control an Instrument through its
Plugin and MIDI components or by automating instrument macros.
Sample FX: These devices are unavailable.

29.1.1 *Instrument Automation

Instead of working through MIDI, the Instrument Automation device sends parameter
changes to the Plugin component of an Instrument directly. The device automatically
populates itself with the selected Plugin's changeable parameters. Since every Plugin is
different, the number and function of those parameters can vary wildly. You may find it
useful to watch our short video.

Instrument: The targeted instrument, chosen from those available in the
Instrument Selector. If the instrument has no Plugin component the parameters
below will be blank.

• 

Parameters: Shows the selected parameter. Left-clicking will open a drop down
menu listing of all the Plugin's available parameters, allowing you to select and
use the one you need.

• 

Show/Hide Parameters: The small arrow buttons in the bottom-right corner
allow you to expand/shrink the device to show/hide parameters.

• 
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29.1.2 *Instrument Macros

This device provides a copy of the linked instrument's macro controls for altering the
assigned Modulation or Effects parameters of a linked instrument. The instrument's
Phrase can also be changed with the menu at the top right. You may find it useful to
watch our video on this subject.

Instr.: The targeted instrument, chosen from those available in the Instrument
Selector.

• 

Phrase: The instrument's currently selected Phrase.• 
MIDI Macros: A copy of the instrument's MIDI Controller macros.• 
Macros: A copy of the instrument's macro controls.• 

29.1.3 *Instrument MIDI Control

The MIDI Control device broadcasts MIDI pitch bend, channel pressure, control change
and program change commands directly to the Plugin and MIDI components of the
selected instrument. You may find it useful to watch our video on this subject.

Instrument: The targeted instrument, chosen from those available in the
Instrument Selector.

• 

Show/Hide Parameters: The small arrow buttons in the bottom-right corner
allow you to expand/shrink the device to show/hide parameters.

• 

All of the other sets of parameters work in exactly the same way with the following
options:

"Custom Name" for CC message types: Allows you to name a control change
parameter, describing what the CC number does. In addition to the standardised
Controller Change numbers, Plugin and MIDI instruments often have customised
sets of numbers and you'll typically find information about them in the
instrument's reference manual.

• 

On/Off for PB/CP/Prg, a number for CC: Toggles the parameter or specifies the
CC number that is sent.

• 
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MIDI Message Type: Can be PB (Pitch Bend), CP (Channel Pressure), CC
(Controller Change) or Prg (Program Change).

• 

Parameter Value: The actual value that is sent.• 

Affecting Samples

Normally this device only affects the Plugin and MIDI components of an instrument, but
it is possible to affect samples in a few different ways:

Program Change messages also affect the instrument’s Phrase.• 
If the instrument is purely sample-based then changing the volume, scale key
and scale mode via their CC numbers will adjust those parameters in the
Instrument Properties. If the instrument contains Plugin and/or MIDI components
though then the messages will be directed there instead. Scale & Key are
covered in-depth in our video.

• 

The MIDI controllers to the left of the on-screen keyboard are also automated by
any Pitch Bend, Channel Pressure or CC 01 messages, making it possible to
affect samples through their macros.

• 

Tips and Tricks

MIDI channel numbers are not set with this device; this is handled independently
in the instrument's Plugin and MIDI sections.

• 

By default, this device has only one preset, used to quickly start working with a
General MIDI instrument. But if you make use of this device a lot, then it'll be
worthwhile setting up and saving your own custom presets for your favourite
instruments.

• 

If you’re using ReWire with Renoise as the master, then this device can be used
to control the instruments of other applications.

• 

When a song is loaded that contains one or more Instrument MIDI Control
devices, they will immediately send out messages from all of the enabled
parameters. This is necessary to prepare the song for playing with the correct
settings, but it may not be ideal for your particular setup. In this case you should
use automation to initially start with the device disabled.

• 

29.2 Mapping Devices

Mapping devices handle parameter modulations across multiple inputs and outputs. As
with most effect parameters, the input values of these three devices can be changed
through a variety of methods. The user can perform the changes live, or the value can
be automated via Effect Commands, Graphical Automation or by another effect device.
It's this last option of cross-routing multiple effects that makes the Mapping devices so
powerful.

You may find it useful to watch our video on the Mapping Devices.
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29.2.1 *Formula

The Formula device generates an output value from user-created code and up to three
input values. The upper Code Box doesn't have to be used and is only needed when
programming more complex functions that will be called by the Formula below. The
language used is Lua. Pressing the Help button brings up the provided variables and
math functions.

Dest.: Destination track/FX Chain, effect and parameter, allowing you to specify
the parameter to be modulated.

• 

A/B/C Inputs: Inputs to be used in the formula. They can be renamed by
double-clicking on them, but they must still be referred to as capital A, B and C
when used as variables in your code.

• 

Hide/Show Code: Clicking the small arrow button will hide/show the panel
containing the Code Box and Formula.

• 

Help: Brings up a new window showing the available mathematical functions
and variables. The variables and constants must be written as capitals, while the
math functions must be lower-case.

• 

Code Box: More complex programming functions are coded here. If your code
(either in this box or the Formula) contains an error then the status above the
Code Box will show this. Clicking on the warning icon will bring up the full error
message.

• 

Formula: The formula to be calculated, potentially using the Inputs and any
functions called from the Code Box. A new calculation is performed every tick or
if an Input value is changed (and that Input is used in your code).

• 

29.2.2 *Hydra

The Hydra device allows the mapping of its Input value toward up to nine different
destinations.

Input: The input value.• 
Out 1-9: Each output has its own individual set of parameters:

Destination: The first set of three boxes are the destination track/FX
Chain, effect and parameter, allowing you to specify the parameter to be

♦ 
• 
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modulated.
Min/Max: The min/maximum value to be used from the destination
parameter's range.

♦ 

Scaling: The scaling that will be applied to the final output value. By
default, the value will be mapped linearly, but you can also select from
two exponential and two logarithmic scales.

♦ 

Show/Hide Parameters: The two small arrow buttons in the bottom-right
corner allow you to expand/shrink the device to show/hide parameters.

• 

29.2.3 *Meta Mixer

The Meta Mixer accepts input from up to three sources and combines them to create a
new output value, as represented by the meter at the far right.

Dest.: Destination track/FX Chain, effect and parameter, allowing you to specify
the parameter to be modulated.

• 

Min/Max: The min/maximum value to be used from the destination parameter's
range.

• 

Scaling: The scaling that will be applied to the final output value. By default, the
value will be mapped linearly, but you can also select from two exponential and
two logarithmic scales.

• 

Input A/B/C: The three input values used to create the output.• 
Weight A/B/C: Adjusts how much influence an Input has over the final output
value. Each Input's Weight relative to the others is represented by the graph at
the right.

• 

29.3 Modulation Devices

Modulation Devices, as the name suggests, modulate other effect parameters. They
can be triggered and synced by user input, Effect Commands, Graphical Automation,
velocity values and even note values and volume envelopes of audio data.

29.3.1 *Key Tracker

The Key Tracker device works in much the same way as the Velocity Tracker, except it
adjusts a parameter according to note value instead of velocity. As a track effect, input
values are only accepted from an instrument that is playing in the same track as the
Tracker device. When in a Sampler FX Chain values will be accepted from any track.
Also note that a sample does not have to be specifically routed through FX Chains in
order to trigger any Tracker devices within them.
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Input: The instrument/sample to be used for input.• 
Dest.: Destination track/FX Chain, effect and parameter, allowing you to specify
the parameter to be modulated.

• 

Dest. Min/Max: The min/maximum value to be used from the destination
parameter's range.

• 

Scaling: How the input value will be mapped across the chosen input Range. By
default, the input is mapped linearly, but you can also select from two
exponential and two logarithmic scales.

• 

Range: Minimum and maximum note range that will be used for input.• 

Range Modes

In addition to applying a scaling mode to the Key Tracker's range, you can also set up
how the range will handle notes:

Clamp: Each note within the range will trigger an event, while notes outside of
the range will be clamped to the specified limits.

• 

Soft: Notes outside of the range are completely ignored and will not trigger
anything.

• 

Octave: Notes played on different octaves will be handled equally, e.g. a C-5 will
have the same effect as a C-4 or C-3.

• 

29.3.2 *LFO

The Low Frequency Oscillator generates a signal that cycles through a relatively slow
pattern. The signal is constructed by applying the various parameters to a repeating
waveform, which can be chosen from four simple shapes or one customised by the
user.

LFO device using a preset waveform:

Dest.: Destination track/FX Chain, effect and parameter, allowing you to specify
the parameter to be modulated.

• 

Amplitude: The the maximum range that the value will oscillate to. 100% will
modulate the full range.

• 
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Offset: Offsets the central point of the modulation to a different position. The
effect of Amplitude & Offset on the original shape can be seen in the meters at
the far right.

• 

Frequency: The speed of the modulation in Lines per Cycle. For example, an
LPC of eight will cycle the LFO once every eight pattern lines.

• 

Reset: Resets the position of the LFO back to the beginning. Renoise Pattern
Editor only: See below for more details on syncing modulation.

• 

Modulation shape:
Sine wave♦ 
Sawtooth♦ 
Pulse/Square♦ 
Random♦ 
Custom: Allows you to draw a custom waveform. If you set the custom
wavelength to match the Frequency value, then one grid line becomes
equal to one line in the Pattern/Phrase Editor line.

♦ 

• 

LFO device using a custom waveform:

Envelope Type: Dictates how the envelope's value will change over time.
Points: Only changes value when a point is encountered.♦ 
Lines: Initially interpolates in a straight line, but the handles between
points can be used to create curves and control their easing.

♦ 

Curves: Interpolates with a smooth cubic curve, easing into and out of
points.

♦ 

• 

Envelope Size: Alters the length of the envelope by changing the amount of
grid lines.

• 

One Shot: When enabled, the envelope will run only once until a "Reset"
command is given.

• 

Ext. Editor: This will open the envelope waveform graphic in the large central
section of the interface, allowing for finer control over details. This provides
additional tools and the "Detach" button in the lower right hand corner. When
clicked, this will open the envelope in a completely separate window, which can
be moved around and resized. Clicking "Attach" will reattach the window to the
main interface. Clicking either the top right "X" or "Ext. Editor" button will
remove the larger editor.

• 

Presets: Right-clicking a button will store the current envelope as a preset. Left
clicking will recall a previously stored envelope.

• 

Syncing LFOs

The LFO runs constantly, even while the song is stopped, so to synchronise the
modulation's cycle to the song's playback, which will ensure it runs the same way each
time, you have to automate the "Reset" button. This is achieved by right-clicking on it,
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which places a command in the current track's Master FX column, and can be done
while the song is stopped or during playback (this is for track effects, sample fx need to
be automated through macros). You can also control the position of the reset by
manually entering the effect command: x8yy, where x stands for the location of the
device in the effect chain (1 if it's the first device, 2 if it's the second etc.) and yy is the
offset value. For example, if yy is equal to:

00 - The modulation restarts from the beginning.• 
40 - The modulation restarts from a quarter of the way through the cycle.• 
80 - The modulation restarts from halfway through the cycle.• 
C0 - The modulation restarts from three quarters of the way through the cycle.• 
FF - The modulation restarts from just before the end.• 

29.3.3 *Signal Follower

The Signal Follower measures the volume level at the location that it’s placed in a track
or Sampler FX Chain and then uses its controls to craft an output signal from that
volume input. The output is sent to a destination, which automates the chosen
parameter of the chosen effect. You may find it useful to watch our video about this
device.

Dest.: The destination track/FX Chain, effect and parameter to be modulated.• 
Dest. Min: The minimum value to be used from the range of the destination
parameter.

• 

Dest. Max: The maximum value to be used from the range of the destination
parameter.

• 

Dest. Off: Applies an offset to the destination parameter's min and max values.• 
Attack: The speed of the response to the input volume rising.• 
Release: The speed of the response to the input volume falling.• 
Sensitivity: Tunes the responsiveness of the device to the overall amplitude of
the input.

• 

Scaling: How the final output value will be mapped across its range. By default,
this is linear but there also two exponential and two logarithmic scales available.

• 

 - Listen to how the input is being affected by the LP and HP filters, providing a
better idea of exactly what the signal is that's working through this device.

• 

LP/HP Filter: Cutoff frequencies of the Low/HighPass filters applied to the input,
which restrict the frequency range that triggers the volume envelope.

• 

L/R/L+R: Select which of the stereo channels will be used for the input's volume
tracking: left (L), right (R) or both (L+R).

• 

Lookahead: Shifts the envelope back in time relative to the audio playback.
Useful to catch very snappy attack rates. Activating it will add some latency to
the device, and for it to work Automatic Plugin Delay Compensation must be
enabled.

• 
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Destination Limitation

Unlike the other Meta Devices the Destination cannot be a device that appears before
(to the left of) the Signal Follower, and this takes two forms.

When targeting the same track or Sampler FX Chain the device must be after the Signal
Follower. This is because effect chains are processed left to right, with each device
feeding into the next. Likewise, when targeting another track it must be to the right of
the track that the Signal Follower is in. Although tracks don't feed into each other,
unless you've set that up, Renoise and Redux do process everything in a strict order to
ensure maximum efficiency and as little latency as possible. This is the same for
Sampler FX Chains, except it’s applied vertically top-to-bottom.

So if you want to target a device that appears before the Signal Follower, then you'll
need to make changes so that this is no longer true, either by moving the devices
around, or reordering the tracks or Sampler FX Chains.

Tips & Tricks

The Signal Follower does not actually alter the signal it receives and so the audio
leaving this device will be the same as the input, regardless of what you do with
the filtering options or any of the others.

• 

The Destination device is usually in another track or Sampler FX Chain, since a
common reason for inserting a Signal Follower is for it to allow other elements of
a song to react to what the audio is doing at its location. You may have realised
that this is actually side-chaining, though obviously this is of the modulation
variety and we're not passing along the full audio signal.

• 

If you’re looking to use automation to control the general output of this device,
then the Dest. Off parameter is the best place to do it.

• 

The Sensitivity value applies an inverted gain to the input. At 100% the input
gain is reduced to 1/1000th of the original. So generally speaking, if the input is
very quiet then low values work best and higher values should be used for louder
inputs. But playing around with this value in conjunction with the Output
parameters (Min, Max, Offset & Scaling) is the best way to customise how the
Destination effect should be controlled.

• 

The volume meters at the right of the device are not simply the input and output
signals. The left meter shows the value that’s been created from the input once
it’s gone through the Input (Attack, Release & Sensitivity) and Filter sections,
while the meter on the right is the final value after it’s made its way through the
Output parameters.

• 

29.3.4 *Velocity Tracker

The Velocity Tracker adds another dimension of control by responding to the velocity
values of notes. For example, when modulating a Filter's cutoff value with a Velocity
device, the sound of an instrument can then be drastically altered by pressing the keys
harder or softer. As a track effect, input values are only accepted from an instrument
that is playing in the same track as the Tracker device. When in a Sampler FX Chain
values will be accepted from any track. Also note that a sample does not have to be
specifically routed through FX Chains in order to trigger any Tracker devices within
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them.

Input: The instrument/sample to be used for input.• 
Dest.: Destination track/FX Chain, effect and parameter, allowing you to specify
the parameter to be modulated.

• 

Dest. Min/Max: The min/maximum value to be used from the destination
parameter's range.

• 

Scaling: How the input value will be mapped across the chosen input Range. By
default, the input is mapped linearly, but you can also select from two
exponential and two logarithmic scales.

• 

Range: Minimum and maximum velocity range that will be used for input.• 

29.3.5 *XY Pad

The XY Pad allows simple movements and more complex gestures to change two
parameters at once. Unlike the other Meta devices, the focus here is on capturing live
performance by the user. You may find it useful to watch our video about this device.

X/Y Axis Setup: Switches between configuring the X and Y axis parameters.
Dest.: Destination track/FX Chain, effect and parameter, allowing you to
specify the parameter to be modulated.

♦ 

Dest. Min/Max: The minimum/maximum value to be used from the
destination parameter's range.

♦ 

Scaling: The scaling that will be applied to the final output value. By
default, the input will be mapped linearly, but you can also select from two
exponential and two logarithmic scales.

♦ 

• 

Auto Reset: Toggles whether releasing the mouse button on the XY pad will
cause the device to jump back to the specified values, much like an
auto-centring joystick.

• 

Show/Hide Parameters: The small arrow button next to the XY pad allows you
to show/hide the parameters.

• 
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30 Routing Devices
Routing Devices can send audio to a Send Track/FX Chain, receive a signal from an
external source, or sidechain audio from one track/fx chain to a device in another.

30.1 #Line Input

The #Line Input device can route inputs from your soundcard into Renoise/Redux, e.g.
microphone or line-in jack, allowing you to listen to an instrument directly. You can also
route to this device the audio from MIDI devices that have been triggered with Renoise.

Channel: When your soundcard offers more than one input, you can choose a
sub-channel here. The recording device is set up in the Audio Preferences.

• 

Input: The channel to be routed to this device (left, right or both). The level
meter to the right of the buttons displays the current input levels.

• 

Latency: (Renoise only) Select from "Live Recording Mode" for guitar, vocals
etc. or "MIDI Return Mode" for Renoise-triggered synths routed back into
Renoise. This will apply the appropriate amount of latency to the signal (see
Latency handling with External MIDI Instruments for a more in-depth
explanation).

• 

Panning: The panning of the input stream.• 
Volume: The gain of the input stream.• 

30.2 #ReWire Input (Renoise Only)

When running Renoise as the ReWire master, you can route other ReWire slave
applications into Renoise by using this device. A ReWire slave can be another audio
sequencer or a softsynth like VSampler or Kontakt. Once the device is selected and the
application is opened, both program's time-lines will be synchronised. If available, MIDI
inputs of ReWire devices will then show up as regular devices in the Renoise MIDI
panel, allowing you to automate and trigger the ReWire applications from Renoise.
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Device: The ReWire slave to be loaded into Renoise. After selecting a device,
many applications (e.g. Reason) will be auto-started. If this doesn't happen, then
just launch the program yourself and it should be automatically set as a slave to
Renoise.

• 

Channel: When the device has more than one audio channel available, you can
select it here. To route more than one channel from the same slave to Renoise,
simply use multiple #ReWire Input devices with the same "Device" setting.

• 

Input: The channel to be routed to Renoise (left, right or both). The level meter
to the right of the buttons displays the current input levels.

• 

Panning: The panning of the input stream.• 
Volume: The gain of the input stream.• 

30.3 #Send

You may find it useful to watch our video covering the subject of Send Tracks &
Devices.

Track Effects: A #Send device routes a track's output to a Send Track within Renoise.
By routing more than one track to the same Send Track, you can apply the same effect
chain to the audio from multiple tracks simultaneously. A Send Track can also make use
of a #Send device, so there are many possibilities available for complex routing.

Sample FX: The device works in the same way, but instead routes the audio to
another FX Chain.

Mode:
Mute Source: The signal is muted after it is routed to the Send Track/FX
Chain, meaning that the current track becomes silent and effects
appearing after the Send device in the chain will have no effect.

♦ 

Keep Source: The signal is routed to the Send Track/FX Chain and also
continues to play through the current track (see illustration below).

♦ 

• 

Apply post mixer volume & pan: (Renoise only) Use the track's Post Mixer
levels to control the send device.

• 

Amount: The volume of the signal sent to the Send Track/FX Chain.• 
Panning: The balance for how much of the left and right channels are sent to
the Send Track/FX Chain.

• 

Receiver: The Send Track/FX Chain that will receive the audio.• 

The picture below illustrates #Send device routing in the Renoise Mixer:
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30.4 #Multiband Send

A more advanced version of the standard #Send device, this allows you to split an
audio signal into three separate frequency bands and individually route them to
different Send Tracks/FX Chains. The "Amount" of each band, plus the "Low" and "High"
limits can be adjusted in the right-hand graph by left-click dragging the lines.

The volume scale of the graph at the right side of the device can be changed by
clicking on the small button in the bottom right corner:

Amount 1: The volume of the lower band signal sent to the Send Track/FX
Chain.

• 

Amount 2: The volume of the middle band signal sent to the Send Track/FX
Chain.

• 

Amount 3: The volume of the upper band signal sent to the Send Track/FX
Chain.

• 

Low: The upper frequency limit of the lower band.• 
High: The lower frequency limit of the upper band.• 
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Each Amount slider has two additional options to the right of it:

Mute/Keep Source: Determines whether the original signal is muted or
continues to play on the current track.

• 

Receiver: The Send Track/FX Chain that will receive the audio from this
frequency band.

• 

There are three additional controls under this:

Apply post mixer volume & pan: (Renoise only) Use the track's Post Mixer
levels to control the send device.

• 

Type: Changes the type of crossover filter used around the Low and High
frequency bands. There is a choice of three Linkwitz–Riley filters, a FastFIR and a
SteepFIR.

• 

Show/Hide Graph: Clicking the small arrow button will show/hide the graph at
the right side of the device.

• 

30.5 #Sidechain

You may find it useful to watch our video covering the subject of audio sidechaining.

The Sidechain device sends its audio signal to an effect that’s in a different track or FX
Chain. This allows the receiving effect’s behaviour to be controlled by an audio source
other than one that it’s actually processing. The Sidechain can only connect to effects
that explicitly allow it, as indicated by this icon  in the effect's top-right area, which
will change colour to indicate that a connection has been established. The available
native devices are the Compressor, the Bus Compressor and the Gate.

Mode:
Mute Source: The signal is muted after it is routed to the Receiver,
meaning that the current track becomes silent and effects appearing after
the Sidechain device will have no effect.

♦ 

Keep Source: The signal is routed to the Receiver and also continues to
play through the current track.

♦ 

• 

Amount: The volume of the signal sent to the Receiver.• 
Panning: The balance for how much of the left and right channels are sent to
the Receiver.

• 

Receiver: The track/FX Chain and effect device that will receive the audio signal.• 
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31 Doofers
Doofers enable the bundling of complex effect chains within a single device and provide
easy access to the most useful parameters through macros. Automating a macro will
change the values of all assigned parameters.

To begin crafting your own Doofer, add it to the effect chain then drag and drop
another effect into it on the right side of the device. You can keep adding as many
effects as you like this way.

To map effect parameters to a macro, click the  button to open the mappings list and
reveal any mappable parameters – they’re shown here as red, but the highlighted
colour may vary according to the current interface Theme. Clicking on a parameter will
add it to the list, where you can specify its Min/Max values and Scaling. Pressing the X
at the right will delete the mapping.

To rename a macro, just click on its name.• 
Once you've finished mapping, you may find it useful to minimize some or all of
the devices.

• 

If you need to add or remove macros, use the  and  buttons.• 
Toggling the  Edit button off closes the effect chain and prevents further
editing.

• 

Saving a Doofer as a preset will save it and all contained devices as a native effect. It
will be added to the effect list under the Doofers section, where you can add it to a
track just like you would with any other device. If you export the Doofer, you can share
it with other people - though of course if it contains any non-native plugins, then those
will need to be installed on their system as well.

You may find it useful to watch a short video on this subject.
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32 Plugin Effects
Plugin effects (VSTs on Windows, VSTs or Audio Units on MacOS, VSTs, LADSPAs or
DSSIs on Linux) can be added and used just like any of the other Effects in Renoise, but
you may have to configure them with the Plugin Compatibility Options. If you can't find
your plugins in the Effects list, then please have a look at the Plugin Preferences
section.

You may find it useful to watch our video covering both plugin instruments and effects.

32.1 Plugin Effect Layout and Options

Besides the usual effect controls, plugin effects may have a few extra options:

 - Show/Hide the plugin parameters.• 
 - Open the plugin's custom external editor.• 

 - Set up compatibility options for the plugin. Hovering the mouse over this
button will display some information about the plugin, such as latency, where the
file is loaded from etc.

• 

32.2 Plugin Compatibility Options
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This dialog will appear after clicking on the  button in the top-right corner of the
effect device. In most cases these options will already have the correct settings, as
Renoise comes with a database which sets the defaults for you. If you are experiencing
any of the problems described in the dialog, then you might want to try altering the
settings.

32.3 Plugin Effect Aliasing

Most plugin effect parameters can be controlled by Automation or through MIDI
Mapping. One of the things that cannot be changed by these methods though, is the
effect’s preset (or program). Nor will a plugin accept note data. By treating a plugin
effect like a plugin instrument though, these things are possible, and this is done by
creating an Effect Alias.

Just put the effect into the track you want to use it on, same as usual, then go to the
Plugin tab and select it from the FX alias list.
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Now you can use a MIDI controller or an *Instrument MIDI Control device to send MIDI
data to the effect and change the preset as a song is playing. Very few plugin effects
accept note data, but for those that do, you can now play and record notes to control
how the sound is being processed. The most common example of this are vocoders, but
it really just depends on the specific plugin and how it chooses to use incoming note
data.

You may find it useful to watch a short video on the subject.
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33 Graphical Automation
Automation is the recording and playback of parameter changes over time. A
parameter in this case is a Track Effects parameter, such as a Distortion's Drive or
Tone. Every effect device in Renoise can be automated, which can be achieved by two
separate methods: graphically or with Effect Commands. Automation of Plugin
instruments and their parameters is also possible by using an *Instr. Automation
Device.

The easiest way to create Automation is to record it. This can be done by clicking,
holding and moving a Track Effect's slider with the right mouse button while playing
back the song. Depending on the Automation setting in the Pattern Editor's Control
Panel , your changes will then be recorded as either Effect Commands or as
graphical envelopes.

To quickly create an empty Automation and switch over to the Automation Editor, you
can also click on the small rectangle to the right of each parameter. When a parameter
is automated, an icon is shown in this rectangle. In the image below, the icons next to
the parameters represent automation by (top to bottom): Effect Commands, envelopes,
both.

33.1 Automation

To open the Automation Editor, select its icon at the lower left corner of the Renoise
interface: 

The Automation Editor consists of two main parts. To the left you will see a list of all
available parameters and devices for the currently active track. To the right of this is
the envelope editor, where you will draw and edit the Automation. Beneath the
envelope editor are a series of options and buttons used to edit and modify the
envelope. You can expand the editor's vertical size by click-dragging the bar just above
it.

The envelope grid is labelled along the x-axis at the top with numbers that represent
time as the line-numbers of the Pattern Editor. The value range of the selected
parameter is represented along the y-axis.
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The Automation Editor will follow the progress of a song's playback as it playing. To
turn off this behaviour, allowing you to edit the automation of any pattern while a song
is playing, disable Pattern Follow mode in the Transport Panel.

33.1.1 Zoom Levels

You can zoom in and out of the Automation envelope by placing the mouse pointer over
the grid and scrolling the mouse wheel. The default zoom level is a single pattern, with
the x-axis showing the full range of the pattern's line-numbers. Zooming in you can
begin to see fractions of lines all the way down to 1/256th, allowing for incredible
resolution should you need it. Zooming out you can see individual patterns and
eventually the entire song. Pattern numbers are shown in an envelope's top left corner.
The pattern you are currently editing is highlighted, which you can change by clicking
on another.

When Lock is enabled, the zoom level is shown beneath the grid in the Automation
Toolbar and can be changed there too.

33.1.2 Creating Automation

To create an Automation point, select a parameter from the Automation List and then
double-left-click somewhere inside the grid. Alternatively, double-click on the
parameter, which will create an envelope and insert a point at line 0 with the
parameter's current value.

To create pre-defined patterns, right-click on the Automation grid area and expand the
"Process" option. There you can select the options "Create Random Points", "Create
Linear Curve", "Create Exponential Curve" and "Create Sine Curve".

When an Automation already exists for the current pattern, that parameter's name will
be highlighted in the Automation List.

33.1.3 Editing Automation Envelopes

Once you've created an Automation, it can be edited with the mouse or keyboard in
various ways:
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33.1.3.1 Editing with the Mouse

Double-clicking in the envelope where no point is set will create a new point.
Double-clicking on an existing point will remove it. If you click and hold on an existing
point then you can drag it around and set a new value. You can also use the Draw tool
located at the bottom left of the toolbar to manually draw in a waveform. If the Snap
mode is disabled, or is enabled and set to "Grid", then the waveform will be drawn at
the resolution of the current zoom level.

"Left Shift" + moving a point horizontally will remove all points that the mouse
pointer touches.

• 

"Left Control" + moving a point vertically will fine-tune its value. "Left Control" +
hovering over a point will display the point's value.

• 

Left-click and dragging across the grid will create a highlighted area. Any points within
this area will be selected and can be adjusted all at once. You can also use the
right-click menu on the grid to use the selected area in following ways:

33.1.3.2 Right-click Context Menu

Cut: Cut only the points contained within the selection area.• 
Copy: Copy the selection area.• 
Paste: Paste the previously copied points into the envelope from the cursor
position (left-clicking in the envelope will set the cursor position for pasting
operations).

• 

Paste Continuously: Paste the previously copied points into the envelope from
the cursor position and repeat until the end of the envelope.

• 

Insert Paste: Paste the previously copied points into the envelope from the
cursor position and move the rest of the envelope to right. Note that any points
shifted outside of the current pattern will be lost.

• 

Cut Selected Time: Cut the selected area of time from the envelope.• 
Delete Envelope: Delete the whole envelope.• 

Process: Applies to the entire envelope or the selected area if there is one.
Create Random Points: Creates points of random value.♦ 
Create Exponential Curve: Creates an exponential curve rising from 0
to 1. Use the flip buttons to achieve other curves.

♦ 

Create Linear Curve: Creates a linear curve rising from 0 to 1.♦ 
Create Sine Curve: Creates a single cycle sine curve.♦ 

• 

33.1.3.3 Editing with the Keyboard

If you middle-click on the envelope, or right-click and select "(Set Keyboard Focus
Here)", you can control the envelope with keyboard shortcuts:

To move the selection cursor in the envelope, use the left/right arrow keys or the
"Home" and "End" keys.

• 

To create a new point or remove an existing one, hit the "Enter" key.• 
To enter an exact value for a point in the numerical edit field, press "Left Shift +
Enter" and type in the value.

• 
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To select parts of the envelope, hold down the "Left Shift" key while moving the
cursor.

To cut the selection press "Left Control + X".♦ 
To copy the selection press "Left Control + C".♦ 
To paste the cut/copied selection, move the cursor to the desired position
and press "Left Control + V", or "Left Control + P" to paste continuously, or
"Left Control + I" to insert.

♦ 

"Left Control + K" will cut the selected area of time from the envelope.♦ 

• 

33.1.3.4 Tip For Smooth Pattern Transitions

To maintain a smooth envelope between two patterns, simply create a point in the
second pattern's envelope and move it to the beginning of the pattern. Now, as you
move the point up/down, it will automatically snap to the waveform of the previous
pattern.

33.1.4 Automation Controls And Options

Draw: Draw mode allows you to draw points on the envelope with the mouse.• 
Line: The Line tool allows you to create a linear ramp. This will be maintained
across multiple patterns.

• 

Snap: Will snap the horizontal creation and movement of points to:
The current resolution of the grid.♦ 
Every pattern-line.♦ 
Every beat.♦ 

• 

Value: The value of the selected point. Left-click to enter a new value.• 
Snap to Value: Lock and choose the zoom factor of the envelope view.• 
Envelope Type: Dictates how the envelope's value will change over time.

Points: Only changes value when a point is encountered.♦ 
Lines: Initially interpolates in a straight line, but the handles between
points can be used to create curves and control their easing.

♦ 

Curves: Interpolates with a smooth cubic curve, easing into and out of
points.

♦ 

• 

 - Cut the whole envelope.• 
 - Copy the whole envelope.• 
 - Paste the whole envelope.• 

 - User-configurable envelope presets. Right-clicking a button
will store the current envelope as a preset, left clicking will recall a previously
stored envelope.

• 

 - Move the envelope or selected points to the left/right. Will wrap around the
edges.

• 

 - Flip the envelope or selected points horizontally/vertically.• 
 - Humanizes the envelope or selected area by randomly adding or subtracting

a small amount to the point values.
• 
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33.1.5 Automation List

The list indicates which parameters are automated with a small icon next to their name.
Left-clicking on a parameter will select it, while double-clicking on a parameter which
has no Automation will create a new blank envelope.

Right-clicking on a name allows you to delete the Automation for the current pattern or
the whole song. This also applies when right-clicking on a device name, which will
delete the Automation for all of the effect's parameters.

The search field at the top of the list allows you to quickly find a parameter or effect.
Enabling the "Automated Only" button will only show effects in the list which are
already automated.

33.2 Master Track Extras

In addition to the usual effect parameters, the Master Track allows you to control three
additional native Renoise parameters via Automation: the song's Beats Per Minute,
Lines Per Beat and Ticks Per Line settings. Unlike other parameters though, these three
will only update once per line and points cannot be placed between the lines.
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34 Effect Commands
Effect Commands are used in the Pattern Editor and Phrase Editor to perform a variety
of tasks, from changing the volume of a single note, to automating the parameters of
Track Effects, or controlling the song during playback. They also allow various direct
manipulations of sample audio, which can only be done via Effect Commands and is a
major feature that differentiates trackers from other DAWs. Examples include: starting
the playback of a sample from the middle (S effect), then playing it in reverse (B
effect), panning it fully to the left (pan column), then retriggering the waveform at its
current position (R effect in the pan column) while simultaneously gliding to another
note one octave down (G effect). All this can be easily and precisely achieved with
Effect Commands.

You may find it useful to watch our 9-part "Effect Commands" video series, which
provides explanations and demonstrations on this subject.

34.1 Recording and Editing Effect Commands

Effect Commands are recorded in Edit Mode with the Tracker Interface, so if you're
unfamiliar with this method of working, you should read through that section of the
manual before continuing here.

Values are entered using the row of numbers above the letters on the keyboard, not
the number-pad, which is reserved for quickly switching between instruments in the
Instrument Selector. Entering a value will place it at that exact digit in the column. For
example, if you are at the first digit in the Volume column and press '4', the value will
become '40'. If you want the value to be '48', then move the cursor over to the second
digit using the arrow keys and press '8' there.

When recording an effect column value, the cursor automatically moves down to the
next line. If you want the cursor to advance to the right instead, hold "Left Shift" while
entering the values.
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34.1.1 Ticks

Many Effect Commands make use of 'ticks', so it's important to understand the concept.
Just as a pattern is split into a number of lines, so each line is split into a number of
Ticks. A tick is when an update is made to certain things if they makes changes over
the course of a line. The things affected are Effect Commands, interpolation between
points in Graphical Automation and meta devices such as the LFO. In Renoise, this tick
fraction is configurable with the Ticks Per Line parameter in the Song Options panel.

34.1.1.1 Ticks vs. Note Delays

As shown above, note columns have a delay sub-column, which lets you delay the note
to the left of it on the same line. These delays do not use ticks, but instead always
divide a line into 256 slices.

34.2 Effect Listing

xx and xy are place-holders whose meanings are explained in the Effect
Command descriptions. They should be replaced with values to create an effect.
xx means both digits are one whole value. xy means that the x and y are
separate values.

• 

All values shown below are hexadecimal.• 

Similar effect styles are highlighted with the same colour (e.g. pitch up, down
and glide are all red, though the exact colour depends on the current interface
Theme).

• 

When typing commands into the pattern/phrase, a helpful summary about them
will appear in the Lower Status Bar.

• 

The U, D, G, V, I, O, T and N commands will repeat the last valid value if a value
of 00 is used. This way you can quickly enter a series of commands without
having to continually type the exact value.

• 

You can use the small FX drop down menu as both a quick reference and an easy
method of inserting commands:  For phrases, this is found in the Phrase
Editor options. For the Pattern Editor, this is in the control panel the bottom of
the editor.

• 

We also have an Effect Command reference card available for download,
available in four different versions:

Screen 16:9♦ 
Screen A4♦ 
Print 16:9♦ 
Print A4♦ 

• 
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34.2.1 Local & Master FX Effect Columns

34.2.1.1 Sample Commands

These commands only apply to samples and will have no effect on the Plugin or MIDI
components of an Instrument. When used in the Master track, the effect will be applied
to all tracks.

-Axy - Set arpeggio, x/y = first/second note offset in semitones. Using 0 for x or y
will use the original note.

• 

-Uxx - Slide pitch up by xx 1/16ths of a semitone (01 is 1/16th of a semitone, 08
is half a semitone, 10 is a whole semitone).

• 

-Dxx - Slide pitch down by xx 1/16ths of a semitone (01 is 1/16th of a semitone,
08 is half a semitone, 10 is a whole semitone).

• 

-Gxx - Glide towards given note by xx 1/16ths of a semitone (01 is 1/16th of a
semitone, 08 is half a semitone, 10 is a whole semitone). A value of FF will make
the slide instant.

• 

-Vxy - Set vibrato (regular pitch variation), x = speed, y = depth.• 
-Ixx - Fade volume in by xx volume units (-I01 inserted 256 times will slide from
0 to full volume, -I7F inserted twice will do the same much faster).

• 

-Oxx - Fade volume out by xx volume units.• 
-Txy - Set tremolo (regular volume variation), x = speed, y = depth.• 
-Cxy - Cut volume to x after y ticks (x = volume factor: 0=0%, F=100%). Does
not stop playback.

• 

-Sxx - Trigger sample slice number xx or offset xx.• 
-Bxx - Play sample backwards (xx = 00) or forwards (xx = 01).• 
-Exx - Set the position of all active Envelope, AHDSR, Fader and Stepper
Modulation devices to offset xx.

• 

-Nxy - Set auto pan (regular pan variation), x = speed, y = depth.• 

34.2.1.2 Sample Command Variations (Renoise only)

A few commands will behave differently when used in the Pattern Editor to affect a
phrase:

-Sxx - Trigger phrase from line xx.• 
-Bxx - Play phrase backwards (xx = 00) or forwards (xx = 01).• 
-Ixx, -Oxx, -Txy - Will also affect the volume of any Plugin or MIDI playing in the
phrase.

• 

34.2.1.3 Instrument Commands

These commands will affect all of the sample, Plugin and MIDI components of an
Instrument. They can be used in the Master track to apply the effect to all tracks,
except for -Yxx and -Zxx.

-Mxx - Set channel volume level, 00 = -60dB, FF = +3dB.• 
-Zxx - Trigger phrase number xx (01 - 7E, 00 = no phrase, 7F = keymap mode).• 
-Qxx - Delay playback of the line by xx ticks (00 - TPL).• 
-Yxx - MaYbe trigger the line with probability xx. 00 = mutually exclusive mode• 
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(will trigger only one note on this line, where the chance of triggering is inserted
into the Local FX column, or the volume or panning column using Yx).
-Rxy - Retrigger instruments that are currently playing. This is done every y ticks
with volume factor x applied to each retrigger, where x represents:

0 - No volume change♦ 
1 - Lower volume by 3%♦ 
2 - Lower volume by 6%♦ 
3 - Lower volume by 12%♦ 
4 - Lower volume by 25%♦ 
5 - Lower volume by 50%♦ 
6 - Cumulatively lower volume by 33%♦ 
7 - Cumulatively lower volume by 50%♦ 
8 - No volume change♦ 
9 - Raise volume by 3%♦ 
A - Raise volume by 6%♦ 
B - Raise volume by 12%♦ 
C - Raise volume by 25%♦ 
D - Raise volume by 50%♦ 
E - Cumulatively raise volume by 50%♦ 
F - Cumulatively raise volume by 100%♦ 

• 

34.2.1.4 Device Commands

Only applies to the Renoise Pattern Editor. These commands specifically target the
track's effect devices.

-Lxx - Set track pre-mixer's volume level, 00 = -INF, FF = +3dB.• 
-Pxx - Set track pre-mixer's panning, 00 = full left, 80 = center, FF = full right.• 
-Wxx - Set track pre-mixer's surround width, 00 = off, FF = max.• 
-Xxx - Stop all notes and FX (-X00), or a specific effect (-Xxx, where xx > 00).• 
-Jxx - Set track's output routing to channel xx, 01 upwards = hardware channels,
FF downwards = parent groups (00 is the master track, 01 is the first soundcard
output channel and FF is the closest parent group track).

• 

You can also change any Track Effect parameter with Effect Commands by using the
first digit to target a specific device in the effect chain:

xyzz - x is the xth device in the effect chain, y is the yth parameter in the device.
For example: if you have a Distortion device as the first effect in the chain, then
13FF will set the Distortion's Tone parameter to the maximum value (1 =
Distortion device (the first effect), 3 = Tone (the third parameter), FF =
maximum value).

• 

You can also enable and disable specific effect devices with the following commands:

x000 - Turn effect x off.• 
x001 - Turn effect x on.• 

Moving a device's slider will also show the Effect Command in the Lower Status Bar.
Right-clicking a slider will automatically record the parameter changes into the track's
Master FX Column when pattern Automation recording mode is set record into the
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pattern.

34.2.1.5 Global Commands

Only applies to the Renoise Pattern Editor. These commands control the song during
playback.

ZTxx - Set tempo (BPM) (14 - FF, 00 = stop song)• 
ZLxx - Set Lines Per Beat (LPB) (01 - FF, 00 = stop song).• 
ZKxx - Set Ticks Per Line (TPL) (01 - 10).• 
ZGxx - Toggle song Groove on/off (00 = turn off, 01 or higher = turn on).• 
ZBxx - Break pattern. The current pattern finishes immediately and jumps to
next pattern at line xx (remember that although this value is hexadecimal
pattern lines are usually displayed as decimals).

• 

ZDxx - Delay (pause) pattern playback by xx lines.• 

34.2.2 Volume Column

00-7F - Set note volume/velocity where 00=minimum and 80=maximum. This
can also be used for polyphonic after-touch in VST/MIDI instruments that support
it.

• 

Ix - Volume fade in in the current note column, with step x*10 (I1 = -I10 in effect
column, I2 = -I20, etc.)

• 

Ox - Volume fade out in the current note column, with step x*10 (O1 = -O10, O2
= -O20, etc.)

• 

34.2.3 Panning Column

00-80 - Set panning of current note column: 00 = full left, 40 = center, 80 = full
right.

• 

Jx - Panning slide left with step x (0 - F).• 
Kx - Panning slide right with step x (0 - F).• 

34.2.4 Volume or Panning Column

Ux - Slide pitch up by x semitones.• 
Dx - Slide pitch down by x semitones.• 
Gx - Glide towards given note by x semitones. A value of F will make the slide
instant.

• 

Cx - Cut the note after x ticks (0 - F). Unlike -Cxy this stops playback (without
triggering a Note-Off) and will affect Plugin & MIDI.

• 

Bx - Play sample in the current note column backwards (0 is backwards, 1 is
forwards again).

• 

Qx - Delay a note by x ticks (0 - F).• 
Yx - MaYbe trigger note with probability x.• 
Rx - Retrigger a note every x ticks (0 - F).• 

Note: The panning/volume Rx version of retrigger does not restart the sample from the
beginning, while the -Rxy effect command does. This behaviour is intended to give you
a choice of two different retrigger modes.
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34.2.5 Delay Column

00-FF - The delay column can only be used to delay a note or Note-Off, where 00
is no delay and FF will result in the note being delayed until immediately before
the next line. For example:

40 - 25% delay♦ 
80 - 50% delay♦ 
C0 - 75% delay♦ 

• 

34.2.6 MIDI Commands

Renoise only. With Mx in the right-most panning column and a valid instrument number
next to it, you can send MIDI commands via Effect Commands in the format xxyy. For
example:

--- 0A M0 -17F -> Will send to the MIDI or Plugin instrument number 0A, a
controller change number of 1 and a value of 7F

M0 - Controller change message, xx = controller number, yy = controller value.• 
M1 - Pitch bend, xx = main value, yy = fine-tune value.• 
M2 - Program change, yy = program number (00 - 7F).• 
M3 - Channel pressure (monophonic after-touch), yy = pressure amount.• 

Note: Insert the Mx MIDI commands in the panning column of the right-most note
column. MIDI commands show a different syntax colour than when they function as
panning values and a -000 value is automatically filled in on the effect column.

Take care that you also add the instrument number, so that Renoise knows which MIDI
instrument the command will be targeting.

MIDI and plugin instruments can also be automated through *Instrument MIDI Control
or *Instrument Automation devices.

34.3 Entering Multiple Digit Values with the Computer
Keyboard

By default, when entering values with the computer keyboard, a single digit value will
be placed and the cursor will immediately move down within the Pattern Editor (by the
number of lines specified by the Edit Step). If you want to enter multiple digit values in
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a single line without this occurring, this can be achieved by holding down "Left Shift"
while entering the values. This works individually with the Volume, Panning, Delay and
each of the Effect columns.

34.4 Effect Examples

Some very basic sample command examples to get started:

34.4.1 Pitch Slide

1. Pitch slide up -Uxx: Sound file (mp3)

From line 00 to 07, the sample is pitched up at a constant rate of 20 (hexadecimal
notation), where 00 means "repeat the previous value".

2. Glide to note -Gxx: Sound file (mp3)

The first note is played at C-4. At line 04 the pitch rises at a constant rate of 20
(hexadecimal notation) towards A-4. Once the glide reaches reaches the desired pitch
of A-4, subsequent G commands are ignored.

34.4.2 Breakbeat Tricks
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1. Original Loop: Sound file (mp3)

2. Sample offset -Sxx: Sound file (mp3)

The offset command works by splitting a sample into 256 equal parts. The larger the
sample, the more inaccurate this command will be. As the range of values is 00 to FF,
-S80 plays the sample from halfway through and -S40 plays the sample from one
quarter of the way through.

3. Retrigger note Rx: Sound file (mp3)

This effect replays the sample very quickly at its current position in the waveform
playback. x sets how many ticks to count before retriggering the sample again. By
default, there are 12 ticks per line. Setting R4 will retrigger a sample 3 times per line
(12÷4=3).

4. Reverse sample B0, B1: Sound file (mp3)

B0 plays the sample backwards from that point. B1 resumes normal playback.

34.4.3 Programming Delays

Here are two techniques for programming a delay:
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1. Delay note Qx: Qx delays by ticks. A line is divided into equal ticks, the default
value being 12. By using the Q8 command in the volume or panning column, the note is
delayed by 8 ticks.

2. Using the Delay Column: The Delay Column divides a line into 256 equal parts
and so is much more precise than ticks. Use this column to get more accuracy.

34.5 Effect Commands Quick Reference Card

We also have an Effect Command reference card available for download, available in
four different versions:

Screen 16:9• 
Screen A4• 
Print 16:9• 
Print A4• 
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35 Mixer

The Mixer is opened with the Mix tab at the top left of the interface.

If you are familiar with hardware mixer consoles, the Mixer in Renoise will look familiar
to you. It provides a quick overview of all available tracks, Track Effects and output
levels. This is especially useful in the last production stage, when you are finished with
the main song structure and need to concentrate on polishing the final mix. The Mixer
also allows you to display a subset of track effect parameters which you can customise.
Using this, you can prepare your songs for live performance by showing only the
parameters you would like to concentrate on adjusting.

35.1 Detaching The Mixer

Near the top-right of the interface and to the left of the Scopes options is the  Detach
button, which opens the Mixer in a completely separate window that can be moved
around and resized. There are also additional buttons at the window's top right corner
for minimizing, maximizing and closing. Clicking  Attach will reattach the window to
the main interface.

Note that the Spectrum and Track Effects panels and buttons are moved to the Mixer
window when it’s detached.
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35.2 Pre/Post Volume and Panning Concept

Volume and panning controls in the Mixer can be set up to show two different levels:

Pre: Volume and panning levels which are applied after instrument playback, but
before Track Effects are applied.

• 

Post: Volume and panning levels which are applied after all Track Effects are
applied. This is the final sound leaving the track and being fed into the Master
Track.

• 

The idea behind the Pre/Post mix separation is that you should use the Pre levels while
composing the song. Automation, like the fade-in of tracks, should be applied here or
with a Gainer Device. Post volume and panning levels cannot be automated and should
only be used in the final mixing stage to balance the mix.

35.3 Customizing the Mixer Layout

At the right side of the Mixer you will notice a set of buttons that allow you to show/hide
to some of the components:

 - Parameter labels above effect sliders.• 
 - Mute and solo track controls.• 
 - Panning sliders.• 

 - VU meters and main volume faders.
• 

 - Volume edit box.• 
 - Custom track delays. Entering a negative value will play the track before

others, while a positive value will play it after. This is only available for regular
Tracks. This can be useful to compensate small latency problems with MIDI and
plugin based tracks.

• 

 - Audio routing control. Audio routing defines where the track's final output
will be sent to. Selecting "Master" will send the output to the Master Track and
through its effect chain. Selecting a dedicated output of your soundcard will
bypass the Master Track, allowing you to separate and mix Renoise tracks with
an external mixer console. This is only possible if your soundcard allows the use
of multiple channels. To make use of this feature on Windows, you have to use
ASIO; on Linux, Jack Audio.

• 

Track colours can be shown or hidden in the Mixer as well. Right-click anywhere in the
Mixer effect chain section and select, "Show Track Colors".
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35.4 Working with Effects and Chains

Track Effects devices are shown in the Mixer rack above the track levels. Right-clicking
an effect brings up a set of options for both that specific effect and the whole chain. To
show/hide particular effect parameters, right-click on the effect and choose them from
the "Show Sliders" menu option.

35.5 Send Devices/Tracks and the Post Mixer

To route a track into a Send Track, a #Send device is inserted into the original track.
For a full explanation of how this works, see #Send device in the Routing Devices
section of the manual. In the Mixer, the #Send device's slider controls the amount of
audio that is sent to the send track.

When #Send devices use the "Mute Source" option, the post volume and panning levels
will have no effect. That's because the signal is muted before it reaches post-mixer
device. To change the track's levels in this case, you either have to have to adjust the
#Send device's sliders or use the receiving Send Track's volume and panning levels.

To visualize this in the mixer, track levels which do not reach the Post volume and
panning are shown by a different colour (white by default instead of green, but this may
vary depending on the current interface Theme):
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(Track with a Send Device using Mute Source)

(Send Device Routing in the Mixer)

35.6 Adjusting Level Meters

To disable or change the scaling for all meters, right-click on any level meter in the
mixer and choose from the list. This also works for the master level meter at the top of
the Renoise interface.
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35.7 Controlling the Mixer with a MIDI Controller

You can attach MIDI controllers to the Pre/Post volume and mute/solo controls, allowing
you to comfortably mix a song using the controller. To do so, select "View -> Midi
Mapping…" from the main menu or click on the "MIDI Map" button at the top of the
Renoise interface, next to the main VU meter.

Have a look at the MIDI Mapping section of the manual for a more detailed description
of the available features.

35.8 Drag and Drop, Copy and Paste

To copy an effect from one track to the another, simply click and drag it to a new place.
Holding "Left Control" while dropping the effect will create a copy of the device. The
standard cut/copy/paste commands also work in the Mixer ("Left Control + X", "Left
Control + C", "Left Control + V").

Note: Copying or moving an effect from one track to another will not move device's
Automation(s) as well. When moving a device, the original Automation(s) will be
removed.
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36 Render Song to Audio File
Rendering your song to an audio file is usually the last step to take when you've
finished creating your music, but it can also be use to export sections of a song,
perhaps to be reused in another composition, or even for post-processing in other
multi-track editors by rendering each track to a separate file. Renoise does not directly
render .mp3 files, only uncompressed .wav files. However, those .wav files can then be
easily converted to .mp3 with free external applications.

You can also quickly render, resample and reuse parts of the song from within the
Pattern Editor.

36.1 Opening the Render Dialog

You can open the Render dialog by either clicking the "Render" button in the Disk
Browser with the "Song" category selected, or by using the main menu option: "File ->
Render Song To Disk...".

36.1.1 Part to Render

This specifies which part of the song you want to render. Note that muted tracks and
columns are never rendered by Renoise, making it easy to exclude tracks/columns you
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don't want to export.

Entire Song: Renders the entire song.• 
Selection in Sequence: Render only a selected pattern range from the Pattern
Sequencer. You can also select this range in the Pattern Sequencer directly by
using the Pattern Sequencer's context menu: "Render Sequence Selection To
Sample...".

• 

Selection in Pattern: Renders only the area selected in the current pattern
(see Render & Resample Parts of the Song). This can also be quickly done using
the Pattern Editor's context menu: "Render Selection To Sample...".

• 

36.1.2 Destination

This determines where the .wav file will be saved and under which name. Hitting the
"Browse" button will prompt you to select the folder where you would like the rendered
files to be saved. Enter the name of the file in the text field under the "Browse" button.
The destination file(s) will always be standard .wav audio files.

Use automatic file naming: Will name the saved render(s) automatically.
Clicking the drop-down menu that appears to the right will show the various
commands which can be inserted into the naming scheme. Clicking on an option
will place that text at the end of the existing command.

• 

Reveal in Explorer when rendering finished: Will automatically open the
Destination folder upon completion of rendering.

• 

36.1.3 Render Mode

Rendering Offline is faster, more accurate and allows more options. Rendering in
real-time will simply play the song and record the output, which also allows the
recording of Line-In Devices and MIDI instruments that play in real-time. Some plug-in
instruments and effects may render incorrectly when running faster than real-time, so
use this mode for those occasions.

36.1.4 Render Options

Priority: Select the priority of the rendering process. "Low" will leave plenty of
CPU power for other tasks, while "High" will use as much CPU power as possible.

• 

Interpolation: Choose the re-sampling quality that will be used in the rendering
process. "Default" is what you've heard during composing and playback.
"Precise" gives the best possible sample quality by running Cubic and Sinc
interpolated samples in more precise, non-lookup table based HQ modes, which
can remove a bit of interpolation noise (mostly inaudible below 96dB) without
changing the character of the sound.

• 

Sample Rate: Select a sample rate for the rendering process. By default, the
currently active sample rate is selected and it is recommended to use this. Many
DSP effects may sound slightly different at other rates, so changing the rate
could result in a slightly different sound from what you expect. Some external
VST or AU plugins don't even support sample rate changes, so if you change the

• 
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rate to something other than the default, make sure to listen back to the
rendered result to ensure that everything is correct. Alternatively, play back your
song in Renoise using the different rate first and fine-tune the song when
needed. This can be done by changing the sample rate in the "Edit ->
Preferences -> Audio" tab.

Bit Depth - Choose the bit-depth of the rendered file. Renoise internally renders
in 32-bit float, the highest quality, so you should use this format when you plan
to reuse the rendered song in other applications. CDs use 16-bit with a sample
rate of 44,100 kHz, so you can choose to render in this format for burning songs
directly to CD (bear in mind the potential issues with changing your default
sample rate as noted above, though).

• 

Save each track into a separate file: When enabled, the song will not be
rendered into a single file, but instead will create one file per track. This can be
useful if you want to export loops (when used in conjunction with "Selection in
Sequence/Pattern") or to post-process the tracks in an external multi-track audio
editor. Note that completely silent tracks will be deleted at the end of the
rendering process.

• 

Save each pattern into a separate file: When enabled, this creates new files
for every single position in the Pattern Sequencer (not just one copy of each
numbered pattern). This is extremely useful to quickly cut and export your song
as a set of loops.

• 

36.1.5 Hidden Rendering Feature

Sequence marker positions: When rendering your song, all of the Renoise
sequence positions are written into the .wav file, giving you markers to easily cut
up your work in external editors. The markers may also be useful to developers
who can use them with their own internal play routines to trigger playback from
any sequence position.

• 

36.2 Quickly Rendering Parts Of A Song

It's also possible to render only small parts of a song from within the Pattern Editor,
perhaps for generating new samples or to grab sections which require a lot of CPU
power when played normally. To do this, select one or more lines in the Pattern Editor,
then right click (on the Pattern Editor) and select "Render To Sample" from the context
menu. Alternatively, you can use the shortcut "Left Control/Command + Alt + Shift +
R". The newly created sample will be loaded into the next free instrument slot.

If you want to create sample-based instruments from plugin instruments, you can use a
dedicated function in Renoise to do so. See Render or Freeze Plugin Instruments to
Samples for more information.
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37 Quickly Rendering Parts of the Song
By using the Render Dialog in Renoise, you can already quickly and comfortably render
the whole song as an audio file. But it's also possible to render only small parts for
generating new samples, or to render down parts of the song which require a lot of CPU
power. To do this, select one or more lines within the Pattern Editor, then right click on
the Pattern Editor and select "Render To Sample" from the context menu. Alternatively,
you can use the shortcut "Left Control/Command + Alt + Shift + R". The newly created
sample will be loaded into the next free instrument slot.

If you want to create sample-based instruments from plugin instruments, you can use a
dedicated function in Renoise to do so. See Render or Freeze Plugin Instruments to
Samples for more information.
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38 Render/Freeze Plugin Instruments to Samples
The Plugin Grabber allows you to create sample-based instruments out of any plugin
based instrument (VSTi/Audio Unit). You can also quickly render and replace (freeze) a
plugin instrument this way.

Replacing a plugin with samples has advantages:

When sharing your Renoise .xrns song file, your song can be opened and played
back on any computer with Renoise, without the need for the plugin to be
installed.

• 

Sample-based instruments always use less CPU power than plugins, because
samples can be played back and pitched instead of being synthesized and
generated on the fly.

• 

When not replacing, but creating new instruments with the grabber, you can
quickly sample your favorite synthesizer sounds and create a small sample
library for later processing and sound mangling. Samples in Renoise also can be
manipulated in many ways that plugins cannot. For example, you can control the
playback pitch, direction and offset at any time in the pattern with the Effect
Commands.

• 

Replacing a plugin with samples also has disadvantages:

Automation of plugin synthesizer parameters with an *Instr. Automation Device
will only work with the original plugin. The Automation can no longer be applied
to the rendered samples.

• 

Samples are limited in length. Even though you can apply cross-fading to create
smooth loops in Renoise with the grabber, such automatic loops may not always
sound as detailed as the original.

• 

You may find it useful to watch our video on the subject

38.1 Opening the Plugin Grabber Dialog

To directly sample and then replace a plugin instrument, you can use the Plugin
Grabber in the Plugin section. Left-clicking the Render To Samples button will set the
grabber to replace the plugin instrument (render the plugin and then unload it).
Right-clicking will set the grabber to render the plugin into a new instrument slot.

Alternatively, you can right-click the plugin instrument in the Instrument Selector and
then choose "Render Plugin To Instrument..." or "Render Plugin To New Instrument...".

Finally, you can also bring up the grabber by selecting "File -> Render Plugin To
Instrument..." from the main menu.
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38.1.1 Instrument Selection

Source: The plugin to be rendered. Only plugin instruments that can be grabbed
will show in the list. Plugin instrument and effect aliases cannot be grabbed and
so will not be listed.

• 

Destination: Where the resulting samples will be placed after rendering.
"Current instrument" will overwrite the actual source instrument.

• 

Remove the source plugin after rendering: When enabled, the plugin will be
unloaded after the rendering has finished. Unloading the plugin can be undone,
just like any other operation, with "Left Control + Z".

• 

Note: These options will be set up for you automatically when either clicking the record
button in the Waveform section of the Sampler or launching the plugin grabber from
the Instrument Selector. You still can change the settings after a rendering, so you can
record a batch of instruments without opening and closing the dialog.

38.1.2 MIDI Options

Note Range: The note range to be rendered. This and the "Step" option define
how many samples will be created in the resulting instrument. When more than
one sample is rendered, a multi-sample instrument will be created. "Set From
Song" will parse your song and automatically fill in the range, using the lowest
played note as the lower boundary and the highest played note as upper
boundary.

• 

Step: How many samples will be rendered in the "Note Range". Setting this to 1
will individually render every single note. Setting this to 12 will render one

• 
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sample per octave. The more samples are rendered, the closer the rendered
result will be to the original.
Velocity Range: The Note-On velocity that will be used to trigger the
instrument when sampling it. Plugins may modulate some of their settings
depending on the velocity.

• 

Step: How many samples will be rendered in the "Velocity Range". Setting this
to 1 will render only a single sample for the entire velocity range. The more
samples are rendered, the closer the rendered result will be to the original.

• 

38.1.3 Sampling Options

Auto-loop samples (cross-fade): When enabled, the sample is cross-faded
and looped. Cross-fading creates a smooth, click-free loop and so is incredibly
useful for pads or other long sounds. Enabling cross-fading will also disable the
"Tail" (Note OFF) settings below.

• 

Duration: The duration in milliseconds of the Note-On phase, before a Note OFF
is sent to the plugin. With cross-fading enabled, this will be the total length of the
sample. Entering a number into the right value box and hitting "Set" will apply
the correct length calculated from the line duration.

• 

Tail: How long the Note OFF phase will last. This is needed to sample the sustain
phase of plugin instruments. Entering a number into the right value box and
hitting "Set" will apply the correct length calculated from the line duration.

• 

Fadeout Tail: When enabled, the tail/sustain phases of the samples are cleanly
faded out to zero.

• 

38.1.4 Sampling Format

Bit depth: The destination format of all rendered samples. 32-bit will create the
highest quality files, but also the largest in terms of file size. 16 or 24 are good
alternative bit depths, which still sound excellent and create smaller files.

• 

Channels: Allows the option of forcing the rendering to take place in stereo or
mono.

• 
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39 Template Song

39.1 Template Song

A Template Song is a special song file used as the initial document when Renoise is
launched or when creating a new song. By default, a new song is completely blank.
However, if you would like new songs to be created with a specific set of tracks, DSP
effects, instruments, MIDI mappings etc. then you can create such a base song and
save it as a template by selecting "File -> Save As Template Song" from the menu
options in the Upper Status Bar.

To delete the template, making new songs blank again, choose "File -> Delete
Template Song". It’s also possible to bypass the Template Song and use a blank one
instead, without having to delete the template, by selecting "File -> New Song (no
Template)".

You may find it useful to watch a short video on this subject.
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40 MIDI Mapping
With MIDI Mapping you can remotely control Renoise from your external MIDI controller
or master keyboard. Nearly everything you can do in Renoise with the mouse or the
keyboard can also be done from an external MIDI controller.

MIDI mappings are saved along with your song, unlike the keyboard mappings in the
Preferences, allowing you to create unique MIDI mapping sessions for every song and
also share the settings by either using Template Songs or by importing/exporting
common MIDI mappings in the MIDI dialog (see below).

Renoise will never automatically detect your MIDI controller and configure the
mappings for you. You have to manually (at least once for a Template Song) set up the
controller.

40.1 MIDI Device Setup

First make sure Renoise knows which device you want to use for MIDI mapping by
setting it in the "Edit -> Preferences -> MIDI" panel.

40.2 Opening the MIDI Mapping Dialog

The MIDI Mapping dialog box can be opened with the "Options -> MIDI Mapping..."
option in the main menu (or by pressing "Left Control/Command + M"). It can also be
opened by clicking the  button to the right of the VU meters at the top of the
Renoise interface.

Next to the "MIDI Map" button you will also find two small LEDs which show the MIDI
input/output that Renoise receives/sends. If you are in doubt about whether your MIDI
controller is set up and connected correctly to Renoise, then watch the green LED
(input), which should blink when you use the controller.

Left: MIDI Clock (if enabled in the MIDI Preferences)• 
Right: General MIDI input and output• 

40.3 The MIDI Mapping Dialog at a Glance
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Learn Mode:
Highlights all the parts of Renoise available for MIDI Mapping (see image
below). Select a highlighted button or parameter, then press a key or
move a controller to assign.

♦ 

When clicked, "Learn Mode" will become "Test Mode", which allows you to
test out what you've just mapped without having to close the MIDI
Mapping dialog.

♦ 

• 

Available & Active Mappings: Clicking the arrow will unfold a list of the
currently available and active mappings.

• 

Selected parameter: Displays the currently mapped parameter in Renoise.
Channel: The MIDI channel currently mapped from your controller.♦ 
CC No: The CC number currently mapped from your controller.♦ 
CC Type: The type of MIDI CC controller.

Absolute 7 bit: Use the CC value as an absolute value.◊ 
Relative signed bit: Increase at [065 - 127], decrease at [001 -
063].

◊ 

Relative signed bit 2: Increase at [001 - 063], decrease at [065 -
127].

◊ 

Relative bin offset: Increase at [065 - 127], decrease at [063 -
000].

◊ 

Relative two's comp: Increase at [001 - 64], decrease at [127 -
065].

◊ 

♦ 

Min: When mapping, for example, a MIDI fader or encoder to an effect
parameter in Renoise, this allows you to set up the lower boundary of the
controller.

♦ 

Max: This allows you to set up the upper boundary of the controller in
Renoise. Tip: Swap min and max values to reverse the controller.

♦ 

• 

Prefer 'Setting' instead of 'Toggling' On/Off states: Specify how the
controller should change things that are turned On/Off in Renoise. See Set,
Trigger and Toggle Mappings for a detailed description.

• 

Allow mapping the same Note/CC more than once: When enabled, you can
assign the same controller button or fader (the same MIDI message) to multiple
things in Renoise. As an example, this could be used for cross-fades of two track
volume parameters.

• 
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Record MIDI mapped parameters to automation: When enabled, any
parameter changes you make with the MIDI controller will be recorded into either
the Pattern Editor or Automation Editor. This only applies when Edit Mode is
enabled.

• 

Note that the highlighted colour may vary according to the current interface Theme.

40.4 Create Mappings

Click on a highlighted parameter or button.• 

Send MIDI from your controller (press a key, push a button, move a fader etc.)• 
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Renoise will automatically map the selected parameter to the chosen key/button/fader
of the controller.

Note: When using endless encoders, which may send one of the relative CC modes
noted above, slowly turn it to the left in order to map it. This allows Renoise to estimate
how the encoder works (guess the relative CC modes) and stop you from having to
keep manually resetting the mode.

40.5 Remove Mappings

To remove a mapping, open the MIDI Mapping dialog and click on the mapped part of
the Renoise GUI. Then hit the Backspace or Delete key on your keyboard. Alternatively,
press the "Clear" button next to the parameter description:

To clear all of the mapped parameters, click the "Clear" button at the top of the dialog
(next to the "Load" and "Save" buttons).

40.6 Import/Export Mappings

If you want to share MIDI mappings you've set up, you can do so by importing/exporting
them. To export, click on the "Save" button at the top of the dialog. This will prompt
you for a file name and a location to save the mappings to. Exported settings can be
imported by clicking the "Load" button and selecting a file.

Note that Renoise will not import/export parameter mappings as these are specific to
Track Effects and so will be completely different for every song. What is
imported/exported though, are the parameters found under "Global Mappings" in the
"Available and active mappings" list, such as Start/Stop, select/trigger sequences etc.

If you want to repeatedly use the same mappings for your songs, then it might be
useful to create a Template Song. Because all mappings are saved with a song, you can
set up your favourite mappings in a blank song and save this as a template, enabling
them by default for every new song.
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40.7 Set, Trigger and Toggle Mappings

The list of "Available and active mappings" shows you all the possible parameters and
functions that can be mapped in Renoise. This list contains far more entries than what
is shown highlighted in the GUI. For example, there are mappings to select the
currently active track, to control the selected Track Effects and much, much more.

Further, many things can be mapped in more than one way. Note the postfix of the
mapping names in the list: [Trigger], [Toggle] or [Set].

[Trigger]: Whenever your controller sends a command to Renoise, ignoring any
values or states from the MIDI messages. This is, for example, used for things
like "Start Playing" or "Stop Playing".

• 

[Toggle]: Allows the controller to only change an On/Off value, ignoring any
values or states from the MIDI messages.

• 

[Set]: Allows the controller to specify exactly when something is On or Off,
giving it total control.

• 

To understand the difference between [Toggle] and [Set] better, let's take a look at
what commands MIDI controllers may send out. Here is an example for a button that
sends a MIDI controller change message:
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A)
Button Pressed: Controller with Value 127 (or something above 64) is sent.
Button Released: Controller with Value 0 (or something below 64) is sent.
Button Pressed again: Same as before.
Button Released again: Same as before.

B)
Button Pressed: Controller with Value 127 (or something above 64).
Button Released: Nothing.
Button Pressed again: Controller with Value 0.
Button Released again: Nothing.

C)
Button Pressed: Controller with Value 127 (or something above 64).
Button Released: Nothing.
Button Pressed again: Controller with Value 127 is sent again.
Button Released again: Nothing.

Some controllers may use use protocol A, others B or C, or even other non-listed
combinations. Renoise needs to deal with all of these possibilities, which is why the
[Toggle] and [Set] options exist.

Now let's say you want to set something On or Off in Renoise. You have to tell Renoise
how it should deal with the incoming messages. Take the global "Edit Mode" as an
example, where there exists two variants for it in the list of available MIDI mappings:

Edit Mode [Toggle]: Will ignore Controller Values of 0, so you can use
controller protocol A or C.

• 

Edit Mode [Set]: Will not ignore Controller Values of 0, but will instead interpret
them as "state": CC value > 64 On, CC value < 64 Off, so you can use controller
protocol B with encoders or faders.

• 

If you are unsure what the right mode is for your controller, simply try out both
variants. If this works, then select that variant for the other mappings, because it's very
likely that the controller sends MIDI in the same manner for the other buttons too. Note
that Renoise will always choose the [Toggle] variant when executing MIDI "Learn
Mode".

To automatically choose [Set] or [Toggle]:

When clicking on something in the Renoise GUI to create mappings, the "Prefer
'Setting' instead of 'Toggling' On/Off states" option in the MIDI mapping dialog defines
which mappings should be used for your controller. [Set] will be selected when the
option is enabled, otherwise [Toggle] is used. This way you only have to decide which
type of mapping you want and can quickly create the mapping without using the
"Available And Active Mappings" list.
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40.8 Dynamic Mappings

The list of "Available and active mappings" shows you all the possible parameters and
functions that can be mapped in Renoise. This list contains far more entries than what
is shown highlighted in the GUI. For example:

40.8.1 Selected Track Mappings

Global Mappings/Navigation/Tracks: Allows you to switch over to the next or
previous track in Renoise.

• 

Global Mappings/Track Muting/Current Track: Allows you to mute/unmute
the currently selected track.

• 

Global Mappings/Track Levels/Volume/Current Track: Allows you to control
the volume of the current track.

• 

Global Mappings/Track Levels/Panning/Current Track: Allows you to
control the panning of the current track.

• 

Using this you can control every track in a song with just a few buttons and faders on
your controller.

40.8.2 Selected DSP FX Mapping

The same is also possible for DSP Effects:

Global Mappings/Navigation/Track DSPs/Select: Mapping the selection of
DSP effects.

• 

Global Mappings/Track DSPs/Selected FX/Parameter #XX: Controlling up
to 32 DSP effect parameters.

• 

Global Mappings/Track DSPs/Selected FX (Mixer Subset)/Parameter
#XX: Controlling up to 32 DSP effect parameters in the Mixer.

• 

When using the "Selected FX (Mixer Subset)" mappings, only the DSP effect parameters
which are seen in the Mixer can be controlled. This allows you to customise which
parameters are seen (right-click on the FX in the Mixer and choose a parameter from
the "Show Sliders" option) and controlled, so you can quickly and easily navigate
through a small subset of parameters during a live performance.

40.8.3 Sequencer Navigation & Triggering

Just like the track and effects, the sequencer can be also be controlled in a dynamic
manner. Feel free to explore this on your own, using the above information as a guide.

40.9 The Duplex Tool

Renoise Tools are downloadable packages that extend the functionality of the program,
using the Renoise Scripting API. Created with this, Duplex is a flexible system for using
external controllers in Renoise. When you install Duplex, each supported device has a
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number of configurations that control important Renoise parameters like the Mixer,
Matrix or Effects. You can combine these so-called 'applications' to form your own,
unique mix of features. For example, some pre-installed device configurations have
entries like 'Mixer+Effect'.

You can download and find more information about the Duplex Tool at its page in the
Renoise Tools section of the site.
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41 Song Options
Choosing "Song -> Song Options" from the main menu will open the Song Options
panel, which allows users to configure a variety of more advanced options for an
individual song, such as compatibility settings or general playback behaviour. You may
find it useful to watch our video demonstrating the various options.

41.1 Playback Compatibility

Compatibility: Clicking the button will upgrade the song to the new Renoise 3
playback behaviour. This option will only appear if you've imported an old tracker
file or loaded a Renoise song that was saved in a version prior to 3.0.

• 

LPB mode: Clicking the ‘Upgrade to latest version’ button with ‘BPM & Ticks’
selected may cause changes to either the song’s BPM or LPB value, depending
on what the Speed is (Speed is the old method of controlling a song's timing).
Choosing ‘Only BPM’ will just use the existing BPM value with the default LPB of
4. This option will only appear if you've imported an old tracker file or loaded a
Renoise song that was saved in a version prior to 2.0.

• 

0S Effect Mode: Applies only to the Trigger Slice Effect Command and is for
maintaining accuracy with its older equivalent from the Amiga and FastTracker II.
The "Amiga/FT2" option slices sample waveforms into pieces that are each 256
bits long, starting from the beginning of the waveform. The Renoise mode
divides the whole waveform into 256 slices, where 00 is the slice at the start of
the sample and FF is the final slice.

• 
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Pitch Effect Mode: As with the "0S Effect Mode", the Pitch Effect toggle deals
with pitch related Effect Commands, since, compared to the older trackers,
Renoise allows for much greater accuracy through a wider range of values.

• 

41.1.1 Playback Options

Ticks Per Line: Changes how many ticks make up a single line in the Pattern
Editor and Phrase Editor. This applies to Effect Commands, Graphical Automation
and Meta Devices such as the LFO. This does not apply to the sample Modulation
section. The default value of 12 gives a smooth sound and makes musical sense
since it's divisible by 2, 3 and 4. More noticeable at slower speeds, lower values
result in rougher, choppier changes, which could be useful if that's the sound
you're after. The TPL can be automated as the song is playing with the Effect
Command ZKxx or with Graphical Automation in the Master Track.

• 

Track Headroom: The volume that each track's input is lowered by. This leaves
room for volume increases that may result from the use of effects, as well as
helping to avoid clipping in the final mix that takes place in the Master track.

• 

Automation Following: Enabled by default, this keeps automation (both
Graphical Automation and Device Commands) up to date with the song position,
which allows the song to be played from any point in time with accurate
automation. If disabled, then when a song is played all current automation values
will stay where they are and only update when given a new value.

• 

41.1.2 Metronome

Beats Per Bar: Sets how many beat clicks will be treated as a musical bar for
the Metronome.

• 

Lines Per Beat: Sets how many lines will make up a beat for the Metronome.
The default value is LPB, which will automatically match this to the song’s LPB.

• 

These settings also affect the metronome pre-count for live recording, which can be
enabled and adjusted from the Options menu.

41.1.3 Highlighting & Defaults

Pattern
Highlight every xx lines: Highlights every line in the Pattern Editor that
is a multiple of this number. When set to LPB, Renoise will automatically
highlight lines for every beat. This is typically the most useful setting, but
other specific values can be helpful depending on the particular song.

♦ 

Default pattern length: Set the default pattern length for newly created
patterns.

♦ 

• 

Sequencer
Highlight every xx blocks: Highlights every alternate set of xx blocks in
the Pattern Sequencer.

♦ 

Highlight block offset: Starts the block highlighting after the stated
amount of patterns, which can be useful to skip an introduction section,
for example.

♦ 

• 
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42 Song Comments

42.1 Song Comments

Using the Song Comments box you can leave notes either for yourself or for others
when sharing a song. The comments can be displayed via the main menu option, "Song
-> Song Comments..."

The "Show song comments after loading" option is only applied to the current song, not
globally for all songs.
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43 Groove Settings

43.1 Groove Settings

The Global Groove settings are found at the end of the Master Track's effect chain. You
may find it useful to watch our video, Global Groove & Phrase Shuffle.

The sliders allow you to shift the playback of four pairs of pattern lines. Increasing the
value extends the length of the first of a pair, causing the next line to be delayed. The
length of this second line is also shortened, since the tempo of the song hasn't actually
changed. At 100% the initial line is two-thirds longer than normal, while the next line is
only one-third of its original length. This constant back and forth movement creates a
swinging feel for the whole song.

The rhythm you create with the sliders will be repeated every eight lines, and the
repetition will be reset at the start of each pattern. However, the nature of this cycle
will be different when using a Lines Per Beat value other than the default of 4. With an
LPB of 3 the last slider is ignored, and so the rhythm repeats every six lines. An LPB of 2
ignores the last two sliders, repeating every four lines. At an LPB of 1 only the first
slider is used, repeating every two lines.

At LPB values above 4 things get kind of unpredictable since multiple lines get grouped
together and delayed as a whole instead of individually.

However, it's not vitally important to grapple with the exact technical details here,
since groove is about adding a certain feeling to the music. Just play around with the
settings to hear what effect they have, which is easier when there's something like a
steady hi-hat on every line. As a simple example, setting all sliders to 50% will delay
every alternate line by the same amount, creating a typical swing groove.

Selecting the presets will automatically set the slider values, and you can store
(right-click) then recall (left-click) your own custom values.

Finally, the effect command ZGxx can be used to toggle the Global Groove on and off
during song playback.
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44 ReWire
ReWire is only available for Windows and Mac, but Linux users have Jack Transport as
an alternative for achieving similar results. It allows you to connect and synchronise
multiple software applications, meaning that they will run side by side while passing
Audio/MIDI information between them. For example, you could connect Renoise to
Logic, programming your drums in Renoise while arranging the bulk of your song in
Logic. Or you could connect both Reason and Ableton Live to Renoise, then arrange
your track in Renoise, control Reason's built-in synthesizers and play around with clips
in Live.

ReWire has two modes, both of which are fully supported by Renoise, allowing it to be
used with any other application that supports ReWire:

ReWire Master: Commonly known as a Mixer application, the master controls
other ReWire slaves. A ReWire master has exclusive control of the soundcard,
while slaves must route audio through the master application. There can be
multiple slaves, but only one master.

• 

ReWire Slave: Also known as a ReWire Synth application. Slaves are controlled
by a ReWire master and feed their audio back into it. They receive MIDI from the
master, but can also send MIDI to the master and ask it to reposition itself.

• 

44.1 Start/Stop Procedure for ReWire Applications

Starting: The ReWire master application should be started first, then the slave(s).

Closing: Close the ReWire slave application(s) first, then close the master.

Important: When working on songs, you must save them separately in both
applications. You must also load them up individually when continuing a session.
ReWire only handles audio and MIDI routing, so it's important to remember that songs
and patches will not be automatically exchanged or restored.

The basic workflow is:

Start the ReWire master then restore a previously saved session.1. 
Start the ReWire slave(s) then restore a previously saved session(s).2. 
Work on the song.3. 
Save the session and close the ReWire slave(s).4. 
Save the session and close ReWire master.5. 

44.2 Using Renoise as ReWire Master

First, make sure that no other ReWire master application is open. Now start Renoise,
which automatically makes it the master, then go to the Track Effects panel and insert
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a #ReWire Input device anywhere in the song (Send Tracks are the ideal place to use
this device).

44.2.1 Routing Audio To Renoise

Use the "Device" option to select a slave from the list. In most cases the slave will
automatically launch. If this has not happened then just launch the application
manually.

The audio signal from the slave will be routed into Renoise via the #ReWire Input
device. Both applications are now bound together and everything is automatically
configured for you. If you hit play in Renoise then this will trigger the slave to start
playing too. Navigating around the song using Renoise will likewise cause the slave to
follow. If you change the playback from within the slave then Renoise will follow.

If you want to capture another audio bus from an existing slave, simply add another
#ReWire Input device then select the same slave but choose a different bus.

44.2.2 Trigger MIDI from Renoise

If a slave has MIDI inputs then you will find them listed as regular devices in the MIDI
Output section, where you could, for example, use Reason synths from within Renoise.

44.2.3 Automating ReWired Synths Like Reason

As soon as you've created a ReWire MIDI instrument you can use the *Instr. MIDI
Control device in Renoise to automate it. Certain synths will provide you with
parameters that have already been mapped, displaying the CC numbers that will
automate those parameters.
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44.3 Using Renoise as ReWire Slave

Launch the application that will be designated as the master, then start Renoise, which
will ask if it should run as a slave - click "Yes".

In certain cases the master will need to be explicitly told to use Renoise as a slave. In
most multi-track sequencers this is done by selecting Renoise as an "Audio Input",
otherwise please refer to the master application's documentation for more details.
Once you have routed Renoise into the master mixer, you are ready to go and the
audio signal from Renoise will be routed into the host. Starting, stopping, and
navigating through the song will be synchronized in both apps.

Some hosts allow you to start Renoise from within the host when you insert Renoise as
a Rewire audio/MIDI device (depending on the host - again refer to its manual). In this
case you won't be asked whether Renoise should start as a ReWire slave, since it
happens automatically.

You may have a scenario where you'd want to start Renoise in a forced slave mode
without requiring it to confirm. To achieve this you can attach the following command
to the Renoise executable "-ForceRunningAsSlave" (if Renoise is currently running you
will have to restart for this to take effect). If no Rewire master is active/detected during
startup, Renoise will just ignore the "-ForceRunningAsSlave" command and launch in
master mode.

Note: To send MIDI data to a Renoise slave you will have to use virtual loopback MIDI
cables.

44.3.1 Setting Up Transport Sync Mode in Renoise

When running Renoise as a ReWire slave, you have two choices regarding how Renoise
should sync to the master. This can be set up in the Audio Preferences, but only after
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Renoise is already running as a ReWire slave:

Full Transport Sync: Any changes to the timeline in Renoise and the ReWire
master will be synced. This is very useful for creating a song in multiple
applications at once.

• 

BPM & Bar Sync: You can start, stop and navigate freely in Renoise while the
timeline of both applications remains beat-synced. Very useful for improvisations
or live mixing.

• 

Automatically compensate latencies: The ReWire protocol does not allow the
passing of latencies that either the master or slave are using. When running
Renoise as a slave and the song makes use of plugins which introduce latency,
Renoise must shift its timeline to compensate and ensure synchronicity. This
shifting may unfortunately lead to missed first notes upon starting the song or
pattern.

• 

44.4 General Notes About Renoise as Master or Slave

Some ReWire slaves may have limited control over the song's transport functions,
though it's up to the master application to allow transport changes (or not). For
example, some ReWire masters might ignore tempo changes, loop changes or position
changes. This is not the fault of Renoise, but rather a limitation in the ReWire
implementation of the designated master application.

44.5 ReWire Demo Restrictions

Registered Renoise users have no restrictions, but if you are using the free demo then
there are some ReWire limitations:

When Renoise is the master, only the first stereo pair is used.1. 
When Renoise is a slave, the demo version will occasionally generate a small,
subtle hiss.

2. 
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45 Jack Transport
Jack Transport provides the ability to sync Renoise with multiple Jack clients on Linux.
With it you can start, stop and relocate the play position from any of the Jack enabled
applications. Any software that is "jacked into" the session will react and synchronise
accordingly. Jack Transport is enabled in the Audio Preferences panel, though note that
it's disabled by default, even when it has been selected as the audio device.

45.1 Levels of Jack Transport Control

Level 1: Each Jack client has the power to start, stop and relocate (change the
playback position of) the transport. This is represented in either seconds or sample
time.
Level 2: Only one Jack client can control the Time Base, which is a combination of the
tempo, time signature and beat position.

Most applications support the first level of Jack Transport control, though, at the time of
writing, the second level is rarely supported. If more than one application is running
which supports the Time Base, Jack will select one automatically.

45.2 Dealing with Tempo

Tempo information is exchanged only when the synchronized application supports Time
Base. As stated above, most applications do not support this and so you will have to set
the tempo manually.

In the case where all Jack Transport applications are Time Base aware, you still have to
make sure that all clients are using the same tempo and automation. This is because
playback relocation will be done in sample time instead of "beat time". All clients need
to have the same base tempo in order to jump to the same positions.
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45.3 Dealing with Loops

Loop information is not transmitted via the Time Base, meaning that each client will try
to apply its own loops, fighting with the other Jack programs to reposition. To avoid this
conflict, enable loops in the application that is currently active and disable them in the
others.

45.4 PDC and Jack Transport

Jack doesn't provide a way to explicitly handle latencies, which, when combined with
Automatic PDC (plugin delay compensation) in Renoise, can result in small 'misfires'.
For example, if another application attempts to jump Renoise to a specific "position",
Renoise will attempt to compensate by jumping to "position + overall PDC latency". If
this is causing issues, you should temporarily disable the PDC in Renoise.
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46 MIDI Clock
MIDI Clock is a MIDI protocol that allows the syncing of playback (transport and tempo)
of multiple sequencers, synthesizers, drum machines etc. This can be external MIDI
hardware, other software on your computer, or software running on other computers
and connected to Renoise via MIDI cables.

There are two MIDI Clock modes: master and slave. Renoise fully supports both modes.

The MIDI Clock master sends a series of 24 ppqn (pulses per quarter note) beat clock
messages to all slaves. The interval of these messages allows the connected slaves to
determine the master's tempo and beat position. Along with the 'beat clock' messages,
'Start', 'Stop', 'Continue' and 'Relocation' (Song Position Pointer) messages are sent to
sync the timelines of the master and slaves.

Only the MIDI Clock master can start or stop the playback or change the tempo. Slaves
are forced to follow the master, thus the terms 'master' and 'slave'.

46.1 Running Renoise as MIDI Clock Master

46.1.1 Set Up Devices

To use Renoise as the master, simply set up a MIDI Clock master device in the "Edit ->
Preferences -> MIDI" panel. You can also specify which message types should be sent
from Renoise. Send only MIDI Clock messages if you just want to transfer tempo to the
slaves. Note that Renoise only sends out MIDI clock messages while playing back a
song.

46.1.2 Adjust Offsets

You can use the "Offset" slider in the "MIDI Clock Master" preferences to shift clock
messages back and forth in time. This is sometimes needed to compensate delays
(phase offsets) that are introduced by MIDI hardware. The easiest way to test and
adjust this is by using a steady metronome sound on both the master and slave. If the
sounds do not play back on exactly the same beat, try adjusting the "Offset" slider in
Renoise until they match.

Please note that the smallest possible negative latency is limited to the current latency
of your soundcard. If you need further negative latency, you can increase your audio
latency in the Audio Preferences.

46.2 Running Renoise as MIDI Clock Slave
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46.2.1 Set Up Devices

To connect Renoise to a MIDI Clock master, use the MIDI Clock slave device section in
the "Edit -> Preferences -> MIDI" panel.

To quickly enable and disable the connection to the master clock, use the small 
button in the Renoise Transport Panel, next to the BPM. This icon will only show up
when a MIDI Clock slave device has been set.

Important: A MIDI device must be selected and the sync clock mode icon must be
enabled to sync Renoise to other devices. After you have done this, you should notice a
small green blinking LED at the top of the Renoise interface:

The LEDs next to the small clock icon show the MIDI Clock input in green and output in
red.

46.2.2 Adjust Offsets

As with the MIDI Clock master mode, you can correct small offsets between Renoise
and the master with the "Offset" slider in the preferences. Again, the easiest way to
test and adjust the offset is by using a steady metronome on both the master and
slave. If the sounds are not in sync, try adjusting the offset slider in Renoise until they
match.

46.2.3 Adjust Smoothing

MIDI messages often only have very rough timing, so the beat clock messages
transferred from a MIDI Clock master to Renoise may be imperfect. Depending on how
precise the incoming MIDI clock stream is, you can use this option to set how fast
Renoise should react to changes from the MIDI Clock master. The higher the Smoothing
value, the more stable the sync will be, but the slower Renoise will react to 'real' BPM
changes from the master. Try playing around with the Smoothing to find a good value
for your setup.

46.2.4 Loading New Songs Without Losing Sync

You can detach and reattach Renoise to a running master at any time without losing
sync. To do so, simply stop the song in Renoise when running as MIDI Clock slave,
instead of stopping the master. Now you can even load a new song and hit start again,
whereupon Renoise will resync itself as smoothly as possible to the master, which is
still playing. This is extremely useful when playing live, because you can continuously
run a master and also switch songs in Renoise. When reattaching Renoise in this
manner, the closer you start playing to an on-beat, the less correction will be needed
and the smoother the adjustment will be.
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47 Open Sound Control
Open Sound Control (OSC) was created as a successor to the MIDI control protocol. It
enables communication between computer software, sound synthesizers and other
multimedia devices that support OSC.

Its advantages over MIDI include: an open-ended and dynamic URL-style symbolic
naming scheme, symbolic and high-resolution numeric argument data, pattern
matching language to specify multiple recipients of a single message, high resolution
time tags and "bundles" of messages whose effects must occur simultaneously. The
protocol is also not bound by specific hardware (i.e. MIDI cables and ports) and can be
transferred across any network connection, even remotely via the internet.

This makes OSC much more powerful than MIDI, but due to its open-ended
specification, both the OSC client (which sends OSC data) and the OSC server (which
receives data, i.e. Renoise) must be separately configured, unlike MIDI which is
essentially "Plug & Play".

For more general information about OSC, see the OSC Wikipedia page and the official
OSC homepage.

47.1 Setup

Renoise can use OSC in one of two ways:

Using Renoise as an OSC server (receiving messages) via a preconfigured OSC
message set.

1. 

Using the fully configurable and customisable Renoise scripting API. This allows
you to send and receive any form of OSC message and define your own
communication protocol, but obviously requires programming.

2. 

To set up Renoise as an OSC server, open the OSC options panel by choosing "Edit >
Preferences > OSC" from the main menu:
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Enable Server: This starts the Renoise OSC server and the network port is
changed to a listening state, so you may get a firewall warning the first time this
is enabled.

• 

Incoming Messages: This panel simply displays messages relevant to the
networking process.

• 

Protocol: Select the protocol which the Renoise server will use:
Udp: Provides a high transfer rate with lower reliability than Tcp.♦ 
Tcp: Provides a lower transfer rate than Udp with higher reliability.♦ 

• 

Port: Select the Port number for messages to be transferred over. Generally, a
number greater than 1024 is used.

• 

Command List: Lists the various commands that it is possible to use to
communicate with Renoise.

• 

Explanation Panel: When clicking on a command in the Command List, an
explanation of what the command does is displayed here.

• 

47.2 The Default OSC Implementation of Renoise

/renoise/evaluate(string)• 

Evaluate a custom Lua expression (e.g. renoise.song().transport.bpm = 234).
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/renoise/song/bpm(number)• 

Set the song's current BPM value [20 - 999].

/renoise/song/edit/mode(boolean)• 

Set the song's global Edit Mode on or off.

/renoise/song/edit/octave(number)• 

Set the song's current octave value [0 - 8].

/renoise/song/edit/pattern_follow(boolean)• 

Enable or disable the global Pattern Follow mode.

/renoise/song/edit/step(number)• 

Set the song's current Edit Step value [0 - 8].

/renoise/song/instrument/XXX/macro1-8(number)• 

Set instrument XXX's macro parameter value [0 - 1].
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/instrument/XXX/monophonic(boolean)• 

Enable or disable instrument XXX's mono mode.
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/instrument/XXX/monophonic_glide(number)• 

Set instrument XXX's mono glide amount [0-255].
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/instrument/XXX/phrase_playback(string)• 

Set instrument XXX's phrase playback mode [Off, Program, Keymap].
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/instrument/XXX/phrase_program(number)• 

Set instrument XXX's phrase program number [0 - 127].
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/instrument/XXX/quantize(string)• 

Set instrument XXX's quantization method [None, Line, Beat, Bar].
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/instrument/XXX/scale_key(string)• 
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Set instrument XXX's note scaling key [C, C#... B].
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/instrument/XXX/scale_mode(string)• 

Set instrument XXX's note scaling mode.
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/instrument/XXX/transpose(number)• 

Set instrument XXX's global pitch transpose [-120 - 120].
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/instrument/XXX/volume(number)• 

Set instrument XXX's global volume [0 - db2lin(6)].
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/instrument/XXX/volume_db(number)• 

Set instrument XXX's global volume in dB [0 - 6].
(XXX is the instrument index, -1 chooses the currently selected instrument)

/renoise/song/lpb(number)• 

Set the song's current Lines Per Beat value [1 - 255].

/renoise/song/record/metronome• 

Enable or disable the metronome.

/renoise/song/record/metronome_precount• 

Enable or disable the global metronome precount.

/renoise/song/record/quantization(boolean)• 

Enable or disable the global Record Quantization.

/renoise/song/record/quantization_step(number)• 

Set the global Record Quantization step value [1 - 32].

/renoise/song/sequence/schedule_add(number)• 

Add a scheduled sequence playback position.

/renoise/song/sequence/schedule_set(number)• 

Replace the currently scheduled sequence playback position.
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/renoise/song/sequence/slot_mute(number, number)• 

Mute the specified track at the specified sequence slot in the matrix.

/renoise/song/sequence/slot_unmute(number, number)• 

Unmute the specified track at the specified sequence slot in the matrix.

/renoise/song/sequence/trigger(number)• 

Set the playback position to the specified sequence position.

/renoise/song/tpl(number)• 

Set the song's current Ticks Per Line value [1 - 16].

/renoise/song/track/XXX/device/XXX/bypass(boolean)• 

Enable or disable the bypassing of an effect device.
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/device/XXX/set_parameter_by_index(number,
number)

• 

Set the value of a parameter of an effect device [0 - 1].
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/device/XXX/set_parameter_by_name(string,
number)

• 

Set the value of a parameter of an effect device [0 - 1].
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/mute• 

Mute track XXX.
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/unmute• 

Unmute track XXX.
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/solo• 

Solo track XXX.
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/output_delay(number)• 
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Set track XXX's pre-FX delay in ms [-100 - 100].
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/postfx_panning(number)• 

Set track XXX's post-FX panning [-50 - 50].
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/postfx_volume(number)• 

Set track XXX's post-FX volume [0 - db2lin(3)].
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/postfx_volume_db(number)• 

Set track XXX's post-FX volume in dB [-200 - 3].
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/prefx_panning(number)• 

Set track XXX's pre-FX panning [-50 - 50].
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/prefx_volume(number)• 

Set track XXX's pre-FX volume [0 - db2lin(3)].
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/prefx_volume_db(number)• 

Set track XXX's pre-FX volume in dB [-200 - 3].
(XXX is the device index, -1 chooses the currently selected device)

/renoise/song/track/XXX/prefx_width(number)• 

Set track XXX's pre-FX width [0, 1].
(XXX is the device index, -1 chooses the currently selected device)

/renoise/transport/continue• 

Continue song playback.

/transport/loop/block(boolean)• 

Enable or disable pattern Block Loop.

/renoise/transport/loop/block_move_backwards• 

Move the Block Loop one segment backwards

/renoise/transport/loop/block_move_forwards• 
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Move the Block Loop one segment forwards

/renoise/transport/loop/pattern(boolean)• 

Enable or disable looping the current pattern.

/renoise/transport/loop/sequence(number, number)• 

Disable or set a new sequence loop range.

/renoise/transport/panic• 

Stop song playback and silence all playing instruments and effects.

/renoise/transport/start• 

Start song playback or restart playing the current pattern.

/renoise/transport/stop• 

Stop song playback.

/renoise/trigger/midi(number)• 

Trigger a raw MIDI event.
arg#1: the MIDI event as number

/renoise/trigger/note_off(number, number, number)• 

Trigger a Note OFF.
arg#1: instrument (-1 chooses the currently selected one)
arg#2: track (-1 for the current one)
arg#3: note value (0-119)

/renoise/trigger/note_on(number, number, number, number)• 

Trigger a Note-On.
arg#1: instrument (-1 for the currently selected one)
arg#2: track (-1 for the current one)
arg#3: note value (0-119)
arg#4: velocity (0-127)

Note that the default OSC implementation can be extended by editing the file
"GlobalOscActions.lua" in the "Resources/Scripts" folder, found within the directory
where you installed Renoise (on MacOS this is found in the app bundle).
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47.3 Examples

47.3.1 TouchOSC via Duplex

The Duplex Tool comes with a Device preset for TouchOSC, an iPhone / iPod Touch /
iPad app that allows those devices to control Renoise via OSC. To use it, select
"TouchOSC" from the "Device" drop-down menu in the Duplex Browser and adjust the
configuration as needed within the "Settings" dialog box. Then, using the TouchOSC
app on the Apple device, you can change the values of the various knobs and sliders on
the screen to control various features of Renoise.

Duplex uses the Renoise Scripting API to communicate with TouchOSC, meaning that
it's fully configurable, and can also be used as an example on how to wrap up your own
OSC implementation in Renoise.

47.3.2 Pure Data

PD (aka Pure Data) is a real-time graphical programming environment for audio, video,
and graphical processing. PD was created to explore ideas of how to further refine the
Max paradigm with the core idea of allowing data to be treated in a more open-ended
manner by it up to applications outside of audio and MIDI, such as graphics and video.
There are different versions available to download for PC, Mac and Linux.

47.3.2.1 Using PD With Renoise Via OSC

First install PD, then download, unzip and open the "test-renoise-osc.pd" file
within PD.

• 

In the top-left corner you can set the port number to match the OSC port number
you have chosen for Renoise [connect localhost XXXX]. With Edit Mode (Ctrl + E)
you can edit the numbers.

• 

To the right you can start and stop playing Renoise with the [send / renoise /
transport / start] and [send / renoise / transport / stop] buttons.

• 

The test program comes with a set of commands already loaded in. Make sure a
sample is loaded into into slot 00 within Renoise and press the "chord-test"
button in PD. You should hear a chord being played. You can also click on the
individual commands to hear the individual notes.

• 

If you would like to enter new OSC messages yourself:
Select from the menu "Put -> Message", place the box on the screen and
enter your desired command (check the OSC Command List for available
commands).

♦ 

Connect the new message box by hovering over the bottom left corner
(the cursor will become a circle) then clicking and dragging over to the
"sendOSC" box.

♦ 

Cancel edit mode with (Ctrl + E) and click the box to send the message to
Renoise via OSC.

♦ 

• 
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48 Tools
Tools are scripts that can be plugged into Renoise to add new capabilities and features.
They can be found and downloaded on the Tools section of our site. To install a
downloaded Tool, simply double-click on the .xrnx file or drag and drop it onto a
Renoise window. Installed Tools can be automatically updated by selecting Find Tool
Updates from the Help menu.

Looking for features on the bleeding edge? Then check out the Tool Announcement
forum for unreleased Tools and updates that members of our community have under
development.

The Tools are built upon the Renoise Scripting API, a feature introduced back in version
2.6 that allows users to code their own extensions and features with Lua, a free
light-weight programming language.

So if you have an idea for customising Renoise and want to know how to begin creating
your own Tools, just visit our scripting Github page and download the XrnxStarterPack.
With a few lines of code, you can build the things that you always wanted Renoise to
have.

You may find it useful to watch our video on this subject.
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49 Libraries & Presets
A library acts as a container for other presets, stored in the file format .xrnl, which is
easily installed via drag and drop. Once installed, the library’s contents will be available
to use through the preset menu(s). Since a library’s contents can be many different
things, the installer will helpfully tell you what was installed - whether it was a bunch of
new instruments, some multi-sample presets, or perhaps a collection of effect chains.

You may find it useful to watch a short video on this subject.

If you save one of your own presets, it is stored in a special location - the User Library.
This is found in the same folder as any installed libraries and is shared for use between
Renoise and Redux:

Windows: HOME/[My ]Documents/Renoise• 
MacOS: HOME/Documents/Renoise• 
Linux: HOME/Renoise• 

49.1 Specific Preset Types

Instruments are constructed from a variety of parts: Phrases, Keyzones, Waveforms,
Modulation and Effects. Specific preset types for each of these sections are available
from a drop-down menu at the top right corner, where you can load, save, import and
export. This allows an existing instrument to load the various presets into their specific
sections without overwriting the whole instrument. A library can contain any of the file
types associated with these sections:
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Phrases (.xrnz) - A phrase preset is an XML file describing the number of lines,
columns and other settings (loop, tempo etc.) that make up a single phrase.

• 

Keyzones (.sfz) - A multi-sample preset is an .sfz soundfont file, an open
standard format for describing musical instruments.

• 

Waveform (.flac) - Waveform presets are just samples stored as .flac files.• 
Modulation (.xrno) - A Modulation Set preset is a collection of modulation
envelopes that affect various sample domains (volume, panning, etc.). The
preset itself is a simple XML file.

• 

Effects (.xrnt) - An Effect Chain preset describes the effect devices and
parameter values that make up an effect-chain. The preset itself is a simple XML
file.

• 

A library can also contain two other file types:

Effect-Devices (.xrdp) - An Effect-Device preset defines the parameters of a
single effect device. This can be any of the regular devices or a Doofer (a special
combination of other devices).

• 

Themes (.xrnc) - Themes are alternative visual styles for the interface and are
stored as simple XML files. New Themes can be created, or existing ones edited,
in the Themes tab of the preferences menu.

• 

49.2 XRNL Library Creation

The easiest way to build your own library is to create a copy of an existing user library,
save presets to it from inside Renoise and then do the file/folder organisation
externally.

49.2.1 Build The Collection

Libraries are laid out in the same way as the user library. For example, it might have
the following structure: �

+ Samples
+ Multi-Samples
+ Instruments

Note that these folders are created automatically as you save a preset. It's possible to
move presets around or reorganise them into sub-folders, but this needs to be done
from within your OS explorer/finder window. Any changes performed there will
automatically be reflected in the Renoise user interface.

So, after a bit of customization your file structure might now look like this (with folders
expanded): �

+ Samples

- Ambience
- Channel
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- Field Recordings
+ Multi-Samples
+ Instruments

- Synth
- Bass
+ FX

- Scifi

49.2.2 Add A Manifest

Once you feel the content is ready to be exported, add a manifest to the root folder
(use a basic text editor such as Notepad and copy the following text as a starting
point). �

<?xml version="1.0" encoding="UTF-8"?>
<RenoiseContentLibrary doc_version="0">
  <Id>org.username.examplepack</Id>
  <Name>Example Pack</Name>
  <Author>Username (plus email, link, whatever)</Author>
  <Version>1.0</Version>
  <Description>Amazing pack by username for Renoise+Redux</Description>
</RenoiseContentLibrary>

� The only thing that is important to get right is the name - it needs to follow a certain
naming convention, in the form `abc.def.ghi`. For example `com.renoise.elements` for
one of our Renoise-published libraries, but you can use whatever name you like as long
as it has those three parts.

By now the file structure might look like this: �

+ Samples
+ Multi-Samples
+ Instruments
manifest.xml

� You can even add additional files if you wish to - perhaps a PDF document or a
'readme'. These files will not be useful to Renoise, but will still be installed on the user's
machine as part of the library.

49.2.3 Creating The Library File

Using a zip archive utility (on Windows, 7Zzip is recommended), you first compress the
inside of the root folder, and then assign it the name provided in the manifest plus the
Renoise library file extension .xrnl. So, in the case of our example pack, the file name
would become `org.username.examplepack.xrnl`

49.2.4 Test Install

You can now install the library to check that everything has worked by simply dragging
the file on top of the Renoise window. To install in Redux either drag the file on top of
the plugin window or click the load button  of the Preset Selector.
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A successful install should result in a message like this: �

Library 'xxx' was successfully installed.
It contains Instrument presets.

� If the installer encountered a problem you will be provided with a error message
containing information that will be useful in tracking down the problem.
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50 Preferences
The Renoise Preferences panel lets you set various general options for the program,
such as soundcard settings, MIDI device settings, how files are loaded/saved etc. These
settings need to be set only once and will be applied to all songs and sounds you create
with Renoise.

To open the Preferences panel, choose "Edit -> Preferences..." from the main menu
(Windows + Linux). On the Mac, choose "Renoise -> Preferences...".

When setting up Renoise for the first time, you should only need to tweak the options in
the Audio and MIDI tabs. The rest of the default options should be sufficient until you
are more familiar with Renoise. The Setting Up Audio Devices and Setting Up MIDI
Devices sections of the manual can help you with the initial setup.

50.1 Audio
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50.1.1 Device Settings (Windows)

Device Type: Determines the sound driver that Renoise will use. On Windows
you will have the choice between DirectSound, WASAPI and ASIO. If available,
ASIO is highly recommended as it provides better timing with MIDI instruments
and lower latencies in general.

• 

In Device: (DirectSound only) If you have multiple soundcards installed, you will
be able to select the one you want to use with Renoise here. Choose "Primary
Device" to use the system's default.

• 

Out Device: (DirectSound only) If you have multiple soundcards installed, you
will be able to select the one you want to use with Renoise here. Choose
"Primary Device" to use the system's default.

• 

Sample Rate: Select the Sample Rate for playback. All internal audio processing
in Renoise will be done at this rate. The higher the Sample Rate, the more
detailed the results will be, but also the more CPU power will be used.

• 

Latency: (DirectSound only) Set the buffer size affecting overall latency. Higher
numbers will reduce the possibility of crackling sound at high CPU usage, but will
also cause more latency (the time it takes the sound from Renoise to reach an
output and be heard).

• 

Sync offset: A custom offset applied when synchronizing audio playback to an
external source such Ableton Link peers. It is only necessary to set this if Renoise
cannot reliably detect the actual output latency of the audio device.

• 

Use hardware buffers: (DirectSound only) This option may speed up playback
processing a bit, but only some soundcards support this. If you enable this
option, then experiment with recording in the Sampler before deciding to use it
permanently, as it may cause issues. If you experience strange results then
disable this function.

• 

Limit to stereo in/out: (ASIO only) If you have a multi-IO soundcard, you can
disable all inputs and outputs except for the main stereo pair. This may lead to
better performance when you don't need the other channels.

• 

Dithering: Apply dithering to the audio stream when the soundcard uses a bit
depth of 8 or 16 bit. 24 and 32 bit audio is never dithered.

• 

Control Panel: (ASIO only) Opens the ASIO driver's control panel where you can
configure your soundcard in more detail.

• 

Reinitialize: Shut down and then reopen all connections to the
soundcard/driver. May be useful for troubleshooting.

• 

50.1.2 Device Settings (MacOS)

In Device: If you have multiple soundcards installed, you will be able to select
the one you want to use with Renoise here.

• 

Out Device: If you have multiple soundcards installed, you will be able to select
the one you want to use with Renoise here.

• 

Sample Rate: Select the Sample Rate for playback. All internal audio processing
in Renoise will be done at this rate. The higher the Sample Rate, the more
detailed the results will be, but also the more CPU power will be used.

• 

Latency: Set the buffer size affecting overall latency. Higher numbers will
reduce the possibility of crackling sound at high CPU usage, but will also cause
more latency (the time it takes the sound from Renoise to reach an output and
be heard).

• 
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Dithering: Apply dithering to the audio stream when the soundcard uses a bit
depth of 8 or 16 bit. 24 and 32 bit audio is never dithered.

• 

Reinitialize: Shut down and then reopen all connections to the
soundcard/driver. May be useful for troubleshooting.

• 

50.1.3 Device Settings (Linux)

Setting up Linux for fast and reliable audio usage can be quite complex, depending on
the distribution you are using. For general questions and FAQs regarding sound output
on Linux, take a look at the Linux FAQ.

Device Type: Determines the sound driver that Renoise will use. On Linux you
have the choice between ALSA and Jack. ALSA will be available on all setups. Jack
is more advanced, but also harder to set up and may have to be installed
manually. Jack is highly recommended though, because it allows you to use
several Jack based audio applications at once with the ability to route audio
between them.

• 

In Device:
ALSA: If you have multiple soundcards installed, you will be able to select
the one you want to use with Renoise here.

♦ 

Jack: Select the number of input pairs you would like to pass over to Jack.♦ 

• 

Out Device:
ALSA: If you have multiple soundcards installed, you will be able to select
the one you want to use with Renoise here.

♦ 

Jack: Select the number of output pairs you would like to pass over to
Jack.

♦ 

• 

Sample Rate: (ALSA only) Select the Sample Rate for playback. All internal
audio processing in Renoise will be done at this rate. The higher the Sample
Rate, the more detailed the results will be, but also the more CPU power will be
used.

• 

Buffer Size: (ALSA only) The base buffer size that will be used for audio
processing in Renoise. Higher numbers will reduce the possibility of crackling
sound at high CPU usage, but will also cause more latency (the time it takes the
sound from Renoise to reach an output and be heard).

• 

Periods/Buffer: (ALSA only) How many "Buffer Sizes" will be used. The final
latency for ALSA playback is: Periods/Buffer * Buffer Size. Some drivers need
three buffers to work reliably, while others need only two. If you hear crackling
output from Renoise, try changing this value or the setting for "In Device".

• 

Use realtime priority: (ALSA only) On most 'out of the box' Linux systems,
applications are not allowed to execute realtime performance critical tasks. They
are needed for realtime audio processing though, so they should be enabled
when possible. Please see the Linux FAQ for more info about this topic. If you
cannot configure your system to allow realtime tasks, then you can disable
Renoise from trying with this option.

• 

Enable Transport Support: (Jack only) Send and receive time and transport
information to/from other applications that are running with Jack. This is only
useful to sync multiple audio applications together. If you are only running
Renoise, this option should be disabled.

• 

Dithering: Apply dithering to the audio stream when the soundcard uses a bit
depth of 8 or 16 bit. 24 and 32 bit audio is never dithered.

• 
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Reinitialize: Shut down and then reopen all connections to the
soundcard/driver. May be useful for troubleshooting.

• 

50.1.4 Multi CPU/Core support

Realtime Audio CPUs: If you have a processor with multiple CPUs or cores, you
can adjust how Renoise makes use of them for real-time audio processing. By
default, all cores are used, which is highly recommended.

• 

50.1.5 Automatic PDC

Automatic Plugin Delay Compensation: This automatically compensates all
delays that some Renoise internal effects and VST/AU plugins introduce. Used to
ensure all tracks and instruments are played back in sync. If you are
troubleshooting, you may want to temporarily disable this option. The Automatic
PDC can also be quickly toggled from the Options menu.

• 

50.1.6 CPU Load and Threshold

When the CPU is above, For at least: - When the conditions are fulfilled,
Renoise executes Panic (instantly stops all playback). This option prevents very
high CPU loads from freezing your computer.

• 

50.2 MIDI
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50.2.1 MIDI Master Keyboard/Mapping

In Device A/B/C/D: Select up to four devices to be used for general MIDI input in
Renoise (Recording and Editing Notes) and for MIDI remote control (MIDI
Mapping).

• 

Auto-rescan when hot-plugging devices: When enabled and devices are
hot-plugged, rescan for MIDI devices in Renoise too, so they can be immediately
used.

• 

Rescan: Manually rescan MIDI devices.• 
Record and Play Filters: Toggle the input and recording of specific MIDI
messages for Renoise. This only applies to recording into patterns and real-time
playback.

• 

Adjust recording latency: Will automatically compensate for MIDI latencies, so
that you record what you hear, not what you play.

• 

Fix received MIDI event jitter: Shifts received MIDI events slightly forward in
time to fix MIDI transmission jitter. Stabilizes MIDI input, but also delays input by
an entire audio buffer.

• 

Ignore specific controllers: Explicitly prevent certain MIDI Control Change
messages from being received and recorded. You can enter a list of CC numbers
here, separated by commas.

• 
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50.2.2 MIDI Clock Master

Out Device: Set a MIDI device that Renoise will send MIDI Clock data to.• 
Offset: Manually shift all messages sent out to the devices by the given amount.
This can be useful to manually compensate additional latencies that external
devices introduce (audio latency is always automatically compensated by
Renoise). Please note that the smallest possible negative latency is limited to the
current latency of your soundcard. If you need further negative latency, you can
increase your audio latency in the Audio Preferences.

• 

Send clock: Include sending MIDI Clock pulse messages.• 
Send start/stop: Include sending MIDI Clock start/stop messages.• 
Send song position pointers: Include sending MIDI Clock song position
messages.

• 

Send MIDI Machine Control (MMC): In addition to the MIDI clock, also send
MMC sysex messages to sync external devices to Renoise.

• 

50.2.3 MIDI Clock Slave

In-Device: Select the MIDI Device that Renoise will use to receive MIDI Clock
messages. When enabled, you can slave Renoise to a MIDI Clock master (a
device which sends MIDI Clock messages). As soon as a MIDI Clock device is set,
you will see a new option in the Transport Panel. This option must be enabled to
activate sync from external devices and so can also be used to toggle sync
quickly without having to constantly open the Preferences.

• 

Offset: Manually shift incoming timing information by the given amount. This
can be useful to manually compensate extra latencies that the external MIDI
Clock devices introduce (audio latency is always automatically compensated by
Renoise). Since Renoise can't predict the future, a negative latency setting will
lead to the offset being gradually shifted to its requested position after playback
starts.

• 

Smoothing: MIDI messages often only have very rough timing, so the beat clock
messages transferred from a MIDI Clock master to Renoise may be imperfect.
Depending on how precise the incoming MIDI clock stream is, you can use this
option to set how fast Renoise should react to changes from the MIDI Clock
master. The higher the Smoothing value, the more stable the sync will be, but
the slower Renoise will react to 'real' BPM changes from the master. Try playing
around with the Smoothing to find a good value for your setup.

• 

50.3 OSC
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50.3.1 Server

The server is enabled with the checkbox near the top, though note that you are
opening up a port that is listening for incoming traffic. If you are not planned to use
OSC messaging between Renoise and another OSC client, it is advisable to leave the
OSC server disabled. Beneath the checkbox is the messaging log window, which shows
details of any incoming data and provides feedback on whether outgoing data has been
sent correctly or otherwise.

Protocol: Choose from UDP (for local network and anything with a fast, stable
connection) or TCP (for remote networks requiring more secure feedback on
delivery status).

• 

Port: The port number, which by default is 8000, but can be changed to any
desired port.

• 

50.3.2 Renoise OSC Messaging Protocols

Renoise provides four sub-trees in its root messaging tree of /renoise/:

evaluate - Send Lua strings for Renoise to evaluate.• 
song - Send song specific triggers to activate.• 
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transport - Send transport specific triggers to activate.• 
trigger - Send note specific triggers to activate.• 

For full details of using OSC within Renoise, please refer to its section of the manual.

50.4 Files

Note: All import options mentioned below can also be quickly accessed in the Disk
Browser by right-clicking the file, then choosing "Load File with Options..."

50.4.1 WAV Import

Applies to WAV, FLAC, AIF, OGG and MP3 files.

Import loop settings from files: Enables the importing of loop settings that
are saved along with WAV, FLAC and AIF files.

• 

Autoset 'Beatsync' length: When loading samples, a good Beatsync value will
be automatically estimated in the Sample Properties, overwriting previous
values. If you don't want this to happen, disable it here.

• 
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50.4.2 Raw Audio Import

Applies to any non-audio files that are forced to be loaded as audio. See Importing Raw
Audio for more details.

Bits: Bit-rate that will be applied to the imported raw sample.• 
Sample Rate: Sample rate of raw samples.• 
Skip header bytes: Will skip the specified number of bytes and not treat them
as audio data.

• 

Big Endian: Select the byte order that will be used for the raw sample import.
Only applies to bit depths of 16 or more.

• 

50.4.3 Device Chain Import

Applies to XRNT files.

Replace Existing Chain: When enabled, loading a device chain will completely
erase all existing devices first. When disabled, the imported chain is appended.

• 

50.4.4 MIDI Import (Renoise Only)

Applies to MID or MIDI files.

Create instruments: Create instruments based upon the instruments used in
the MIDI file. When disabled, only notes and CC events are imported and so
instruments have to be set up manually.

• 

Create *Instr. MIDI Control devices: Create MIDI Control devices to import
and send MIDI control change messages (e.g. modulation wheel).

• 

Lines per pattern: Divide the imported MIDI song into patterns of the given
length.

• 

MIDI device: Choose the MIDI device for selecting the MIDI instruments from
(and send output to).

• 

50.4.5 Song/Instrument/Sfz Export (Renoise Only)

Applies to exported XRNI (Renoise Instrument files) and XRNS (Renoise Song files).

Sample format: Select how samples are stored in Renoise song or instrument
files. XRNI and XRNS files are regular zip files with a custom extension, so it is
possible to open them with any tool which can use zip files (e.g. WinRar/WinZip
on Windows, Stuff-it on MacOS) and extract all of the samples manually. "Flac"
will result in smaller files and should be used by default. "Wav" files might be
useful if you later want to extract the files and use them in other programs.

• 

50.5 Keys

Renoise 3.4 User Manual

50.4.2 Raw Audio Import 243



50.5.1 Keyboard Mapping List

All of the keyboard shortcuts in Renoise/Redux can be re-configured. Above the list you
can choose the Focus of the mappings, which changes the part of the interface that the
shortcuts apply to. Selecting "All" will give an overview of all existing keyboard
shortcuts in Renoise/Redux, making it easier to search for a specific setting.

There are many mappings which are not assigned by default, so if you need to create
one that does not exist yet, take a look at the available mappings in the relevant
section. To change or create a keyboard mapping, select the mapping in the list and
click on the "New Assignment" box. Press the key combination you would like to use
and then hit the 'Assign' button. If the given combination is already used somewhere
else you will be warned of this. The new configuration will be saved automatically.

50.5.2 Importing/Exporting Keyboard Mappings

 - Load a saved set of key-bindings.• 
 - Save a custom set of key-bindings.• 
 - Reset to the default key-bindings.• 
 - Display the current key-binding layout in your default browser in a

print-friendly format.
• 
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50.5.3 Global Keyboard Options

Double Caps Lock workaround: If your Caps Lock key is not behaving as
normal (requiring two presses, or entering two Note-Offs instead of one), then
enable this option.

• 

Use right-side modifiers as: Changes whether the right-side Control/Shift/Alt
keys are to be used as modifiers (in combination with other keys, e.g. Ctrl + Z) or
can be assigned functions on their own.

• 

50.5.4 Keyboard Repeat Rate

Repeat Rate: Configure how fast key presses are repeated.• 

50.5.5 Mouse Wheel/Click Repeat Rate

Enable mouse wheel acceleration: Will make the use of the mouse wheel
more sensitive.

• 

Left-Click Repeat Rate: Set how fast changes to a value with a left-click will be
repeated (e.g. increasing the BPM using the small arrows).

• 

Right-Click Repeat Rate: Same as above, but for right mouse button clicks.• 

50.6 GUI
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The GUI options allow the customisation of the general display behaviour.

50.6.1 Global / General

Always start in compact mode: (Redux only) Toggle always starting in
compact mode when Redux is launched.

• 

Show tooltips: Toggle the displaying of tooltips when the mouse pointer hovers
over a significant part of the interface for a second.

• 

Mouse warping (disable for tablet pens): Disable to increase usability for
tablet pens.

• 

GUI effects & animations: When enabled, animations will be used in some
parts of the interface, e.g. smooth scrolling, fading of menus, transparency etc.
Disable this option if you dislike them or are using a very slow computer.

• 

Enable Retina HiDPI display support: (Mac only) Toggles HiDPI support
on/off.

• 

User interface scaling: Can override the amount of scaling used by the default
‘Auto’ setting, which uses your main display’s DPI value, and instead uses a
percentage chosen from 100-350%. This option can still be used to enlarge the
Renoise GUI even if your display isn’t HiDPI, making it more comfortable to use
on higher resolution screens.

• 

Limit frame rate to: Set how fast the GUI will update itself. Lower values
require less CPU power, while higher values result in a more responsive user
interface. Disabling the frame rate will allow use of the necessary amount of CPU
power to update the GUI as responsively as possible.

• 
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More compatible GFX updates (might be slower): (Windows only) Uses a
possibly slower method of drawing the GUI with your graphics card. This option
should be kept on unless it needs to be disabled to avoid problems with
multi-monitor setups.

• 

Enable Metal based GFX updates: (MacOS only) Enables Apple's Metal API for
the Renoise UI instead of using CoreGraphics. This should result in a much
smoother UI when your GFX cards supports Metal, and is enabled by default
when Renoise detects a Retina screen on the first launch after installation.

• 

50.6.2 Pattern/Phrase Editor

Single click to set cursor in edit mode: (Renoise only) This allows a single
left-click in a pattern to move the cursor to that exact position when Edit Mode is
on. When Edit Mode is off, it also allows a single left-click to move the cursor to
that column without changing the pattern line. A double-click will always move
the cursor to that exact position regardless of whether this option is enabled or
not.

• 

Instant drag & drop: When enabled, clicking upon a selected area in the
Pattern Editor will instantly start to drag the selection. When disabled, you have
to click and hold for a second to drag.

• 

Hide 0s in effect columns: Hides 0s in the effect columns.• 
View multiple patterns continuously: (Renoise only) Show previous/next
patterns at the edges of the current pattern.

• 

Syntax highlighting (color-code FX commands): Highlights different types
of Effect Commands with different colors.

• 

Line number format: Use either decimal or hexadecimal for the Pattern Editor
line numbers.

• 

Font size: Choose between four font sizes.• 
H-Spacing: The horizontal spacing between individual letters and numbers.• 
V-Spacing: The vertical spacing between lines.• 

50.6.3 Pattern Sequencer (Renoise only)

Separate edit & play positions (with pattern follow disabled): When
enabled, the sequencer's playback position will be detached from the edit
position when Pattern Follow is disabled.

• 

50.6.4 Envelopes (Renoise only)

Single click to create new points (hold Shift to select): When enabled,
reverts to the old behaviour of a single left-click to create new points in
envelopes.

• 

50.6.5 Scopes (Renoise only)

Show track names: Deactivating this will remove the track names from the
Scopes and display their track numbers instead.

• 

Show track color blends: Show the background colors selected for each track
as the background color of its Track Scope.

• 
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50.7 Theme

50.7.1 Theme Files

There are four different options for handling Theme files (.xrnc) here and they can also
be Imported/Exported in the Disk Browser.

Import a Theme file. To store this within Renoise/Redux for future use, be sure to
also Save it.

• 

Export the current colour settings to a file.• 
Delete the selected user-created (non-bundled) Theme.• 
Save the current colour settings as a user-created Theme. Before pressing Save,
enter the desired name into the text field, finishing with "Enter".

• 

50.7.2 Color Settings

Change individual colour settings. Colours are organized into multiple categories.
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50.7.3 Global Color Filter

Adjust all colour settings at once by applying Hue, Saturation or Value changes to them.

50.7.4 Graphics

Change the texture set and bevel amounts that are used for the current Theme.

50.8 Plugins/Misc

50.8.1 Audio Unit Plugins (MacOS only)

Enable the use of Audio Unit plugins in Renoise.• 

50.8.2 LADSPA Plugins (Linux only)

Enable the use of LADSPA plugins in Renoise.• 
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50.8.3 VST2 Plugins (Windows, Mac & Linux)

Enable the use of VST2 plugins in Renoise and choose the initial folder where
Renoise will scan for plugin files.

• 

Enable and choose a second folder (Linux) or multiple folders (Win & MacOS)
where Renoise will scan for plugin files.

• 

50.8.4 VST3 Plugins (Windows, Mac & Linux)

Enable the use of VST3 plugins in Renoise. Please note that, regardless of where
you install other files, the actual VST3 files must be located in the default
directory or they will not be detected.

• 

50.8.5 Plugins General (Windows, Mac & Linux)

Rescan previously failed plugins: When hitting the "Rescan" button, Renoise
will try to open plugins that failed to open in previous scans. Plugins which
caused a crash upon scanning are never rescanned though, unless you delete
the VST cache files in the Renoise preferences folder. When this option is
disabled, hitting the "Rescan" button will only look for new plugins.

• 

Rescan: Rescan for new plugins or try to rescan previously failed plugins (see
above).

• 

Scan for new plugins on startup: By default, Renoise will always start
scanning for new plugins when launched. If you have a large amount of plugins
installed then disabling this option can vastly improve startup time. If disabled,
then after installing new plugins you will have manually scan for them with the
"Rescan" button, as described above.

• 

Run all plugins in sandboxes (�separate process): When enabled, plugins
will be started in their own process, preventing bugged ones from crashing
Renoise.

• 

50.8.6 Backup

Auto save backups: When enabled, Renoise will periodically save backups of
your current song. For existing songs, the backups are saved into a new folder
named after the song. For 'Untitled' songs, the backups will be saved into the
Renoise preferences folder.

• 

Save also during playing: When enabled, backups will be saved as songs are
playing, which could possibly cause interruptions in the audio. If you want to
avoid this while composing, disable this option.

• 

Save every xx minutes: How often backups will be saved.• 
Keep xx backups: Specify how many revisions of the backups will be kept.• 
Save at: Instead of being saved next to the original song files, you can specify a
folder to place the backups.

• 

50.8.7 Misc

Auto play songs after loading: When enabled, Renoise will automatically start
playback as soon as a song is loaded.

• 
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Stop playing notes on pattern sequence navigation: When navigating
around in the Pattern Sequencer, Renoise will stop all playing notes and then
skip over to the new pattern to continue playback, avoiding 'hanging' notes. You
can disable this behaviour here.

• 

Space record/stop mode
Renoise: Use the space key to start/stop playing.♦ 
FT2: Use the space key to stop the song or toggle Edit Mode if the song is
already stopped.

♦ 

• 

Mute mode (left click):
Off: (Soft Mute) Muting a track will act as a Note-Off event for any
instruments playing in the track, so you may hear them carry on until
finished. New notes and Effect Commands playing in the track will not be
triggered while the Mute is active.

♦ 

Mute: (Mixer Mute) Muting a track will immediately silence all audio. New
notes and Effect Commands playing in the track will still be triggered while
the Mute is active, so un-muting will instantly bring back all audio.

♦ 

• 

Solo mode (right click):
Mute Others: Solo-ing a track will cause all other tracks to be muted.
Unsolo-ing will un-mute all other tracks.

♦ 

Solo: Solo-ing and unsolo-ing track will retain the mute states of all other
tracks.

♦ 

• 
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51 HiDPI & UI Scaling
HiDPI (High Dots Per Inch) or 'Retina' displays have a high resolution packed into a
relatively small form factor, resulting in much greater pixel density than normal.
Initially found on phones and tablets, they are becoming more commonly used in
high-end laptops and monitors, especially those with a 4K resolution. Compared to
regular displays, HiDPI renders pixels at twice the normal horizontal and vertical
resolution, giving an overall density increase of 400%. To make use of this extra
density without resorting to upscaling requires explicit support from the software
application.

For more general and technical information about HiDPI:

What is HiDPI and why does it matter?• 
Pixel Density 4K• 

51.1 Renoise is now HiDPI-enabled

Starting from version 3.2, Renoise is a HiDPI-enabled application. If you don’t have a
HiDPI display this changes nothing, though you can still make use of the new ‘User
interface scaling’ option. If your display is HiDPI then the OS will now draw the Renoise
UI in the higher native resolution instead of manually upscaling. That upscaling is
typically performed by the OS so that non-HiDPI-enabled applications appear at the
same size as they would when running on a non-HiDPI display. The downside of
upscaling in this manner is that the UI can become blurry and sometimes lacking in
responsiveness - issues which Renoise can now avoid completely.

51.1.1 Disabling HiDPI Support

If you need to disable HiDPI support, this is performed in the following way depending
on your OS:

Windows: Right-click the Renoise executable and select ‘Properties’. Go to the
Compatibility tab and click on ‘Change high DPI settings’. In the DPI settings
dialog, enable the ‘Override high DPI scaling behavior’ option, then in the
‘Scaling performed by’ drop-down menu select ‘System’.

• 

MacOS: Toggle the ‘Enable Retina support’ option in the Renoise "Preferences >
GUI" tab.

• 

51.1.2 Requirements for HiDPI Support

Windows: Windows 10 is required for full support. On Windows 8 the Renoise UI
will be HiDPI, but Plugin GUIs will not be scaled. Versions of Windows prior to 8
do not support HiDPI.

• 

MacOS: No special requirements.• 
Linux: If your current Linux setup works with a HiDPI display, Renoise should
work too.

• 
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51.1.3 User Interface Scaling Option

Found in the "Preferences > GUI" tab, the new ‘User interface scaling’ option can
override the amount of scaling used by the default ‘Auto’ setting, which uses your main
display’s DPI value*, and instead uses a percentage chosen from 100-350%. This option
can still be used to enlarge the Renoise GUI even if your display isn’t HiDPI, making it
more comfortable to use on higher resolution screens.

* On Linux: When present, the X resource ‘Xft.dpi’ setting is checked and followed, then
the scaling is deduced from the default display’s ‘DisplayHeight / DisplayHeightMM’
ratio.

51.1.4 Limitations

Currently in version 3.2, the entire Renoise UI can only be displayed at one single level
of scaling. When using multiple monitors with different DPI settings (or a non-HiDPI
display using a HiDPI setting), the UI will always be rendered at the DPI of the main
display and then up/down-scaled as needed on the other display(s) by the OS. So, if
your main display is HiDPI, but you want to use Renoise primarily on another non-HiDPI
display, you should disable the HiDPI support in Renoise to prevent blurring and
potential lag.

51.1.5 Using VST/AU Plugins on HiDPI Displays

Since plugin instruments and effects are actually external applications, their interfaces
are not controlled by Renoise. Most old (and even many new) plugins don’t support
HiDPI displays, which may have implications depending on your OS.

Windows: By default all plugins are treated as non-HiDPI-compatible (because
most plugins are not). So any plugin will be upscaled by the OS unless you tell
Renoise that it supports HiDPI by unchecking "Plugin > Compatibility Options >
Auto scale external editor". This only applies to Windows 10. On versions prior to
Windows 10, plugins that don’t support HiDPI will always appear small on HiDPI
screens.

• 

MacOS: When a plugin supports HiDPI and is running on such a display, it will
just work in most cases.

• 

Linux: As far as we’re aware, there’s no way to automatically upscale
non-HiDPI-compatible plugins. So if a plugin doesn’t support UI scaling it will
appear small on HiDPI screens (the Renoise GUI will still scale properly).

• 
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52 Keyboard Shortcuts
Renoise features an enormous amount of keyboard shortcuts, but in the previous topics
we often only noted a few of the important ones. Besides those, there are many other
shortcuts available and even unassigned shortcuts, which you can customise yourself if
they fit well into your work-flow.

52.1 Keyboard Focus Concept

Renoise utilises a shortcut Focus system for the keyboard, which means that most
keyboard shortcuts only apply to a specific region of the interface. Those are referred
to below as 'Local', while the others are 'Global'. The currently focused area is indicated
by small corners that are coloured orange by default:

To change the Focus area, you can either:

Click anywhere in Renoise with the middle mouse button.• 
Left-click anywhere in Renoise while holding down the "Left Alt" key.• 
Right-click anywhere in Renoise and choose "(Set Keyboard Focus Here)" from
the context menu.

• 

Use the shortcuts "Left Control/Command + TAB" or "Left Control/Command +
Left Shift + TAB".

• 

Here is a small example on how to use the Focus:

When you start up Renoise, the Pattern Editor is focused by default. If you use the
arrow keys then the Pattern Editor's cursor will start moving around. Now left-click
somewhere in the Disk Browser while holding down the "Left Alt" key, which will set the
Focus to the Disk Browser. Notice that the orange corners now surround the Disk
Browser and the arrow keys move around to select files and folders.

The idea behind this is that the main components of Renoise (such as the Pattern
Editor) should always be ready for editing. The keyboard Focus will not move around as
you click on different parts of the interface, though you can change this via the "View >
Lock Keyboard Focus" option in the Upper Status Bar.
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52.2 Customising and Printing Shortcuts

Using the menu panel "Edit > Preferences > Keys", you can customise any keyboard
shortcut and also print out a list of the currently set shortcuts. To print the shortcuts,
simply click the  button at the top-right of the menu:

52.3 List of Important Shortcuts

Below is a list of the most commonly used keyboard shortcuts (Mac users: Replace
"Control" with "Command" and "Alt" with "Option" below):

Renoise also supports most of the common shortcuts that apply to any application:
"Left Ctrl + X" (Cut), "Left Ctrl + C" (Copy), "Left Ctrl + V" (Paste), "Left Ctrl + Z"
(Undo), "Left Ctrl + Y" (Redo).

52.3.1 Global
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52.3.1.1 Panel Switching

F1, F2, F3, F4, F5, F6, F7, F8: Activate Window Layout Presets• 

Tip: You can save and customise the layouts by right-clicking on the 1, 2, 3, 4, 5, 6, 7,
8 buttons at the top right of the Renoise interface. The current keyboard Focus is also
saved with the preset.

52.3.1.2 Play and Record

Space: Start/Stop playing.• 
Enter: Only play the line that the cursor is on (play step by step).• 
Right Alt: Start playing and looping the current pattern.• 
Right Ctrl: Start playing the song.• 
Right Shift: Start playing the song with Edit Mode enabled.• 
Escape: Toggle Edit Mode.• 
Numpad Enter: Activate Block Loop and start playing.• 

52.3.1.3 Instruments

Numpad / *: Decrease/increase keyboard octave.• 
Numpad - +: Decrease/increase slot selection in the Instrument Selector.• 
Numpad 1-9: Select instrument from instruments visible in the Instrument
Selector.

• 

Left Alt + Left/Right Arrow Keys: Jump up/down a page in the Instrument
Selector.

• 

Left Alt + Up/Down Arrow Keys: Decrease/increase slot selection in the
Instrument Selector.

• 

52.3.2 Local

52.3.2.1 Cut/Copy/Paste

Left Ctrl + X: Cut selection to clipboard.• 
Left Ctrl + C: Copy selection to clipboard.• 
Left Ctrl + V: Paste contents from clipboard to target.• 
Backspace: Delete all notes and Effect Commands at the current line in the
track and scroll everything beneath the current line up.

• 

Insert: Insert clean row into track and push all notes and effects in current track
down.

• 

Left Ctrl + Left Shift + Delete: Delete note under cursor and scroll column
beneath current note up.

• 

Left Ctrl + Left Shift + Insert: Insert clean row into column and push all data
in current column down.

• 

Left Ctrl + Left Shift + Left/Right arrow: Remove/add note or effect column.• 

Left Shift + F3: Cut current track.• 
Left Shift + F4: Copy current track.• 
Left Shift + F5: Paste current track.• 
Left Ctrl + F3: Cut current pattern.• 
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Left Ctrl + F4: Copy current pattern.• 
Left Ctrl + F5: Paste current pattern.• 
Left Alt + F3: Cut current selection in pattern.• 
Left Alt + F4: Copy current selection in pattern.• 
Left Alt + F5: Paste current selection in pattern.• 

52.3.2.2 Pattern/Phrase Editor

Left Ctrl & - +: Decrease/increase the Edit Step value.• 
Left Ctrl & 1-0: Set the Edit Step number.• 
Left Ctrl & Shift & 1-9: Set note quantize value.• 
Arrow Keys: Navigate through the Pattern Editor.• 
PageUp/PageDown: Move up/down in pattern.• 
Home/End: Go to start/end line of pattern.• 
F9: Move cursor to line 0.• 
F10: Move cursor 25% of the way down the pattern.• 
F11: Move cursor to the centre of the pattern.• 
F12: Move cursor 75% of the way down the pattern.• 
Caps-Lock/A: Insert a Note-Off when Edit Mode is enabled.• 

52.3.2.3 Pattern Sequencer

Left Ctrl + Left/Right Arrow Keys: Change number of current pattern.• 
Left Ctrl + Up/Down Arrow Keys: Move to prev/next pattern in sequence.• 
Left Ctrl + Home: Go to first pattern in sequence.• 
Left Ctrl + End: Go to last pattern in sequence.• 
Left Ctrl + Insert: Insert new pattern into sequence.• 
Left Ctrl + Delete: Delete current pattern in sequence.• 
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